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介绍 1
软件概述
SCIEX OS 软件将仪器控制、数据采集、数据处理和报告功能融合在一个软件包里。

打开软件

1. 从 Start 菜单中选择软件：

• Windows 7：Start > All Programs > SCIEX > SCIEX OS > SCIEX OS

• Windows 10：Start > SCIEX OS > SCIEX OS

注释: 如果 LibraryViewServiceHost 服务未运行，则会显示 User Account Control 对话
框。单击 Yes 启动该服务。

如果软件进行了 Integrated 模式配置，则会打开 Home 页面。

如果软件进行了 Mixed 模式配置，则会打开 Logon 对话框。继续进行以下步骤。

2. 如果正在使用 Central Administrator Console (CAC) 软件，并且 SCIEX OS 已配置为集中
管理，则选择要登录的工作组。

3. 如果 Logon 对话框打开，则键入有权使用该软件的用户的用户名和密码，然后单击 OK。
此时 Home 页面便会打开。

关于主页

主页包含工作区图标，按功能、状态面板、功能区和启动对话框分组。工作区访问权限由用户
的指定角色以及许可决定。

介绍
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图 1-1 主页

项目 描述

1 深蓝色图标左侧的浅蓝色竖线表示工作区已打开，工作正在进行，用户可
访问功能。图标显示了已打开工作区的状态。

2 深蓝色图标表示工作区已关闭。

3 灰色图标表示工作区未启用。

4 工作区打开时，图标右上角显示关闭图标 (×)。

5 访问启动对话框。启动对话框包含所有工作区的列表。单击图标右侧的

 打开启动对话框。

6 功能区请参阅以下章节：关于功能区和启动对话框。要导航至其他工作
区，请在列表中单击一个工作区。当前打开的工作区将保持活动，功能区

中显示工作区图标。单击  关闭活动的工作区。单击  返回到主
页。

7 功能：采集、处理和管理。访问权限取决于用户的指定角色和许可。

8 系统状态。单击标题栏显示或隐藏状态面板。

9 状态面板。请参阅以下章节：关于状态面板。
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表 1-1 功能

标签 描述

Acquisition （采集）运用 Acquisition 分组中的功能创建方法、批次，提
交样本用于采集。用户还可以通过 MS Tune 来调谐质谱仪。

Processing （处理）运用 Processing 分组中的功能来定量或定性处理数
据。

Management （管理）运用管理分组中的功能来配置设备、设定软件访问、
浏览事件日志。

表 1-2 图标

标签 描述

Batch （批次）使用 Batch 工作区创建批次并将其提交至队列。请
参阅以下章节：Batch 工作区。

Queue （队列）使用 Queue 工作区监控采集和处理状态，并管理队
列中的样本。请参阅以下章节：Queue 工作区。

MS Method （MS 方法）使用 MS Method 工作区创建并编辑 MS 方法。
请参阅以下章节：MS Method 工作区。

LC Method （LC 方法）使用 LC Method 工作区创建并编辑 LC 方法。请
参阅以下章节：LC Method 工作区。

MS Tune （MS 调谐）使用 MS Tune 工作区优化质谱仪。请参阅以下
章节：MS Tune 工作区。

Explorer (Explorer) 使用 Explorer 工作区检查采集的数据。请参阅以下
章节：Explorer 工作区。

Analytics （分析）使用 Analytics 工作区处理并检查采集的数据。请参
阅以下章节：Analytics 工作区。

Configuration （配置）使用 Configuration 工作区配置软件、添加和激活设
备、分配用户角色，创建和分配审核图。请参阅文档：《帮助
系统》。

Library （谱库）使用 Library 工作区管理化合物谱库。

Event Log （事件日志）使用 Event Log 工作区查看系统事件，包括错误
和警告。请参阅文档：《实验室主管指南》。

Audit Trail （审核记录）使用 Audit Trail 工作区查看软件事件的记录，例
如配置更改和数据处理。请参阅文档：《实验室主管指南》。

介绍
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关于功能区和启动对话框

图 1-2 功能区

项目 描述

1 允许用户打开另一个工作区，方法是从列表中选择它。此工作区将成为活
动工作区。之前的活动工作区将保持打开。请参阅图：图 1-3。

2 显示活动工作区的名称。

3 打开主页。

4 显示打开的工作区。活动工作区显示为白色。要将打开的工作区变为活动
工作区，请单击工作区图标。

5 显示当前登录的用户。

6 显示系统状态。请参阅以下章节：关于状态面板。

7 打开帮助系统。单击 ?。

介绍
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图 1-3 启动对话框

项目 描述

1 显示工作区列表。单击 。

2 显示活动工作区的名称。

3 显示工作区的状态。深蓝色背景表示工作区已关闭。左侧浅蓝色垂直栏表
示工作区打开。浅蓝色背景表示工作区激活。

4
关闭打开的工作区。单击 。

5
关闭活动的工作区。单击 。

关于状态面板

要打开此面板，请单击状态面板标题栏。请参阅图：图 1-2。

状态标题栏的图标、文本和颜色发生变化时，表明系统状态发生变化。将状态面板用于：

介绍
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• 添加或选择一个项目。

• 查看队列中的现存样本以及批次采集完成的预计剩余时间。

• 查看队列中的现存样本数量以及队列完成的预计剩余时间。

• 查看系统状态或 Configuration 工作区内的 Devices 列表中已启动的各个设备的状态。

• 访问直接设备控制以启动或停止设备。

• 查看设备详情。

• 将质谱仪或 LC 系统置于 Standby 状态。

• 验证和校准 TOF MS 和 TOF MS/MS 模式。

• 平衡系统。
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图 1-4 SCIEX OS 状态面板
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项目 描述

1 显示系统状态。单击标题栏显示或隐藏状态面板。

• 绿色表示准备就绪。

• 灰色表示脱机。

• 蓝色表示正在平衡稳定、运行和加载。

• 黄色表示已停止或正在停止。

• 红色表示故障。

2 显示当前项目。要更改为现有项目，从列表中选择项目。要添加项目，请

单击 Create Project( )，键入项目名称，然后单击 OK。

3 显示队列中的样本状态。

4 显示设备的状态。单击设备名称，打开 Device Details 对话框并查看详
情。如果设备不处于活动状态，则状态面板的此部分将显示 Activate
Devices 按钮。单击此按钮以激活设备。

5 单击 Direct Device Control 图标，使用设备控制功能。可选注射泵可通
过 Device Control 对话框启动或停止。

6 显示设备状态。图标是一个仅供查看的指示器，用于指示设备状态。

7 单击以访问 MS Tune 程序。

8 单击适当按钮，以平衡系统或进入 Standby 状态。请参阅以下章节：平衡
系统。

表 1-3 状态面板部分

标签 描述

Projects
（项目）显示当前项目。单击 Create Project ( ) 以创建项
目。请参阅以下章节：添加一个项目。

Queue （队列）显示队列中的样本状态。提供的信息包括：

• Samples waiting（等待的样本）

• Sample time remaining（剩余的样本时间）

• Acquisition time remaining（剩余的采集时间）

请参阅以下章节：管理队列。
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表 1-3 状态面板部分 (续)

标签 描述

Devices （设备）列出活动配置中的设备。在此列表中，可以通过以下方
式管理设备。

• 单击设备名称打开 Device Details 对话框并查看详情。

• 查看图标状态或将光标移动到状态图标上方以显示设备状态。

• 单击 Direct device control( ) 打开 Device Control 对话
框。

MS Check （MS 检查）在正离子 (+) 或负离子 (–) 模式下执行 MS 调谐程
序。

Direct Control （直接控制）允许用户手动控制设备。单击 Standby 将系统置于
Standby 状态。单击 Equilibrate 打开 Equilibrate 对话框。请参阅
以下章节：平衡系统。

表 1-4 状态面板功能

目的 方法

显示状态面板 单击最小化状态面板顶端的状态面板标题栏。请参阅图：图 1-2。

隐藏状态面板 在状态面板标题栏显示时单击它。

更改活动项目 从状态面板的 Projects 列表中选择一个项目。

提示! 单击 Create Project ( ) 以创建项目。键入项目名称，然
后单击 OK。

控制设备状态 1. 在状态面板上单击设备标题右侧的 Direct device

control( )。

此时 Device Control 对话框打开。

2. 按需要开始、停止或更新设备。

3. 单击 OK。

通过该步骤获得设备状态的详细反馈。例如：温度、压力和电
压。要检测设备状态，单击设备名称最右端的图标。

Data Acquisition 面板

使用 Data Acquisition 面板开始和监控实时数据采集。用户还可以在实时采集数据时编辑采集
方法参数，并在 Explorer 工作区中保存或打开数据。
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提示! 单击 Data Acquisition 面板顶端，然后上下拖动以调整内容尺寸。

图 1-5 Data Acquisition 面板

项目 描述

1 显示 TIC 和质谱或 XIC。如果检测器激活，还会显示 DAD 或 UV 数据。

2 MS 方法。悬停以显示正在运行的 MS 方法的名称。

3 LC 方法。悬停以显示正在运行的 LC 方法的名称。

4 单击 Start 开始手动采集。单击 Start > Start with LC 以打开 Start with
LC 对话框。

5 单击停止手动采集。

6 单击保存数据。

7 单击以实时浏览数据。

锁定屏幕

若要在工作站无人值守时防止对软件进行未授权访问，请锁定软件。当软件被锁定时，正在进
行的任何采集或处理都将继续。

当自动登出时间到期时，用户将登出。采集继续。

注释: 如果正在处理或未保存 Results Table，则不会登出。

1. 按下 Ctrl+Q。
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图 1-6 Lock Screen 对话框

2. 单击 OK。
SCIEX OS is Locked 对话框随即打开。

解锁软件

如果软件被锁定，则当前登录的用户可以解锁软件。

注释: 其他用户不能解锁软件，但拥有 Force User Logoff 权限的用户可以使当前用户登出。

在 SCIEX OS is Locked 对话框中，键入当前用户的密码，然后单击 Unlock。

电子实验室笔记本支持
SCIEX 不支持任何特定的电子实验室笔记本 (ELN) 解决方案，但 SCIEX 会提供产品、工具和
服务，以方便与 ELN 系统集成的数据导入和导出：

• 批次创建：SCIEX OS 可以导入 csv 和 txt 格式的批次文件。请参阅 Batch 工作区。

• 结果上传：SCIEX OS 可以将数据导出至 txt 文件，以在 LIMS 系统中使用。请参阅
Analytics 工作区。

文档标志和惯例
本指南采用了以下标志和惯例。

危险! 危险表示会导致重伤或死亡的行为。

警告! 警告表示如不遵守注意事项可能会导致人身伤害的行为。

小心: 表示如不遵守注意事项可能会导致系统受损或数据破坏或丢失的操作。

注释: 注释一词突出强调了程序或说明中的重要信息。

提示! 提示在文中针对特定需求提供有助于应用技术和程序的有用信息，以及提供捷径，但对
于程序的完成而言并非必不可少。
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操作说明 — 设备配置 2
使用 Configuration 工作区来：

• 启用和停用设备

• 添加和删除设备

• 编辑设备设置

• 测试设备

添加设备

注释: 为避免出现任何激活问题，务必在添加任何其他设备前添加质谱仪。

1. 打开 Configuration 工作区。

2. 单击 Devices。

3. 如果任何设备已激活，则单击 Deactivate。

4. 单击 Add。
Device 对话框随即打开。

5. 在 Type 列表中选择所需类型。

6. 在 Model 列表中选择所需型号。

7. 单击 Settings 编辑设置或恢复默认值。

8. 单击 Test Device 核查设备是否配置正确且可用。

9. 单击 Save。

10. 根据需要重复步骤 4 至步骤 9。

11. 选择各个待激活设备旁的 Activate 复选框，之后单击 Activate Devices。
所有所选设备均已激活。

12. 要编辑或删除设备，请参阅帮助系统。

删除设备

注释: 若删除的设备是整体系统的一部分，则该系统中的全部设备均将被删除。用户无法删除
整体系统中的单个设备。

1. 打开 Configuration 工作区。

2. 单击 Devices。

3. 单击 Deactivate。

4. 选择一个设备。
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5. 单击 Delete。

6. 选择各个待激活设备旁的 Activate 复选框，之后单击 Activate Devices。
所有所选设备均已激活。

编辑设备设置
1. 打开 Configuration 工作区。

2. 单击 Devices。

3. 如果设备已激活，则单击 Deactivate。

4. 选择要编辑的设备。

5. 单击 Edit。
Device 对话框随即打开。

6. （可选）编辑 Device Display Names 区域中的设备属性。有关属性的信息，请参阅文
档：《帮助系统》。

7. （可选）单击 Settings 以查看和更改其他设备信息。使用 Settings 对话框执行以下任
务：

• 单击 Restore Defaults 以恢复设备的默认设置。

• 单击 Test Device 核查设备是否配置正确且可用。如果测试成功，则 Settings 对话框
关闭。

8. 单击 Test Device 核查设备是否配置正确且可用。
如果测试成功，则显示绿色消息。否则，消息将会指示配置无效且需要更新。

9. 单击 Save。

10. 选择各个待激活设备旁的 Activate 复选框，之后单击 Activate Devices。
所有所选设备均已激活。
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操作说明—软件配置 3
有关配置用户和角色的信息，请参阅文档：《实验室主管指南》。

关于项目和根目录
根目录是包含一个或多个项目的文件夹。软件将在该文件夹中查找项目数据。预定义的根目录
为 C:\SCIEX OS Data。
为了确保项目信息安全地存储，请使用 SCIEX OS 创建项目。请参阅以下章节：添加一个项
目。

项目数据可组织安排到子文件夹中。使用 SCIEX OS 软件创建子文件夹。请参阅以下章节：
添加子文件夹。

注释: 对于通过 Central Administrator Console (CAC) 软件管理的工作组，CAC 软件的配置控
制是否能够通过 SCIEX OS 管理项目。如果在 CAC 软件中选择了 Use central settings for
projects 选项，则 Projects 页面为只读状态。

添加根目录

根目录是存储一个或多个项目的文件夹。

注释: 软件最多保存十个根目录。

1. 打开 Configuration 工作区。

2. 单击 Projects。

3. 在 Advanced 部分中，单击 Current root directory 字段旁边的 Create Root ( )。

4. 将完整路径输入根目录文件夹中。
文件夹已创建。

提示! 不输入路径，而是单击 Browse，然后选择将创建根目录的文件夹。在路径末尾输
入“\”和根目录文件夹名称。

提示! 或者，在 File Explorer 中创建一个文件夹，浏览和选择该文件夹。

注释: 对于具有处理许可的 SCIEX OS 装置，根目录可以是 Analyst 软件
Analyst Data\Projects 文件夹。

5. 单击 OK。
新的根目录成为当前项目的根目录。
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删除根目录

软件将维护过去使用的十个根目录的列表。用户可以从此列表中删除根目录。

注释: Current root directory 无法删除。

1. 打开 Configuration 工作区。

2. 单击 Projects。

3. 在 Advanced 部分中，单击 Current root directory 字段旁的 。
Clear Root Directory 对话框随即打开。

4. 选择将从根目录列表中删除的文件夹，然后单击 OK。

指定一个安全网络帐户

如果项目储存在网络资源上，则可指定一个 SNA，以确保工作站的所有用户都有网络资源的
必要访问权限。

1. 打开 Configuration 工作区。

2. 单击 Projects。

3. 在 Advanced 部分中，单击 Credentials for Secure Network Account。

4. 输入网络资源上规定的安全网络帐户的用户名、密码和域。

5. 单击 OK。

添加一个项目

项目中储存有采集方法、数据、批次、处理方法、处理结果等。我们建议用户为每个项目使用
单独的项目文件夹。

提示! 还可以通过单击 Status 面板上的 Create Project( ) 来创建项目。

请勿在 SCIEX OS 软件外部创建项目或者复制粘贴文件。

1. 打开 Configuration 工作区。

2. 单击 Projects。

3. 单击 Current Project 字段旁的 Create Project ( )。
New Project 对话框随即打开。

4. 键入项目名称。

5. 单击 OK。
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添加子文件夹

在项目之内，数据可进一步组织安排到子文件夹中。

1. 打开 Configuration 工作区。

2. 单击 Projects。

3. 单击 Add Data Sub-Folders to any Project。
Add Data Sub-Folders 对话框随即打开。

4. 在 SCIEX OS Project 字段中，选择要添加子文件夹的项目。

5. 单击 Project Data Sub-Folders 部分中的框上方的 Add a new data sub-folder

( )。
Data Sub-Folder Name 对话框随即打开。

6. 键入子文件夹的名称。

7. 单击 Save。

8. 关闭 Add Data Sub-Folders 对话框。

选择队列选项
软件将按照顺序处理列表中已提交的样本，使用所选的采集方法运行每个样本。所有样本采集
完成后，队列停止，系统进入 Ready 状态。在 Instrument Idle Time 字段中设定的时间过去
后，系统进入 Standby 状态。在 Standby 状态下，LC 泵和柱温箱关闭，有些质谱仪的电源也
会关闭。自动进样器的温控器始终开启，以防止样本降解。

只有分配有管理队列权限的用户才能在最后一次采集完成后并且仪器进入 Standby 状态前修改
队列运行的时长。

1. 打开 Configuration 工作区。

2. 单击 Queue。

3. 按需要选择队列选项。关于选项描述，请参阅文档：《帮助系统》。

4. 单击 Save。

选择实验室信息管理系统 (LIMS) 设置
使用这一功能连接至 LIMS 服务器。用户可以从 LIMS 导入批次信息，或将结果导出至
LIMS。

注释: 连接到 Watson LIMS 不需要此程序。

1. 打开 Configuration 工作区。

2. 单击 LIMS Communication。

3. 要与 LIMS 通信，在 LIMS Server 字段中键入 LIMS 服务器的 URL，然后选择 Enable
import from the specified LIMS server。
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注释: 客户 IT 部门或中间件提供商负责配置 LIMS 服务器。联系他们了解 URL 或服务器
的位置。

4. 单击 Save。

启用全屏模式
选择该功能将 SCIEX OS 作为主要应用程序。用户无法关闭软件或访问其他软件程序。

1. 打开 Configuration 工作区。

2. 单击 General。

3. 在 General 下，选择 Enabled 复选框以启用 Full Screen Mode。

4. 单击 Save。

选择区域设置
本特性应用于 Control Panel 中选中的区域和语言设置。只能用小数点“.”或逗号“,”作为小数分
隔符。不支持数字分组。

1. 打开 Configuration 工作区。

2. 单击 General。

3. 在 Regional Settings 下，单击 Apply。
重启计算机后 Windows 操作系统中配置的区域设置将应用于软件。

4. 单击 Save。

5. 重启计算机。

管理化合物谱库

导入 LibraryView 软件包

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Import 图标。

4. 在 Library Importer 对话框中单击 LibraryView Package (*.lbp)。

5. 导航至 Open 对话框中的相应文件。

6. 选择所需文件，然后单击 Open。

7. 在 Library Importer 对话框执行下列操作之一：

• 单击 Compound 列上方的 All，导入所有化合物。

• 在适当的行内单击，导入各化合物。

提示! 为便于找到化合物，可使用 Search 字段。由于搜索标准已键入，因此可见列会
被搜索并刷新，以仅显示匹配指定标准的信息。
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8. 请执行以下任一操作，以将化合物添加至谱库：

• 从 Add to Compound Library 列表选择合适的谱库。

• 在 Add to Compound Library 列表字段内键入谱库名称。

9. 单击 Next。

注释: 如果用户在所有化合物完全复制至数据库之前取消导入操作，那么已导入的任何化
合物都将保留在数据库内。软件无法将数据库还原至导入前的状态。

10. 必要时需解决任何冲突问题。

11. 单击 Finish。

导入化合物数据库

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Import 图标。

4. 在 Library Importer 对话框执行下列操作之一：

• 单击 DiscoveryQuant Compound Database (*.mdb)。

• 单击 Analyst Compound Database (*.mdb)。

5. 导航至 Open 对话框中的相应文件。

6. 选择所需文件，然后单击 Open。

7. 在 Library Importer 对话框执行下列操作之一：

• 单击 Compound 列上方的 All，导入所有化合物。

• 在适当的行内单击，导入各化合物。

提示! 为便于找到化合物，可使用 Search 字段。由于搜索标准已键入，因此可见列会
被搜索并刷新，以仅显示匹配指定标准的信息。

8. 请执行以下任一操作，以将化合物添加至谱库：

• 从 Add to Compound Library 列表选择合适的谱库。

• 在 Add to Compound Library 列表字段内键入谱库名称。

9. 单击 Next。

注释: 如果用户在所有化合物完全复制至数据库之前取消导入操作，那么已导入的任何化
合物都将保留在数据库内。软件无法将数据库还原至导入前的状态。

10. 必要时需解决任何冲突问题。

11. 单击 Finish。
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导入 Cliquid 软件包

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Import 图标。

4. 在 Library Importer 对话框中单击 Cliquid Package (*.clq)。

5. 导航至 Open 对话框中的相应文件。

6. 选择所需文件，然后单击 Open。

7. 在 Library Importer 对话框执行下列操作之一：

• 单击 Compound 列上方的 All，导入所有化合物。

• 在适当的行内单击，导入各化合物。

提示! 为便于找到化合物，可使用 Search 字段。由于搜索标准已键入，因此可见列会
被搜索并刷新，以仅显示匹配指定标准的信息。

8. 请执行以下任一操作，以将化合物添加至谱库：

• 从 Add to Compound Library 列表选择合适的谱库。

• 在 Add to Compound Library 列表字段内键入谱库名称。

9. 单击 Next。

10. 如果需要，可在 Instrument Name 对话框的 Instrument Name 字段内键入质谱仪的名
称。

11. 单击 OK。

注释: 如果用户在所有化合物完全复制至数据库之前取消导入操作，那么已导入的任何化
合物都将保留在数据库内。软件无法将数据库还原至导入前的状态。

12. 必要时需解决任何冲突问题。

13. 单击 Finish。

导入 Excel 文件

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Import 图标。

4. 在 Library Importer 对话框中单击 Excel file (*.xls)。

5. 导航至 Open 对话框中的相应文件。

6. 选择所需文件，然后单击 Open。

7. 在 Excel worksheet to importLibrary Importer 对话框中选择合适的 。
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8. 如果该工作表包含列标题，则选择 Selected Excel Worksheet has headers 旁的复选
框。

9. 如果需要，可在 Instrument Name 对话框的 Instrument Name 字段内键入质谱仪的名
称。

10. 为每列信息选择合适的标题。

提示! Compound:CompoundId 和 Compound:Name 是必选项。对不需要的信息选择
---[not used]---。

11. 单击 Next。

12. 在 Library Importer 对话框执行下列操作之一：

• 单击 Compound 列上方的 All，导入所有化合物。

• 在适当的行内单击，导入各化合物。

提示! 为便于找到化合物，可使用 Search 字段。由于搜索标准已键入，因此可见列会
被搜索并刷新，以仅显示匹配指定标准的信息。

13. 请执行以下任一操作，以将化合物添加至谱库：

• 从 Add to Compound Library 列表选择合适的谱库。

• 在 Add to Compound Library 列表字段内键入谱库名称。

14. 单击 Next。

注释: 如果用户在所有化合物完全复制至数据库之前取消导入操作，那么已导入的任何化
合物都将保留在数据库内。软件无法将数据库还原至导入前的状态。

15. 必要时需解决任何冲突问题。

16. 单击 Finish。

导入谱库数据库快照

小心: 潜在的数据丢失。执行此程序之前，请备份当前 LibraryView 软件数据库。该信息包内
的信息可覆盖 LibraryView 软件数据库内的所有现有数据。取消选项在导入开始后不可用。

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Import 图标。

4. 在 Library Importer 对话框中单击 Overwrite Database with Library Snapshot (*.lbp)。

5. 在 Warning 对话框中单击 Yes。

6. 导航至 Open 对话框中的相应文件。

7. 选择所需文件，然后单击 Open。

8. 单击 Finish。
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从第三方导入谱库信息包

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Import 图标。

4. 在 Library Importer 对话框中单击 Third Party Library Package (*.tplp)。

5. 导航至 Open 对话框中的相应文件。

6. 选择所需文件，然后单击 Open。

7. 在 Library Importer 对话框执行下列操作之一：

• 单击 Compound 列上方的 All，导入所有化合物。

• 在适当的行内单击，导入各化合物。

提示! 为便于找到化合物，可使用 Search 字段。由于搜索标准已键入，因此可见列会
被搜索并刷新，以仅显示匹配指定标准的信息。

8. 请执行以下任一操作，以将化合物添加至谱库：

• 从 Add to Compound Library 列表选择合适的谱库。

• 在 Add to Compound Library 列表字段内键入谱库名称。

9. 单击 Next。

注释: 如果用户在所有化合物完全复制至数据库之前取消导入操作，那么已导入的任何化
合物都将保留在数据库内。软件无法将数据库还原至导入前的状态。

10. 必要时需解决任何冲突问题。

11. 单击 Finish。

安装有许可证授权的 LibraryView 软件包

注释: LibraryView 软件必须安装。

注释: 获取 LibraryView 软件许可证时，需要接入互联网。如果计算机不能接入互联网，则需
要复制所生成的计算机 ID。用一台能够接入互联网的计算机访问 SCIEX 网站的许可证授权页
面，然后按照操作说明获取许可证。

可以从 DVD 或从 SCIEX 网站下载的 zip 应用程序文件安装许可库。应用程序文件可包括化合
物名称、化合物转换信息和化合物谱库。

1. 以具有管理员权限的 Windows 用户身份登录计算机。

2. 执行以下任一操作：

• 如果谱库是从 DVD 安装的，需将 DVD 光盘放入 DVD 驱动器，然后继续步骤 5。

• 如果谱库通过下载文件安装，则继续步骤 3。
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3. 从 SCIEX 网站下载所需的 zip 文件。

提示! 为了避免可能出现的安装问题，请将文件保存至计算机桌面以外的某个位置。

4. 下载完成后，右键单击所下载的文件，然后单击 Extract All。

5. 找到提取的文件或 DVD，然后双击 Library.exe。

提示! 如果 User Account Control 对话框打开，请单击 Yes。

提示! 如果 LibraryView Setup (Not Responding) 消息对话框打开，请关闭该消息对话
框，右键单击 Library.exe 文件，然后选择 Run as administrator 选项以再次开始安
装。

6. 在 LibraryViewPackages Feature Unavailable 对话框中单击 Software Activation。
LibraryViewPackages Activation 对话框随即打开。

7. 在相应字段中键入与所示内容完全相同的许可证密钥。
如果许可证密钥不可用，请使用 sciex.com/request-support 上信息联系我们。

8. 单击 Generate Computer ID。
将为工作站创建唯一标识符。

9. 单击 Copy ID to Clipboard。

10. 按照操作说明获取许可证。

提交必需信息后，许可证文件会发送至所提供的每个电子邮件地址。

11. 关闭浏览器窗口。

12. 在收到包含许可证文件的电子邮件后，将许可证文件复制到工作站桌面上。

13. 在 Install License FileLibraryViewPackages Activation 对话框中，单击 。

14. 在 Select the new license file to be installed 对话框中，浏览并选择许可证文件。

15. 单击 Open。
Select the new license file to be installed 和 LibraryViewPackage Activation 对话框均关
闭。

16. 执行以下任一操作：

• 在 Library Importer 对话框中单击 Compound 列上方的 All，以导入所有化合物。

• 在 Library Importer 对话框中的相应行内单击，以导入单个化合物。

提示! 为便于找到化合物，可使用 Search 字段。由于搜索标准已键入，因此可见列会
被搜索并刷新，以仅显示匹配指定标准的信息。

17. 单击 Next。

注释: 如果用户在所有化合物完全复制至数据库之前取消导入操作，那么已导入的任何化
合物都将保留在数据库内。软件无法将数据库还原至导入前的状态。

18. 必要时需解决任何冲突问题。

操作说明—软件配置

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统
30/301

软件用户指南
RUO-IDV-05-7560-ZH-I

https://sciex.com/request-support


19. 单击 Finish。

化合物冲突

设置含有化合物组的谱库或设置各种化合物时，软件会在数据库中搜索名称或化学式相同的化
合物，作为信息包中的化合物。如果找到了化合物，软件就会对信息包中的对应化合物进行标
记，然后等待用户输入后再继续运行。

用户可以选择：

• 合并化合物信息。来自信息包中化合物的新质谱、离子对和保留时间均被添加到保存在数
据库中的化合物信息中。

• 覆盖化合物信息。来自信息包中的化合物信息将替代保存在数据库中的化合物信息。

• 保留化合物信息。数据库中的化合物信息保留下来，而来自信息包中的化合物信息将被丢
弃。

冲突信息可帮助用户作出正确选择。

查看化合物冲突

1. 在 在 Library Importer 对话框中单击该化合物旁边的 Resolve，以查看冲突详情。

2. 执行以下任一操作：

• 单击 Keep Original，以保留现有化合物信息，并舍弃新信息。

• 单击 Use New，以用新信息替代现有化合物信息。

3. 为每种化合物重复步骤 1 和步骤 2 。

4. 当所有冲突解决完毕后，单击 Finish。

合并化合物

1. 在 Library Importer 对话框中执行以下任一操作：

• 单击 Merge，将导入信息包中单个化合物的新质谱、离子对和保留时间与保存在数据
库中的对应化合物信息合并。

• 单击 Merge All 将导入信息包中所有化合物的新质谱、离子对和保留时间与保存在数
据库中的所有对应化合物信息合并。

2. 当所有冲突解决完毕后，单击 Finish。

覆盖化合物

1. 在 Library Importer 对话框执行下列操作之一：

• 单击 Overwrite All 将保存在数据库中的所有化合物信息用导入信息包中的对应化合物
信息覆盖。

• 单击相应化合物旁边的 Resolve，然后单击 Use New，可使数据库中存储的化合物信
息被导入信息包中的对应化合物信息覆盖。

2. 当所有冲突解决完毕后，单击 Finish。

操作说明—软件配置

软件用户指南
RUO-IDV-05-7560-ZH-I

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统

31/301



保留原始化合物

1. 在 Library Importer 对话框执行下列操作之一：

• 单击 Keep All Original 保留数据库中存储的所有化合物信息，并舍弃来自导入信息包
中的化合物信息。

• 单击相应化合物旁边的 Keep Original，以保留存储在数据库中的单个化合物信息，并
丢弃源自导入信息包的化合物信息。

2. 当所有冲突解决完毕后，单击 Finish。

添加化合物

注释: 也可以使用 Edit Library 选项将化合物添加到谱库中。

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 单击 Add 图标。

注释: 化合物名称是必填项。其他所有信息是选填项。

4. 在 Details 选项卡的字段中，键入合适的信息。

5. 单击 Save。

给化合物添加质谱

1. 在 Manage 窗格中展开 Compounds 列表。

2. 单击 All Compounds。

3. 双击相应的化合物。

4. 单击 MS Spectra 选项卡。

5. 单击 Edit Mode 图标。

6. 单击 Add Spectra 图标。

7. 单击 Open *.wiff fileAdd Mass Spectrum from *.wiff file to Compound 对话框中的 。

8. 在 Open 对话框中浏览并选择合适的 wiff 或 wiff2 文件。

9. 单击 Open。

10. 请执行以下任一操作，以将化合物添加至谱库：

• 对于 IDA 数据，扩展样本，然后在左侧的导航窗格中选择合适的化合物。

• 对于 EMS、MRM 和循环数据，请选择合适的样本。

11. 请执行以下任一操作，以给该化合物添加质谱：

• 对于 IDA 数据，在 Acquired Spectrum 窗格中单击 Add Spectrum。
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• 对于 EMS、MRM 和循环数据，双击 TIC，然后单击 Acquired Spectrum 窗格中的
Add Spectrum。

12. 对每个要添加的质谱重复步骤 7 至步骤 11。

13. 单击 Save。

14. 单击 MS Spectra 选项卡上的 Save。
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操作说明 — 用户工作流程 4
分析师

任务 请参阅

查看主屏和状态面板，检查系统状
态。

关于主页 和 关于状态面板。

通过 Microsoft Excel 电子表格、
LIMS 或手动创建并提交批次。
Analysts 创建和提交批次前，
Method Developers 必须锁定液相
色谱方法和质谱方法。

Batch 工作区。

查看和管理队列中的样本。 Queue 工作区。

在 Results Table 中处理和检查数
据。

Analytics 工作区。

浏览数据。 Explorer 工作区。

方法开发人员

任务 请参阅

配置系统。 • 操作说明 — 设备配置。

• 定义项目的默认处理参数。

• #unique_55。

调谐质谱仪。 MS Tune 工作区。

配置液相色谱 (LC) 设备。 LC 设备的文档。

创建液相色谱方法。 创建一种 LC 方法。

创建质谱仪 (MS) 方法。 MS Method 工作区。

开发处理方法。 创建处理方法。

管理员

任务 请参阅

设置 Windows 文件许可权限。 实验室主管指南

配置 LIMS。 选择实验室信息管理系统 (LIMS) 设置。

给软件添加用户并指定角色。 实验室主管指南
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任务 请参阅

存档日志。 存档日志。

审核人

任务 请参阅

审查处理后的结果。 Analytics 工作区。

浏览数据。 Explorer 工作区。

审查日志。 查看日志。
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操作说明 - 采集方法 5
使用以下工作区来执行采集任务：

• MS Method 工作区：创建并管理 MS 方法

• LC Method 工作区：创建并管理 LC 方法

• Batch 工作区：创建批次并将它们提交至队列

• Queue 工作区：管理队列中的样本

注释: 如欲避免性能问题或数据损坏，在样本采集期间，请勿执行任何计算机维护步骤，如整
理碎片或清理磁盘、病毒扫描或 Windows Updates。

MS Method 工作区
使用此工作区可创建和管理质谱仪 (MS) 方法。

在 MS Method 工作区中可以打开多个方法。使用 Views 菜单，用户可以将方法窗口的排列方
式更改为选项卡式、垂直平铺、水平平铺或浮动视图。在浮动视图中，可以调整窗口大小、最
大化或最小化窗口、将窗口移出 SCIEX OS 窗口并移到其他显示器上。

方法窗口的标题包含方法和项目名称。在平铺和浮动视图中，活动方法的标题栏为蓝色，其他
方法的标题栏为灰色。在选项卡式视图中，活动方法的选项卡为白色，其他方法的选项卡为蓝
色。

对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

创建一种 MS 方法

请根据需要参阅以下内容：

• MS 方法实验

• 关于质谱方法

• 为 MS 方法计算动态碰撞能量

1. 打开 MS Methods 工作区。

2. 单击 New，然后单击一种方法。

3. （可选）单击 Options，然后根据需要选择选项：

表 5-1 选项菜单

参数 描述

Apply experiment
scheduling

（应用实验日程）在实验执行前，选择该选项以应用保留时间窗
口。对于环回实验，其中一个起始运行时间必须为 0，其中一个停止
运行时间必须等于方法持续时间。
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表 5-1 选项菜单 (续)

参数 描述

Apply ionization
scheduling

（应用电离日程）选择以显示 Ionization start time 和 Ionization
stop time。

Show EAD
parameters

（显示 EAD 参数）（ZenoTOF 7600 系统）选择以显示 EAD 参
数。使用 EAD 碎裂模式并且选择了此选项时，将会启用下列字段：

• Fragmentation mode：EAD

• Electron KE

• ETC

• Electron beam current

• Load time

• EAD RF

• Reaction time

Apply intact protein
mode

（应用完整蛋白模式）（X500 QTOF 系统）选择以显示完整蛋白模
式字段。

Ramp （优化）选择以优化参数。Ramp Compound Parameters 对话框随
即打开。

优化可用来优化离子参数。

优化参数包括自动运行实验，同时增加或减小参数值。一次只能优
化一个参数，步长必须朝向同一方向，即在起始值和停止值范围内
增加或减小。用户可以设置开始和结束电压以及期间的步长大小。

对于 TOF MS 方法，用户可优化 DP 参数。对于 TOF MSMS 方
法，用户可优化 DP 或 CE 参数。选择 Apply ramping to the
compound 参数，可启用优化。

Calibrate （校准）选择以在采集时校准质谱和质谱仪。Calibrate 对话框随即
打开。此对话框允许用户选择合适的离子参照表进行校准。

校准功能通常与校准物输送系统 (CDS) 配合使用。要查看校准结
果，用户可进入 Queue 工作区，然后双击校准运行的采集状态图
标。校准需要 1.25 分钟。

Dynamic collision
energy

（动态碰撞能量）单击以打开 Dynamic Collision Energy 对话框。

Dynamic ETC （ZenoTOF 7600 系统）（动态 ETC）单击以打开 Dynamic ETC
对话框。

4. 根据需要在字段中键入值。关于参数描述，请参阅文档：《帮助系统》。

5. （可选）单击 Add Experiment。
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提示! 使用 Experiment 字段旁边的列表更改或删除实验。

6. 执行以下任一操作：

• 单击 Save > Lock Method，以保存并锁定 MS 方法。

• 单击 Save > Save。

• 单击 Save > Save as。

使用引导式 MRM HR 创建 MRM HR 方法

如果需要增加对起止电压的控制，可使用 Guided 选项。

1. 打开 MS Method 工作区。

2. 单击 New > Guided MRM HR。
Preparation 页面随即打开。

3. 选择该模式：

• Guided：用于增加对起止电压的控制。

• Automatic：允许软件自动选择起止电压值。

4. 选择 Polarity。

5. 要使用已知离子对，请执行此操作：

a. 单击 Use known transitions。

b. 键入 Compound ID、Precursor Ion (Da) 和 Fragment to Use (Da)。

6. 要使用未知离子对，请执行此操作：

a. 单击 Find transitions automatically。

b. 在每种化合物的表格中指定 Compound Name、Charge、Precursor Ion 和
Number of Fragments to Use。

7. 单击 Continue。
Initial Conditions 页面随即打开。

8. 如有需要，调整 Source and Gas Parameters。

9. 如果未自动进行处理，请单击 Start。

10. 在 Optimize DP 页面上，单击 Ramp。
软件自动优化 DP 参数，并为每个离子对找到最大强度的 DP 值。

11. （自动模式）等到确定每个子离子的最佳 DP 和最佳 CE 后，将会显示 Review Report 页
面。然后，转到步骤 13。

12. 在 Optimize DP 页面上，单击 Ramp。
软件自动优化 DP 参数，并为每个离子对找到最大强度的 DP 值。

13. （可选）通过以下步骤保存报告：

a. 在 Report 页面，单击 Save report as。。

b. 浏览至您希望保存报告的位置，键入 File name，然后单击 Save。
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14. 单击 Continue 打开 MS Method 工作区的优化方法。

15. 在 Method Duration 字段中键入所需的方法持续时间。

16. 请执行以下任一操作，以保存 MS 方法：

• 单击 Save > Save，以使用相同名称将该方法保存到同一项目中。

• 单击 Save > Save As，以使用新名称保存该方法，或者将其保存到另一项目中。

• 单击 Save > Lock Method，以锁定已达到就绪状态可用于常规分析的方法。

注释: 锁定该方法，以防止未授权用户进行编辑。仅具有 Lock/Unlock methods 权限的
用户才可编辑已锁定的方法。其他用户只能提交方法。

Save As MS Method 对话框随即打开。

17. 在 File Name 字段中键入一个名称。

18. 单击 Save。

MS 方法实验

使用 MS Method 工作区创建或编辑 MS 方法。一种 MS 方法可包含一项或多项实验。在默认
情况下，一种新的 TOF MS 方法包含一项实验。

可用的质谱实验类型如下：

• 三种基本方法实验：TOF MS、TOF MSMS 和 Q1

• 三种组合方法实验：IDA、SWATH 和 MRMHR

此外，提供一种逐步程序，以指导 MRMHR 实验的创建。完成该程序后，相应参数会用来填充
MRMHR 方法。

表 5-2 基本方法实验

类型 定义

TOF MS 使用 TOF 区进行的质量分析。离子的 m/z 值会根据其在 TOF 区的飞行时
间而得以保留。

TOF MSMS 前体离子使用四极杆质量过滤器进行选择。然后，根据碎片离子在 TOF
MS 区的飞行时间返回其 m/z 值。本实验用来确定化合物的结构。

Q1 使用四极杆质量过滤器进行的数据采集。对扫描范围内的质量返回离子强
度。

表 5-3 组合方法实验

类型 定义

IDA IDA（信息相关采集）实验可在数据采集过程中进行分析，并根据分析结
果改变实验条件。分析结果可决定用来执行依赖性扫描的质量。用户可完
全控制激活一项 IDA 实验的标准以及所激活 IDA 实验的参数。
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表 5-3 组合方法实验 (续)

类型 定义

SWATH SWATH 采集可在一个 LC 时段的较宽质量范围内对所有前体离子进行
MS/MS 分析。对 Q1 四极杆设定的选择窗口宽度（通常为 10 Da 至 50
Da）大于用来进行常规产物离子采集的选择窗口宽度。通过逐步通过多个
连续的选择窗口，可迅速覆盖一个较宽的质量范围。所得质谱由穿过相应
Q1 选择窗口的所有前体离子碎片合成而得。该技术允许在一个样本中对
所有粒种进行非靶向 MS/MS 分析。

MRM HR MRMHR 设备有助于通过具有已知质量和保留时间的化合物采集高品质
MS/MS 数据。该采集方法也可用来从 TOF MSMS 质谱图中提取具有较
窄宽度 (0.02 Da) 的碎片质量。这种窄提取法可获得明显更好的选择性。

导向型 MRM HR 一种逐步程序，用来指导 MRMHR 方法的创建。完成该程序的步骤后，相
应参数会用来填充 MRMHR 方法类型。

关于质谱方法

一种质谱方法由以下要素构成：

• 与整个方法有关的参数，包括 Source and Gas 参数。

• 一项或更多项实验。

• 每种方法必须包含至少一项实验。

• 任何方法都包含超过一项实验。这叫做环回实验。

• TOF MS 和 TOF MSMS 实验可在一种方法内进行循环，最多不超过 10 次实验。Q1 实
验不能循环。

• IDA、SWATH、MRMHR 实验可在一种方法内进行循环，最多不超过 2 次实验。

注释: 只能使用特定的实验组合，例如，IDA + IDA、IDA + MRMHR、IDA + SWATH 和
SWATH + MRMHR。

• 每项实验都采用特定的高级设置。

• 每项实验内的单次扫描

表 5-4 质谱方法工作区功能

目的 方法

使用一项以上实验（即环回实
验）创建一种方法。

单击 Add Experiment，然后单击一种实验类型。

在一种现有的质谱方法内切换
实验。

单击 Experiment 旁边的列表，然后单击一种实验类型。

将 TOF MSMS 实验转化为
IDA 实验。

单击 Experiment 旁边的列表，然后单击 Add IDA criteria。
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表 5-4 质谱方法工作区功能 (续)

目的 方法

在 MRMHR 实验中，从方法
中删除 TOF MS。

单击 Experiment 旁边的列表，然后单击 Delete TOF MS (of
MRM HR)。

注释: 仅适用于环回实验。

当一种方法内有多项实验时，
删除一项实验。

单击 Experiment 旁边的列表，然后单击 Delete
experiment.

要查看以下方法结构：
• 一种方法内的实验数量。

• 该方法内每项实验的预定
持续时间。

• 多项实验的 TOF MSMS
扫描次数。

展开或折叠工作区左侧的 Method Overview 面板。

为 MS 方法计算动态碰撞能量

1. 打开 MS Method 工作区。

2. 创建或打开一种包含 IDA 标准或 SWATH 采集标准的 MS 方法。

3. 单击 Options > Dynamic collision energy。

4. 根据需要修改字段内的信息。

5. 执行以下任一操作：

• 要使用之前保存的默认值计算动态 CE，请单击 Load Default Settings。

• 要将当前值保存为准备在新方法中用来计算动态 CE 的默认值，请单击 Save as
Default Settings。

• 要将当前值应用至当前方法以计算动态 CE，请单击 Apply。

• 要关闭对话框并放弃所有更改，请单击 Cancel。

打开 MS 方法

使用此程序打开通过 SCIEX OS 创建的 MS 方法。

1. 打开 MS Method 工作区。

2. 单击 Open。
Open MS Method 对话框随即打开。它包含当前项目中的 MS 方法列表。

3. （可选）如果要打开的方法不在当前项目中，则选择包含要打开的方法的项目。

4. 选择要打开的 MS 方法，然后单击 Open。

提示! 要选择多个方法，请使用 Shift 或 Ctrl 键。
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手动运行一种 MS 方法

必要程序

• 在 MS Method 工作区中，创建 MS 方法或打开现有方法。请参阅以下章节：MS Method
工作区或 打开 MS 方法。

使用此程序在 MS Method 工作区中运行激活的方法。

1. 单击 Data Acquisition 面板中的 Start 按钮上的向下箭头，然后单击以下各项之一：

• Start：此选项在不使用 LC 的情况下运行 MS 方法。

• Start with LC

请参阅以下章节：Data Acquisition 面板。

警告! 火灾危险。将溶剂注入离子源的流速不要超过 3 mL/min。虽然 LC 组件可
以提供高达 5 mL/min 的流速，但直接送进流率超过 3 mL/min 的溶剂可能会造成
溶剂在离子源中积聚。可以用三通将溶剂流分开，以确保提供给离子源的最大流速
不超过 3 mL/min。

如果用户单击 Start with LC，则系统会打开 Start with LC 对话框。有关此对话框上的字
段的信息，请参阅文档：《帮助系统》。

注释: 必须激活 LC 系统，并且必须创建和保存 LC 方法。

图 5-1 Start with LC 对话框

2. （可选）要在 Explorer 工作区中查看数据，请单击 Data Acquisition 面板中的 Open data

exploration to view real-time data ( )。
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实时采集以样本标题中的词 Acquiring、Finished 或 Aborted 表示在 Explore 窗格中。

图 5-2 实时采集——Acquiring

3. （可选）根据需要优化 MS 参数。关于参数描述，请参阅文档：《帮助系统》。

4. 单击 Data Acquisition 面板中的 Stop。

5. （可选）要保存数据，请遵照以下步骤：

a. 单击 Save 保存数据。
Save Data 对话框随即打开。

b. （可选）选择保存数据的项目和子文件夹（如适用）。

c. 在 File Name 字段中键入一个名称。

d. 单击 Save。

6. 请执行以下任一操作，以保存 MS 方法：

• 单击 Save > Save，以使用相同名称将该方法保存到同一项目中。

• 单击 Save > Save As，以使用新名称保存该方法，或者将其保存到另一项目中。

• 单击 Save > Lock Method，以锁定已达到就绪状态可用于常规分析的方法。

注释: 锁定该方法，以防止未授权用户进行编辑。仅具有 Lock/Unlock methods 权限的
用户才可编辑已锁定的方法。其他用户只能提交方法。

Save As MS Method 对话框随即打开。

7. 在 File Name 字段中键入一个名称。

8. 单击 Save。

LC Method 工作区
使用此工作区可创建和管理 LC 方法。

在 LC Method 工作区中可以打开多个方法。使用 Views 菜单，用户可以将方法窗口的排列方
式更改为选项卡式、垂直平铺、水平平铺或浮动视图。在浮动视图中，可以调整窗口大小、最
大化或最小化窗口、将窗口移出 SCIEX OS 窗口并移到其他显示器上。

方法窗口的标题包含方法和项目名称。在平铺和浮动视图中，活动方法的标题栏为蓝色，其他
方法的标题栏为灰色。在选项卡式视图中，活动方法的选项卡为白色，其他方法的选项卡为蓝
色。
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对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

创建一种 LC 方法

请参阅随液相色谱设备提供的文档。

1. 打开 LC Method 工作区。

2. 单击 New。

3. 单击左侧面板中的一个设备，然后按需要编辑字段。

4. 通过单击以下命令之一保存并有选择地锁定 LC 方法：

• Save：用于保存 LC 方法。

• Save > Lock Method：用于保存和锁定 LC 方法。

Save As LC Method 对话框随即打开。

5. 在 File Name 字段中键入 LC 方法名称，然后单击 Save。

Batch 工作区
Batch 工作区包含要采集和（可选）处理的一组样本的相关信息。批次可以告知软件样本的采
集和处理顺序。

对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

注释: 对于选定的自动进样器、样本支架类型、样本支架位置、样本板类型、样本板位置和进
样瓶位置都彼此相关，并且只有特定值有效。

表 5-5 Batch 工作区列

列名称 定义 字段值要求

Sample and method information（样本和方法信息） ( )

Sample Name （样本名称）样本的名称。 小于 252 个字符。

Sample ID （样本 ID）样本的自定义编号或
其他标识符。

小于 252 个字符。Sample ID 字
段不能包含以下任何无效字符：
\ / : ; * ? " < > |=

Barcode ID （条形码 ID）样本的唯一 ID。 小于 250 个字符。

MS Method （MS 方法）方法的名称。 该 MS 方法必须存在于当前项目
中。该字段不区分大小写。

LC Method （LC 方法）液相色谱方法的名
称。

该 LC 方法必须存在于当前项目
中。该字段不区分大小写。

Rack Type （样本支架类型）自动进样器的
支架类型。

必须是适合 LC 方法所指定自动
进样器的任一有效选项。
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表 5-5 Batch 工作区列 (续)

列名称 定义 字段值要求

Rack Position （样本支架位置）样本架在托盘
上的位置。

数值。

Plate Type （孔板类型）自动进样器中的孔
板类型。

注释: 如果 Rack Type 对进样瓶
进行了描述，则此列不可用。

必须是适合 LC 方法所指定自动
进样器的任一有效选项。

Plate Position （孔板位置）样本板在样本架上
的位置。

必须匹配任一预定义的自动进样
器孔板位置。

Vial Position （进样瓶位置）（LC 方法）进样
瓶在支架或孔板中的位置。

数值。最大值不得大于样本架内
的进样瓶数。

Injection Volume
(µL)

（注射体积 (µL)）待注射的样本
量。

注释:

仅在 LC 方法中，注射体积取自
于 LC 方法。用户可在 Batch 工
作区或在导入的批次文件中覆盖
此注射体积。当提交批次时，会
比对 LC 设备支持的范围验证注
射体积。

要恢复至 LC 方法指定的注射体
积，请删除该字段的内容，然后
在 LC Method 字段中重新选择
LC 方法。

数值。

Sample Type （样本类型）样本的类型。 确保样本类型与预定义的一类样
本类型相匹配。任何不匹配的类
型都会被自动替换为 Unknown。

Dilution Factor （稀释系数）各个样本的稀释系
数。

对于 SCIEX 开发的方法，该值必
须为 1.000000。

必须为大于零的值，且包含六个
小数位。默认值是 1.000000。该
字段不得留空。
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表 5-5 Batch 工作区列 (续)

列名称 定义 字段值要求

Data File （数据文件）保存所采集数据的
文件名称。包含将存储文件的子
文件夹的完整路径。

必须少于 252 个字符。字符总数
包括数据子文件夹路径内的字符
数。数据文件不能包含任何这些
无效字符：\ / : ; * ? " < > |=

提示! 单击箭头以从列表中选择子
文件夹，或键入新的子文件夹的
名称。确保在子文件夹和文件名
之间包含反斜杠 (\)。如果子文件
夹不存在，将会在批次运行时创
建子文件夹。

Processing Method （处理方法）方法的名称。如果
将使用现有的 Results File，则
将此字段留为空白。选中现有的
Results File 时，值 *Embedded
Method* 将自动显示在此字段
中。

注释: 处理方法必须符合为样本指
定的 MS 方法。

从项目的处理方法列表中选择一
种处理方法。

Results File （结果文件）保存所处理结果的
文件名称。如果指定了有效的
Results File，将会在采集完成后
自动处理样本数据。如果文件名
无效，将无法完成批次提交过
程。

注释: 如果选择现有的 Results
File，则将所选 Results File 的内
嵌方法用于处理，Processing
Method 单元格中的文本将被替
换为 *Embedded Method*。

文件名不能包含以下任何无效字
符：\ / ; : * ? " < > |=

文件路径（包括文件名和子文件
夹）必须少于 252 个字符。

提示! 单击箭头以从列表中选择现
有 Results File。要创建一个文
件，请键入文件名称。文件将在
处理提交批次中的第一个样本时
创建。

Comment （评注）文本 必须少于 50 个字符。Comment
字段不能包含以下任何无效字
符：\ / : ; * ? " < > |=

Custom columns （自定义列）（可选）用户定义
的列，采用文本、整数或实数格
式。

要求取决于格式。

Component Concentrations（成分浓度）（ ）
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表 5-5 Batch 工作区列 (续)

列名称 定义 字段值要求

Component （成分名称）MS 方法、处理方法
或 Results Table 中定义的成分名
称。

该批次可以包含最多 4,000 个成
分行。

成分名称取自 MS 方法（用于
MRM 扫描）、处理方法或
Results Table。该名称在方法创
建期间已验证。

也可以手动添加成分到该表。请
参阅以下章节：添加成分浓度。

注释: 如果导入文件中含有与批次
网格中任一列都不匹配的数据
列，那么该列可作为 Compound
或 Component Name 列处理。添
加浓度列并在其中填充该数据列
中的值。

Component
concentration

用于标准物和质量对照品样本类
型的分析物或内标浓度。该表每
个样本有一列。样本名称用作列
名。

数值大于或等于 0。

管理批次

注释: 请确保在状态面板选中当前项目名称。

在 Batch 工作区中，使用以下功能管理批次。

表 5-6 Batch 工作区的功能

目的 方法

显示或隐藏列 单击 View。请参阅以下章节：显示或隐藏列。

剪切行 单击 Manage Samples > Cut。

复制行 单击 Manage Samples > Copy。

粘贴行 单击 Manage Samples > Paste。

插入一行 单击 Manage Samples > Insert sample。

删除一行 单击 Manage Samples > Delete sample。

选择列 单击 View。请参阅以下章节：显示或隐藏列。

添加子文件夹到项目中 单击 Manage Samples > Add data sub-folders。 请参阅文
档：《帮助系统》。

打印批次 单击 Print。

保存批次到当前项目 单击 Save > Save 或 Save > Save As。
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表 5-6 Batch 工作区的功能 (续)

目的 方法

将批次导出为 txt 或 csv 文件 单击 Save > Export。

显示或隐藏列

1. 打开 Batch 工作区。

2. 单击 View。

3. 根据需要，在 View 对话框中选择或取消选择该列复选框。关于列描述，请参阅表格：表
5-5。

图 5-3 View 对话框

4. 单击 OK。
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添加自定义列

使用此程序向批次添加列以存储干重等关于样本的额外信息，以使其能够用于化学式和计算列
中的处理。

1. 打开 Batch 工作区。

2. 右键单击批次网格，然后单击 Add Custom Column。
Add Custom Column 对话框打开。

3. 在 Column name 字段中，键入列的名称。

名称必须唯一。它不能与任何预定义列的名称相同。

4. 在 Column type 字段中，选择这些类型之一：

• Integer：此列包含整数。小数将舍入到最接近的整数。

• Real：此列包含实数，最多六位小数。

• Text：此列包含文本，最多 128 个字符。

5. 单击 Add。
新列添加到 Batch 工作区右侧。

更改自定义列的名称

注释: Column type 无法更改。

1. 打开 Batch 工作区。

2. 右键单击要更改的列，然后单击 Edit Custom Column。
Edit Custom Column 对话框随即打开。

3. 在 Name 字段中，为该列键入新名称。

名称必须唯一。它不能与任何预定义列的名称相同。

4. 单击 Apply。

删除自定义列

1. 打开 Batch 工作区。

2. 右键单击批次网格，然后单击 Delete Custom Column。
Delete Custom Column 对话框随即打开。

3. 选中要删除的列名称旁边的复选框。

4. 单击 Delete。
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从文件中导入一个批次

必要程序

• 创建一个批次文件。关于要包含在文件中的字段的描述，请参阅表格：表 5-5。

注释: 在导入的 Microsoft Excel 文件中，第一列必须是预定义列，接着是自定义列。预定
义列的列标题必须与 SCIEX OS 中的列名称匹配。如果预定义列的列标题不正确，则将不
会导入信息。仅支持将句点作为 csv 或 xsl 文件中的小数分隔符。

注释: 在导入批次文件前将其关闭。批次文件如果已在 Microsoft Excel 中打开将无法导
入。

• （对于从 Watson LIMS 导入可选）要自动插入 LC Method 字段，确保 LC 方法的名称与
MS 方法的名称相同。

注释: Watson LIMS 没有 LC 方法字段。如果 LC 方法的名称与 MS 方法的名称不同，则
必须手动插入 LC 方法列。

提交样本前，请检查批次目录。

提示! 要使用剪切、复制、粘贴、添加行和删除行等功能，请单击 Manage Samples。

1. 打开 Batch 工作区。

2. （可选）单击 View，以选择将显示在 Batch 工作区内的列。

3. 单击 Open > Import from file。
Batch Import 对话框打开。

4. 单击 Browse。

5. 导航至所需文件。

6. 单击 Open。

7. （可选）根据需要选择或取消选择 Append to current batch 复选框。

注释: 若用户未选择 Append to current batch 选项，则表格中的任何现有数据都将被覆
盖。

8. 单击 Import。

9. （可选）要将样本板布局用作选择或确认某样本位置的参照物，请单击 Plate Layout。
样本板布局可自动提供未指定样本的孔位和进样瓶位置。

10. 提交批次前确保达到柱温箱温度。

11. 保存批次：

a. 单击 Save As。
此时会打开 Save As Batch 对话框。

b. 键入 File Name，然后单击 Save。
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12. 提交批次。请参阅以下章节：提交批次。

从 LIMS 中导入一个批次

必要程序

• 在 Configuration 工作区中配置 LIMS。请参阅文档：《帮助系统》。

注释: 要从 Watson LIMS 导入批次，请参阅以下章节：从文件中导入一个批次。

1. 打开 Batch 工作区。

2. （可选）单击 View，以选择将显示在 Batch 工作区内的列。

3. 单击 Open > Import from LIMS。
Import a Batch File 对话框打开。

4. 键入文件位置或文件名称。

5. 在 Batch Identifier 字段键入批次标识符。

6. （可选）根据需要选择或取消选择 Append to current batch 复选框。

注释: 若用户未选择 Append to current batch 选项，则表格中的任何现有数据都将被覆
盖。

7. 单击 Import。

8. （可选）要将样本板布局用作选择或确认某样本位置的参照物，请单击 Plate Layout。
样本板布局可自动提供未指定样本的孔位和进样瓶位置。

9. （可选）要将校准样本包含在批次内，请执行以下操作：

a. 要打开 Batch-Automatic Calibration Editor 对话框，请单击 Auto-Calibrate。

b. 在指定频率下，选择要自动应用的离子参照物和校准物输送设置。

c. 单击 OK。

d. 选择 Auto-Calibrate 按钮左侧的复选框。

10. 提交批次前确保达到柱温箱温度。

11. 保存批次：

a. 单击 Save As。
此时会打开 Save As Batch 对话框。

b. 键入 File Name，然后单击 Save。

12. 提交批次。请参阅以下章节：提交批次。

手动创建批次

提交样本前，请检查批次目录。
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注释: 如果质谱仪采用触点闭合与外部设备通信，那么请遵循该等指南：

• 请确保批次中定义的样本序列与外部设备上定义的序列相匹配。

• 请确保方法持续时间少于或等于外部设备上所定义的进样之间的时间间隔。

提示! 要使用剪切、复制、粘贴、添加行和删除行等功能，请单击 Manage Samples。

1. 打开 Batch 工作区。

2. （可选）单击 View，以选择将显示在 Batch 工作区内的列。

提示! 如要使用现有批次，可单击 Open > Open.

3. 单击 New。

4. （可选）要将样本板布局用作选择或确认某样本位置的参照物，请单击 Plate Layout。
样本板布局可自动提供未指定样本的孔位和进样瓶位置。

5. 在表格中键入批次信息。

关于表格中的列的描述，请参阅表格：表 5-5。

提示! Batch 工作区提供以下功能，以更轻松地创建批次：

• Sample Type 等单元格的内容可以从单元格列表中选择。单击单元格右侧显示列表。

• 添加到批次中的第二行及随后的行将自动填充前一行的值。

• 用户可以通过选中单元格、单击单元格的右下角，然后拖动到单元格内容将复制到的最
后一行来复制单个单元格。

• 用户可以通过选中单元格、单击最右侧单元格的下角，然后拖动到单元格内容将复制到
的最后一行来复制同一行中的一组单元格。

• 用户可以通过在两行中键入连续值、选中这两个单元格、单击底部单元格的右下角，并
拖动到该系列中的最后一行来复制一系列值。

• 用户可以使用 Copy (Ctrl+C) 和 Paste (Ctrl+V) 命令复制一个单元格或一组单元格的内
容，然后将它们粘贴到新位置。

注释: LC 列在 LC 方法被选中前不可用。
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提示! 要配置批次以在采集样本后自动处理样本，请使用以下方法之一：

• 要使用内嵌的处理方法，请选择现有的 Results File。样本将使用相应 Results 文件的
内嵌方法进行处理。

• 若要使用新的处理方法，请清除 Results File 字段。清除 Results File 字段时，
Processing Method 字段将可用。选择一种 Processing Method，然后键入新的
Results File 名称。样本将使用选中的处理方法进行处理。

在非目标筛选工作流中进行处理时，无法选择比较样本进行自动处理。对于使用
AutoPeak 算法的处理方法，软件始终使用创建方法所用的样本来构建积分模型。

6. （可选）定义成分浓度。请参阅以下章节：添加成分浓度

7. （可选）按以下步骤对批次应用决策规则：

a. 选择 Decision Rules 复选框。

b. 单击 Decision Rules，然后对要应用到批次的每个决策规则选择 Apply。要添加决
策规则，请参阅以下章节：添加决策规则。

c. 单击 Save。

注释: 如已选择 Decision Rules 选项，且至少一个决策规则是对于该批次是活动的，则
在 Queue 工作区批次名称旁显示 Decision Rules: Active。如活动项目位于该网络且网
络不可用，则显示文本 Decision Rules: Disabled。

8. 保存批次：

a. 单击 Save As。
此时会打开 Save As Batch 对话框。

b. 键入 File Name，然后单击 Save。

9. 提交批次前确保达到柱温箱温度。

10. 确保使用批次中所用的 MS 和 LC 方法平衡系统。

11. 提交批次。请参阅以下章节：提交批次。

使用样本板布局功能创建批次

样本板布局功能可为用来填充 Batch 工作区内表格的样本架和样本板结构提供图形显示。

1. 打开 Batch 工作区。

2. 选择 MS Method。

3. 选择 LC Method。
LC 系统必须处于活动状态。

4. 键入将保存采集数据的 Data File 的名称。

5. 选择将用于在采集后处理数据的 Processing Method。

6. 键入将保存处理数据的 Results File 的名称。

7. 单击 Plate Layout。
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Plate Layout 窗口随即打开，并且在默认情况下显示孔板示意图。

8. 设置孔板的属性。
该窗口更新，以图示所选定的孔板类型。

9. 在该示意图中，单击一个样本位置。
所选样本位置在该示意图中完全高亮显示。Batch 工作区更新，从没有完全定义样本位置
的第一行开始，也就是说，不包含 Rack Type、Plate Type（若使用样本板）和 Vial
Position 值。该表格会相应显示样本位置。

10. 根据需要在示意图中继续单击样本位置，以填充 Batch 工作区内的表格。

如果在 Batch 工作区内的表格中键入样本位置，则示意图会相应更新。

提示! 要删除与指定支架类型相关的所有数据，请单击 Clear All。如果选定的支架类型识
别出一个孔板，则 Clear All 下的菜单会包含 Clear Front 和 Clear Back。

11. 要指定重复的选定样本位置，请单击示意图中的样本位置。
样本板布局的示意图用彩色轮廓显示重复样本位置，Batch 工作区内的表格显示相应的数
据。

图 5-4 样本板布局——重复的样本位置（位置 1）

注释: 未选中的位置以灰色显示，曾选中的位置以带灰色边框的蓝色显示。

12. 要查看示意图中的样本索引，请将鼠标悬停在高亮显示的样本位置上方。
一条工具提示会显示相应的样本索引。

13. 当所有位置分配并审核完毕，请单击 Plate Layout 窗口内的 Close，然后单击 Batch 工作
区内的 Save。

创建离子参考表

1. 打开 Batch 工作区。

2. 单击 Auto-Calibrate。
Batch - Automatic Calibration Editor 对话框随即打开。

3. 单击 Edit。
Ion Reference Table Editor 对话框随即打开。

4. 单击 New。
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提示! 使用 Tab 键，在单元格之间移动，然后按下 Enter 以添加一行。

5. 在 Reference Ions for TOF MS Calibration 表格中，键入前体离子质量。
Compound Name 字段可选。

6. 根据需要添加行。

7. 在 Use 列中，选择要使用的图标。

8. 选择 Use for MS/MS 单选按钮，以将前体离子质量用于 MS/MS。

9. 在 CE for MS/MS 和 DP for MS/MS 字段中，为步骤 8 选中的前体离子质量键入数值。

10. 在 Reference Ions for MS/MS Calibration 表格中，添加并选择至少两个碎片质量。

Fragment Name 字段可选。

11. 单击 OK。

12. 在 Save Reference Table 对话框中键入一个名称，然后单击 OK。

注释: 如果用户选择 LC Method 作为校准物输送方法，则必须在 Reference Ions 表中指
定 Retention Time 和 Retention Time Tolerance。

使用 CDS 校准系统

注释: 如果通过触点闭合选项配置质谱仪，那么请参阅以下章节：校准通过触点闭合配置的系
统。

1. 打开 Batch 工作区。

2. 单击 Auto-Calibrate。
Batch - Automatic Calibration Editor 打开。

3. 选择离子参考表。

注释: 对于 TOF MSMS 方法，确保在参考表中选择的前体离子质量大于方法中的最小前
体离子质量。

4. 键入要在校准之间采集的样本数量。

5. 选择 CDS 作为校准物输送方法。
默认情况下，会选中 CDS 通道 1。将通道 1 用于阳性溶液，将通道 2 用于阴性溶液。

6. 单击 OK 关闭对话框。

7. 确保选中了 Auto-Calibrate 按钮左侧的复选框。

8. 创建并提交批次。

使用液相色谱方法校准系统

注释: 如果通过触点闭合选项配置质谱仪，那么请参阅以下章节：校准通过触点闭合配置的系
统。

1. 打开 Batch 工作区。
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2. 单击 Auto-Calibrate。
Batch - Automatic Calibration Editor 打开。

3. 选择离子参考表。

4. 键入要在校准之间采集的样本数量。

5. 选择液相色谱方法作为校准物输送方法。
右侧对话框会显示自动进样器架、孔板和样品瓶以及质谱方法字段。

6. 选择质谱方法，然后选择合适的进样器架、孔板和样品瓶信息。

7. 单击 OK 关闭对话框。

8. 确保选中了 Auto-Calibrate 按钮左侧的复选框。

9. 创建并提交批次。

管理成分浓度
添加成分浓度

批次中包含 MS 方法、处理方法或 Results Table 中定义的成分浓度。使用此程序添加其他成
分浓度。

注释: 对于 QualityControl 和 Standard 类型的样本，通过此程序添加的成分浓度可进行编辑。
当含有成分的处理方法经过样本定义后，成分浓度列会被添加到批次中。通过处理方法添加的
成分浓度仅对包含该成分的处理方法样本是可编辑的。

1. 在 Batch 工作区中，单击 Component Concentrations ( )。

2. 单击 Manage Components > Add Component。

3. 键入 Component 的名称。

4. 单击 OK。
新成分浓度即会添加到当前批次中。

删除成分浓度

通过该步骤将某个成分浓度从批次中删除。

1. 在 Batch 工作区中，单击 Component Concentrations ( )。

2. 单击 Manage Components > Remove Component。
此时会显示成分列表。其中将包含使用 Add Component Concentration 命令添加的所
有成分，以及某种 MRM 方法或者处理方法添加到该批次的时间。

3. 从列表中选择浓度。

4. 单击 OK。

管理决策规则
添加决策规则

使用此程序添加决策规则。
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1. 在 Batch 工作区中，单击 Decision Rules。
Decision Rules 对话框打开。

2. 单击 Add Rule。
Decision Rules Configuration 对话框打开。

3. 为决策规则键入名称。

4. 定义决策规则的属性，包括标记规则，何时评估决策规则，以及响应。请参阅文档：《帮
助系统》。

5. 单击 Save 保存该决策规则。

6. 单击 Save 关闭对话框。

注释: 如果用户不点击 Decision Rules 对话框上的 Save，新的决策规则将不会被保存。

更改决策规则

1. 在 Batch 工作区中，单击 Decision Rules。
Decision Rules 对话框打开。

2. 单击要更改的决策规则的 Decision Rule Name。
Decision Rules Configuration 对话框打开。

3. 更改决策规则的 Decision rule name 和设置，包括标记规则，何时评估决策规则，以及
响应。请参阅文档：《帮助系统》。

4. 单击 Save 保存该决策规则。

5. 单击 Save 关闭对话框。

注释: 如果用户不点击 Decision Rules 对话框上的 Save，新的决策规则将不会被保存。

删除决策规则

使用此程序删除决策规则。

1. 在 Batch 工作区中，单击 Decision Rules.。
Decision Rules 对话框打开。

2. 单击 Flagging Rule Used。

3. 单击 Delete Rule 删除该决策规则。

4. 单击 Save。

创建副本规则

使用此程序创建副本规则。

1. 在 Batch 工作区中，单击 Decision Rules。
Decision Rules 对话框打开。

2. 单击要复制的决策规则。

3. 单击 Duplicate Rule。
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4. 单击 Save。

导入决策规则

使用此程序导入决策规则。

1. 在 Batch 工作区中，单击 Decision Rules。
Decision Rules 对话框打开。

2. 单击 Import List。

3. 导航至要导入的文本文件并选中，然后单击 Open。

4. 单击 Save。

导出决策规则

1. 在 Batch 工作区中，单击 Decision Rules。
Decision Rules 对话框打开。

2. 单击 Export List。

3. 导航至您希望保存文本文件的位置，键入文件名，然后单击 Save。

4. 单击 Cancel。

平衡系统

在早上运行新方法之前或提交批次之前平衡系统。平衡是为质谱仪和 LC 系统处理后续样本或
批次做预热和准备。

1. 单击状态面板上的 Equilibrate。
Equilibrate 对话框随即打开。

2. 从 MS Method 列表中选择一种 MS 方法。

3. 从 LC Method 列表中选择一种 LC 方法。

4. 在 Time (min) 字段中键入平衡时间（单位为分钟）。

5. 单击 OK。
当平衡完成时，状态面板中的系统状态为 Ready。

提示! 打开 Queue 工作区监控平衡进度。Queue 工作区表示平衡完成所需时间。要在完
成前停止平衡，请单击 Queue 工作区中的 Stop。

提交批次

必要程序

• 平衡系统。

• 在 Batch 工作区中打开批次。

1. 单击 Submit。
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Submit Samples 对话框随即打开。

2. 单击 OK 继续。

注释: 如果选择了 Auto-Calibrate 选项且通过触点闭合选项来配置质谱仪，那么将自动执
行第一次校准运行。然后，系统转为 Loading 状态，直到用户在外部设备上开始进样。

若屏幕顶端显示出现错误，解决后重新单击 Submit。在所有的错误得到解决之前，批次
不会添加到队列中。

提示! 若队列未启动，请导航至 Queue 工作区，然后单击菜单栏上的 Start。

从 Batch 工作区提交单个样本到队列

必要程序

• 平衡系统。

• 在 Batch 工作区中打开批次。

1. 选择样本的行标识号。

2. 单击 Submit。
Submit Samples 对话框随即打开。

3. 单击 OK 继续。

注释: 如果选择了 Auto-Calibrate 选项且通过触点闭合选项来配置质谱仪，那么将自动执
行第一次校准运行。然后，系统转为 Loading 状态，直到用户在外部设备上开始进样。

若屏幕顶端显示出现错误，解决后重新单击 Submit。在所有的错误得到解决之前，批次
不会添加到队列中。

提示! 若队列未启动，请导航至 Queue 工作区，然后单击菜单栏上的 Start。

从 Batch 工作区提交多个样本到队列

必要程序

• 平衡系统。

• 在 Batch 工作区中打开批次。

1. 执行以下任一操作：

• 单击每个样本的样本行标识号的同时按下 Ctrl。

• 向上或向下拖动标识号列表。

注释: 样本将按照选定顺序提交，而不按照在批次中的显示顺序提交。
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2. 单击 Submit。
Submit Samples 对话框随即打开。

3. 单击 OK 继续。

注释: 如果选择了 Auto-Calibrate 选项且通过触点闭合选项来配置质谱仪，那么将自动执
行第一次校准运行。然后，系统转为 Loading 状态，直到用户在外部设备上开始进样。

若屏幕顶端显示出现错误，解决后重新单击 Submit。在所有的错误得到解决之前，批次
不会添加到队列中。

提示! 若队列未启动，请导航至 Queue 工作区，然后单击菜单栏上的 Start。

Queue 工作区
Queue 工作区显示：

• 队列状态

• 批次状态

• 样本采集和处理状态

在此工作区中，用户可以管理队列中的批次和样本。

默认状态下样本不会显示在队列中。样本信息折叠在批次名称下方。显示批次状态、批次名
称、批次中的样本数量和采集当前批次的剩余时间。包含在批次内的校准样本在队列中的
Sample Name 列中显示为 Cal。

对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

注释: 样本采集过程中，请勿手动更改集成分流阀位置。

图 5-5 Queue 工作区
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表 5-7 Queue 工作区列

标签 描述

Batch Name 提交到该队列的批次名称、批次中的样本数，以及决策规则处理状
态。
队列中每批次为一行。默认情况下，批次为折叠，但可以展开显示该
批次中的所有样本。对于每个样本，在如下列显示信息。

注释: 对于含决策规则处理的批次，软件延迟采集下一个样本，以保证
当前样本的处理完成。如未在允许时间内完成处理，则禁用决策规
则。延时时间是采集时间的 1.5 倍。

Acquisition Status （采集状态）数据采集的状态。有关状态图标的信息，请参阅以下章
节：队列图标。

Est. Start Time （估计开始时间）此样本采集开始的时间。

Acquisition Time （采集时间）采集此样本所需时间。

Sample Name （样本名称）批次中指定的样本名称。

Sample ID （样本 ID）批次中指定的样本标识符。

Barcode （条形码）批次中指定的样本瓶条形码编号。

Rack Code （支架代码）批次中指定的 LC 支架标识符。

Rack Position （支架位置）批次中指定的 LC 支架的安装位置。

Plate Code （孔板代码）批次中指定的 LC 孔板的标识符。

Plate Position （孔板位置）批次中指定的 LC 孔板的安装位置。

Vial Position （进样瓶位置）样本在 LC 孔板或支架中的位置。

MS Method （MS 方法）批次中指定的 MS 方法。

LC Method （LC 方法）批次中指定的 LC 方法。

Injection Volume （注射体积）注射的样本量。

Data File （数据文件）数据将采集到的数据文件的名称。

Scanned Barcode （扫描的条形码）进样瓶的标识符。

User （用户）提交批次的用户的名称。

Project （项目）将在其中保存数据文件的项目。

Data File Status （数据文件状态）数据文件的状态。

Auto Processing
Status

（自动处理状态）数据处理的状态。有关状态图标的信息，请参阅以
下章节：队列图标。

Processing Method （处理方法）将用于处理采集数据的处理方法。如果使用现有的
Results 文件，则此列包含文本 *Embedded Method*。

Results File （结果文件）处理的数据将写入到的文件。
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表 5-7 Queue 工作区列 (续)

标签 描述

Decision Rule
Status

（决策规则状态）样本的标记状态和该决策规则采取的措施。

Decision Rule
Summary

（决策规则摘要）触发的决策规则的名称。

管理队列

样本自 Batch 工作区提交之后开始采集。确认提交批次前系统已经经过平衡。请参阅以下章
节：平衡系统。

注释: 如果在样本采集过程中出现异常终止，请再次运行该样本。如果异常终止是由停电引
起，则自动进样器托盘的温度不再保持恒定，因而给样本品质带来问题。

使用下表中的特性来管理队列中的样本和批次。

表 5-8 Queue 工作区特性

目的 方法

显示或隐藏列。 单击 Manage > Display Columns。请参阅以下章节：显示
或隐藏列。

查看批次中的所有样本。
单击 。

折叠批次中的所有样本。 单击 。

开始采集。 单击 Start。运行任何样本前要对系统进行平衡。

查看已提交样本的状态。 双击批次标题。

重新采集所选样本。 1. 单击样本。

2. 单击 Manage > Reacquire samples。

删除所选样本。 1. 单击样本。

2. 单击 Manage > Delete samples。

删除所选样本标题下的全部样
本。

1. 单击样本。

2. 单击 Manage > Delete samples below row
selection。

清除队列中的全部已采集批次
或样本。

单击 Manage > Clear queue。

从所选的行中删除焦点。 单击 Manage > Clear all selections。
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表 5-8 Queue 工作区特性 (续)

目的 方法

将选定批次或样本移动到队列
的顶部。

1. 单击批次标题。

2. 单击 Manage > Move row to top。

注释: 只能移除未采集到的单个批次或样本。

将选定样本在队列中向上移
动。

1. 单击样本。

2. 单击 Manage > Move row up。

注释: 只能移除未采集到的单个样本。

将选定样本在队列中向下移
动。

1. 单击样本。

2. 单击 Manage > Move row down。

注释: 只能移除未采集到的单个样本。

折叠全部样本和批次。 单击 Manage > Collapse all rows。

显示全部样本和批次。 单击 Manage > Expand all rows。

查看正在采集的样本的数据。 执行以下任一操作：
• 双击正在采集的样本。

注释: 双击 Processing Status 列左侧的其中一个列。

• 单击 Data Acquisition 面板中的 Open data exploration

to view real time data ( )。

查看已采集到的样本中的数
据。 双击 Acquisition Status 列中绿色的复选标记 ( )。

查看已创建的 Results 文件。
双击 Processing Status 列中绿色的复选标记 ( )。

查看正在扫描的条形码瓶。 1. 单击 Manage > Display Columns。

2. 选择 Select Columns 对话框中的 Barcode 或 Scanned
Barcode 复选框或此两者。请参阅以下章节：显示或隐
藏列。

3. 单击 OK。
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表 5-8 Queue 工作区特性 (续)

目的 方法

停止队列。 1. 单击 Stop。

2. 选择 Stop now 或 Stop after the current tasks are
completed。

3. 单击 OK。

停止所有剩余排队样本的处
理。

1. 单击 Cancel remaining processing。

2. 单击 Yes。

打印队列。 单击工作区菜单中的 Print。

显示或隐藏列

1. 在 Queue 工作区中，单击 Manage > Display Columns.

2. 根据需要在 Display Columns 对话框中，选择或取消选择该列复选框。关于列描述，请参
阅表格：表 5-7。
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图 5-6 Display Columns 对话框

3. 单击 OK。

队列图标

表 5-9 队列图标

图标 名称 描述

展开箭头 显示批次中的样本。

折叠箭头 隐藏批次中的样本。
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表 5-10 采集状态图标

图标 1 名称 描述

Completed 样本或整个批次采集成功。双击此图标以在 Explorer 工
作区中打开样本。

Warning 样本采集成功，但用户停止或扩展了采集。

Failed 样本或批次内的任何样本未成功采集。

Failed 校准样本不符合验收标准。双击该图标以查看状态报告。

In Progress 正在采集样本或批次。

Waiting 样本或批次暂未采集成功，或者未处在采集过程中。

Barcode Warning 条形码读取错误或者条形码扫描与样本不匹配。

表 5-11 处理状态图标

图标 2 名称 描述

Completed 样本处理成功。双击此图标以在 Analytics 工作区中打开
Results 文件。

Warning 处理被用户停止。

Failed 样本未处理成功。

In Progress 样本正在处理。

Waiting 样本尚未处理。

表 5-12 判定规则状态图标

图标 3 4 名称 描述

Flagging rule
passed

样本符合在判定规则中配置的标记规则的通过条件。

1 如果使用判定规则，则采集状态可能会受到判定规则影响。例如，判定规则可能会中止样本或停止队列。判
定规则会考虑批次中的所有样本、是否有样本正被处理到不同 Results 文件中，然后考虑关联的 Results 文
件。即使是在队列中不再可见的样本也会考虑在内。

2 如果 Processing Status 列为空，则没有为样本选择任何处理方法或 Results 文件。
3 当用户将光标悬停在判定规则名称、标记规则名称和采取的操作上时，将会显示标记状态图标及其工具提

示。
4 如果用户选择在采集所有标准品后评估规则，则追溯性地更新标记样本的状态。
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表 5-12 判定规则状态图标 (续)

图标 名称 描述

Flagging rule
marginal

样本符合在判定规则中配置的标记规则的临界条件。

Flagging rule failed 样本符合在判定规则中配置的标记规则的失败条件。

Queue stopped 根据判定规则停止队列。当停止队列并采集下一个批次
时，也会显示此图标。

Sample injected 样本根据判定规则重新进样，或者样本从判定规则中配置
的进样瓶进样。

表 5-13 数据文件状态图标

图标 名称 描述

Transfer Complete 样本已成功传输至网络项目。

Transfer in Process 样本正在传输至网络项目。

Transfer Failed 样本传输失败。SCIEX OS 将尝试再次传输样本。

MS Tune 工作区
保存仪器数据时软件会创建一个 dat 文件。可使用该文件来恢复之前的参数状态。dat 备份文
件以文件创建时间而不是备份时间命名。

注释: 当使用 APCI 探针时，仅 Quick Status Check 和 Advanced Troubleshooting 功能可
用。要执行任何其他调谐程序，请安装 ESI 探针。

用户每次加载 MS 调谐程序时，所有质谱仪参数都会备份。

对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

执行快速状态检查

必要程序

• 确保安装正确的探针

使用该程序可在 TOF MS 和 MS/MS 模式下校准系统并快速验证分辨率。如果通道校准质量准
确度不符合规范，则用户可重复这些步骤并校准该系统。如果分辨率不符合规范，则用户可执
行 TOF 调谐程序，以优化系统。

提示! 用户可通过单击状态面板上的 MS Check 来评估该程序。
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注释: 如果质谱仪配置有 CDS，那么软件将在开始 Achieve Stable Spray 步骤时自动启动
CDS。当用户关闭 MS Tune 工作空间时，软件将停止 CDS。

1. 打开 MS Tune 工作区。

2. 从 Tuning Procedures 列表中选择 Positive Quick Status Check 或 Negative Quick
Status Check。

3. 单击 Next。

4. 按照屏幕上的操作说明执行每个步骤。请参阅文档：《帮助系统》。

5. （可选）检查报告以验证每一步的结果。

6. （可选）保存该报告。

7. 如果结果令人满意，请单击 Save Tuning Settings。如果结果不能令人满意，请执行以
下任一操作：

• 重复这些步骤。

• 运行 TOF MS 调谐程序。请参阅以下章节：调谐 TOF。

• 关闭 MS Tune 工作区，以舍弃这些结果。

• 通过从 Restore Instrument Data 菜单选择合适的备份文件，可恢复之前设置。

优化检测器

当系统灵敏度较低时，请使用本程序验证检测器电压是否已优化。在本程序进行过程中，软件
可调节检测器电压，以提供最佳灵敏度。当完成优化时，用户可保存优化值或舍弃改动。

注释: 确保在 High Mass 和 Low Mass 模式执行此程序。

我们建议每月优化一次检测器。如果存在明显的灵敏度下降以及对仪器进行排气和清洁之后，
也应当优化检测器。

注释: 检测器老化与离子接触呈函数关系，因此，当使用高浓缩样本时有必要进行更为频繁的
优化。

注释: 如果质谱仪配置有 CDS，那么软件将在开始 Achieve Stable Spray 步骤时自动启动
CDS。当用户关闭 MS Tune 工作空间时，软件将停止 CDS。

1. 打开 MS Tune 工作区。

2. 从 Tuning Procedures 列表中，执行以下操作之一：

• （ZenoTOF 系统）选择 Positive Detector Optimization 或 Negative Detector
Optimization。

• （X500 QTOF 系统）选择 Detector Optimization。

Introduction 页面随即显示。它描述了优化过程的目的、前提条件及指示。

3. 确保正确配置注射泵。请参阅文档：《系统用户指南》。然后单击 Next。

4. 确保喷雾稳定，之后单击 Next。
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5. 请按照屏幕上的指示操作。 请参阅文档：《帮助系统》。
优化报告随即显示。

6. （可选）通过以下步骤保存报告：

a. 在 Report 页面，单击 Save report as。。

b. 浏览至您希望保存报告的位置，键入 File name，然后单击 Save。

7. 单击 Next。

8. 单击 Save Settings。

注释: 如果检测器在 2650 V 或更高的电压下进行优化，请联系 sciex.com/request-
support 以更换检测器。

系统将显示以下消息：“Tuning settings were saved”。

调谐 Q1 单位

在 MS/MS 实验中，Q1 区域用来选择碎裂所需的前体离子。Q1 单位调谐可优化峰宽并校准
Q1 质量。Q1 单位表示前体离子选择窗口在单位分辨率下的宽度。“Q1 低或开放”表示前体离
子选择窗口在低分辨率（宽窗口）或开放分辨率（开放窗口）下的宽度。Q1 单位调谐完成
后，Q1 低和开放设置根据 Q1 单位值进行计算。

注释: 如果质谱仪配置有 CDS，那么软件将在开始 Achieve Stable Spray 步骤时自动启动
CDS。当用户关闭 MS Tune 工作空间时，软件将停止 CDS。

1. 打开 MS Tune 工作区。

2. 从 Tuning Procedures 列表中选择 Positive Q1 Unit Tuning 或 Negative Q1 Unit
Tuning。

3. 单击 Next。

4. 按照屏幕上的操作说明执行每个步骤。 请参阅文档：《帮助系统》。

5. （可选）单击 Edit Method，以调整参数。

6. 如果已进行过校准，则应单击 Confirm 以运行一次确认性采集。

7. 单击 Next。

8. （可选）保存该报告。

9. 单击 Next。

10. 单击 Save Settings。

调谐 TOF
TOF MS 调谐程序可在 TOF MS 和 MS/MS 模式下优化分辨率和灵敏度参数。优化过程的第一
步是在调谐开始前先验证系统性能，然后优化各种参数以达到最大强度和分辨率。通道对准
后，对系统进行校准并确定系统性能。如果性能令人满意，则用户可将调谐设置保存至系统，
否则可舍弃这些设置。
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TOF MS 调谐可在 Automatic 或 Manual 模式下进行。在 Manual 模式下，用户可选择优化的
参数值，或者在调谐步骤结束时暂停。

注释: 如果质谱仪配置有 CDS，那么软件将在开始 Achieve Stable Spray 步骤时自动启动
CDS。当用户关闭 MS Tune 工作空间时，软件将停止 CDS。

1. 打开 MS Tune 工作区。

2. 从 Tuning Procedures 列表中，执行以下操作之一：

• （X500 QTOF 系统）选择 Positive TOF MS Tuning 或 Negative TOF MS Tuning。

• （ZenoTOF 系统）选择 Positive TOF Tuning 或 Negative TOF Tuning。

3. 确保喷雾稳定。

4. 单击 Next。

5. 按照屏幕上的操作说明执行每个步骤。 请参阅文档：《帮助系统》。

6. 单击 Next。

7. （可选）保存该报告。

8. 如果结果令人满意，请单击 Save Settings。如果结果不能令人满意，请执行以下任一操
作：

• 重复这些步骤。

• 关闭 MS Tune 工作区，以舍弃这些结果。

• 通过从 Restore Instrument Data 菜单选择合适的备份文件，可恢复之前设置。

• 请联系 sciex.com/request-support。

调谐“Q1 高”
在 MS/MS 实验中，Q1 区域用来选择碎裂所需的前体离子。调谐“Q1 高”可优化峰宽并校准
Q1 质量。“Q1 高”代表较窄的前体离子选择窗口。

注释: 如果质谱仪配置有 CDS，那么软件将在开始 Achieve Stable Spray 步骤时自动启动
CDS。当用户关闭 MS Tune 工作空间时，软件将停止 CDS。

1. 打开 MS Tune 工作区。

2. 从 Tuning Procedures 列表中选择 Positive Q1 High Tuning 或 Negative Q1 High
Tuning。

注释: 如果正向“Q1 高”调谐程序尚未长时间运行，请单击 Copy，以使用正向 Q1 单位设
置作为起点。

3. 确保喷雾稳定。

4. 单击 Next。

5. 按照屏幕上的操作说明执行每个步骤。 请参阅文档：《帮助系统》。

6. （可选）单击 Edit Method，以调整参数。
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7. 如果已进行过校准，则应单击 Confirm 以运行一次确认性采集。

8. 单击 Next。

9. （可选）保存该报告。

10. 单击 Next。

11. 单击 Save Settings。

校准 Zeno（ZenoTOF 系统）

1. 打开 MS Tune 工作区。

2. 从 Tuning Procedures 列表中选择 Positive Zeno Calibration 或 Negative Zeno
Calibration。
Introduction 页面随即显示。它叙述校准流程的目的和前提条件。

3. 确保喷雾稳定，之后单击 Next。

注释: 用户可以在 Achieve Stable Spray/Modify 页面上手动调整 Source and Gas
Parameters。

4. 按照屏幕上的操作说明执行每个步骤。请参阅文档：《帮助系统》。

5. 单击 Next。

6. （可选）通过以下步骤保存报告：

a. 在 Report 页面，单击 Save report as。。

b. 浏览至您希望保存报告的位置，键入 File name，然后单击 Save。

7. 单击 Next。

8. 如果结果令人满意，请单击 Save Tuning Settings。如果结果不能令人满意，请执行以
下任一操作：

• 重复这些步骤。

• 关闭 MS Tune 工作区，以舍弃这些结果。

• 通过从 Restore Instrument Data 菜单选择合适的备份文件，可恢复之前设置。

执行 EAD 优化（ZenoTOF 系统）

1. 打开 MS Tune 工作区。

2. 从 Tuning Procedures 列表中选择 EAD Optimization。
Introduction 页面随即显示。它叙述优化流程的目的和前提条件。

3. 选择 Tuning process，然后单击 Next。

4. 在 Filament Calibration Verification 页面上，选择 Filament，然后单击 Calibrate
Filament。

提示! 要更换所选灯丝，单击 Filament 字段中的列表，然后选择所需的灯丝。

5. 单击 Next。
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6. 确保喷雾稳定，之后单击 Next。

注释: 用户可以在 Achieve Stable Spray/Modify 页面上手动调整 Source and Gas
Parameters。

7. 按照屏幕上的操作说明执行每个步骤。请参阅文档：《帮助系统》。

8. 单击 Next。

9. （可选）通过以下步骤保存报告：

a. 在 Report 页面，单击 Save report as。。

b. 浏览至您希望保存报告的位置，键入 File name，然后单击 Save。

10. 单击 Next。

11. 单击 Save Settings。

执行 EAD EI 背景减除（ZenoTOF 系统）

1. 打开 MS Tune 工作区。

2. 从 Tuning Procedures 列表中选择 EAD EI Background Reduction。
Introduction 页面随即显示。它叙述调谐程序的目的和前提条件。

3. 单击 Next。

4. 按照屏幕上的操作说明执行每个步骤。请参阅文档：《帮助系统》。

5. 单击 Next。

6. （可选）通过以下步骤保存报告：

a. 在 Report 页面，单击 Save report as。。

b. 浏览至您希望保存报告的位置，键入 File name，然后单击 Save。

执行 EAD 诊断（ZenoTOF 系统）

1. 打开 MS Tune 工作区。

2. 从 Tuning Procedures 列表中选择 EAD Diagnostics。
Introduction 页面随即显示。它叙述 EAD 诊断的目的和前提条件。

3. 单击 Next。

4. 按照屏幕上的操作说明执行每个步骤。请参阅文档：《帮助系统》。

执行 ADC 初始化（ZenoTOF 系统）

1. 打开 MS Tune 工作区。

2. 选择 Tuning Procedures > ADC Initialization。
Introduction 页面随即显示。其中描述了初始化的目的。

3. 单击 Next。
随即显示 ADC Initialization 页面。请参阅文档：《帮助系统》。
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进行高级故障排除

必要程序

• 确保安装正确的探针

如果调谐程序结果不令人满意，则使用这种高级故障排除程序可优化与质谱仪相关的参数。用
户也能在采集过程中查看 TDC 通道统计数据和质谱图。

提示! 实时方法窗口可用来在进行调谐后，查看优化参数。

1. 打开 MS Tune 工作区。

2. 从 Tuning Procedures 列表中选择 Advanced Troubleshooting。

3. 选择一种扫描类型。

4. 单击 Edit Method，然后根据需要在 Live Window 窗口中编辑参数。

5. 单击 Start/Restart Method。

6. 查看数据，然后根据需要调节参数。

7. 单击 Stop，然后保存检测器参数或 TOF MS 参数。

恢复仪器数据

每当用户在每次调谐程序结束时保存调谐设置时，软件均会先生成一份仪器数据文件 (dat) 拷
贝，然后更新当前 dat 文件。之前保存的设置可使用 Restore Instrument Data 功能恢复。

每次执行调谐程序时，会生成报告和数据文件以跟踪优化结果。默认情况下，wiff2 数据文件
和报告可在如下位置找到：D:\SCIEX OS Data\Optimization。

1. 打开 MS Tune 工作区。

2. 从 Restore Instrument Data 菜单中，选择一个拥有较早时间戳的待还原 dat 文件。

图 5-7 Instrument Tuning and Optimization 对话框

3. （可选）按照以下步骤查看要还原的 dat 文件的报告：

a. 单击 View Report。

b. 如果为选定的仪器数据文件生成报告，则导航至报告文件并双击它进行打开。

4. 单击 Yes。
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操作说明 — 处理 6
Explorer 工作区
对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

打开样本

在 Explorer 工作区中执行数据检查任务之前，打开要检查的样本。

1. 打开 Explorer 工作区。

2. 要打开单个样本，请遵照以下步骤：

a. 单击 File > Open Sample。
Select Sample 对话框即会打开。

b. 浏览，然后选择要打开的样本。

c. 单击 OK。

3. 要打开多个样本，请遵照以下步骤：

a. 单击 File > Open Multiple Samples。

b. 在 Select Samples 对话框中，从 Available 列表中选择样本，然后单击箭头以移动
文件至 Selected 列表。

提示! 要选择一个样本，请展开文件，单击该样本，然后单击箭头。

c. 单击 OK。

验证是否存在某种分析物

必要程序

• 打开样本。

1. 提取离子。请参阅以下章节：提取离子。

2. （可选）显示 Data and Peaks Table。请参阅以下章节：显示 Data and Peaks Table。

3. 检查化合物的峰面积、强度、质量和电荷状态。

对于 SCIEX Triple Quad 系统，电荷状态仅适用于全扫描数据类型。
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提取离子

必要程序

• 打开样本。

用来计算一个或多个叠加的提取离子色谱图 (XIC)，此图表示在给定质量范围内作为保留时间
函数的强度的总和。

1. 单击 Show > Extract Ion Chromatogram (XIC)。

图 6-1 Show 菜单：Extracted Ion Chromatogram (XIC)

2. 如果 Specify XIC Ranges 对话框打开，则执行以下步骤：

a. 键入 Center、Width 和 Compound 值或导入值。

注释: XIC 默认标题包括给定行的单元格内所示的化合物名称。

提示! 当使用 Center/Width 模式时，可为该 Center 值指定化学式，而非质量。当使
用中性成分，例如 H2O 时，会在正离子模式下自动加上质子，或在负离子模式下减
去质子。例如，m/z 比（H3O+ 的 m/z 比）将用于正离子模式。通过在该成分的末尾
附加“+n”或“-n”，可明确指定电荷状态（其中，n 表示电荷状态；如果 n 被略去，则视
作 1）。例如，如果指定 H2ONa+，+，则 m/z 比（H2ONa++ 的 m/z 比）按原样使
用。

b. （可选）使用右键菜单中的功能自定义离子提取的选项。有关更多信息，请参阅文
档：《帮助系统》。

c. 单击 OK。
如果活动图包含源自不同样本的叠加系列，则 Process All Overlays? 对话框随即打
开。
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图 6-2 Process All Overlays? 对话框

3. 如果 Select MRMs 对话框打开，则选择 MRM 以包含在 XIC 中，然后单击 OK。

4. 如果 Process All Overlays? 对话框打开，则遵照以下步骤：

a. 执行以下任一操作：

• 选中 All Overlaid，以生成所有可用样本的叠加 XIC。

• 选中 Active Only，以仅从当前活动样本生成 XIC。

b. 单击 OK。

如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

打开 Total Ion Chromatogram
必要程序

• 打开样本。

总离子色谱图 (TIC) 通过将一系列质量扫描中所有离子的强度贡献值进行求和而创建。使用
TIC 可在单一窗格内查看整个数据集。TIC 通过将一次扫描中所有离子的强度之和作为色谱窗
格中所示时间的函数绘制而得。

1. 单击 Show > Total Ion Chromatogram (TIC)。
如果活动图包含源自不同样本的叠加系列，则 Process All Overlays? 对话框随即打开。

2. 如果 Process All Overlays? 对话框打开，则遵照以下步骤：

a. 执行以下任一操作：

• 选中 All Overlaid，以生成所有可用样本的叠加 TIC。

• 选中 Active Only，以仅从当前活动样本生成 TIC。

b. 单击 OK。

如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。
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3. 右键单击 TIC，然后使用右键菜单中的功能。

图 6-3 总离子色谱图的右键菜单

项目 描述

1 当存在一条以上的叠加轨迹时，该功能可用。可从图中删除当前活动的轨
迹。要删除一条当前不活动的轨迹，可将其激活，然后再选择该功能。

2 当存在一条以上的叠加轨迹时，该功能可用。可删除当前活动轨迹以外的
所有轨迹。如果要保留的轨迹当前不活动，则应将其激活，然后再选择该
功能。

3 给图形添加文本。

如果需要，可单击 Font 以调节字体属性，然后再单击 OK。将说明文字
添加在 (x, y) 位置，用户可在此位置右键单击，以打开菜单。

添加说明文字后，用户可将其拖至新位置。如果用户拖动其进入 X 或 Y
轴，则会取消拖动操作。

字符序列“\d”和“\u”按照特殊方式进行处理。在前一种情况下，紧随字符绘
制为下标，而后一种情况则将其绘制为上标。在两种情况下，特殊字符均
不可见。这对化学式而言尤其有用。例如，'H\d3O\u+’ 显示为 H3O+.

4 编辑选定的说明文字。用户也可通过双击说明文字来打开该对话框。

5 删除选定的说明文字。或者，将说明文字拖到图形外，以将其删除。

6 在图形包含至少一处说明文字时可用。一次性删除所有说明文字。

7 在图形中粘贴一幅图像。

8 可从图形中删除选定图像。
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打开 Base Peak Chromatogram
必要程序

• 打开样本。

可通过将每个质谱图最大峰的强度作为时间的函数生成一张图。

1. 单击 Show > Base Peak Chromatogram (BPC)。

图 6-4 BPC Options 对话框

2. 填充 BPC Options 对话框中的字段。有关字段的信息，请参阅文档：《帮助系统》。

注释: 如果单一选定区域持续 1.0 分钟以上的色谱图在生成基峰色谱图时处在活动状态，
则该时间范围会作为选定区域的默认时间范围。否则，会使用最近的时间范围。有限时间
范围让用户免于手动键入具体范围。

如果活动图包含源自不同样本的叠加系列，则 Process All Overlays? 对话框随即打开。
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图 6-5 Process All Overlays? 对话框

3. 如果 Process All Overlays? 对话框打开，则遵照以下步骤：

a. 执行以下任一操作：

• 选中 All Overlaid，以生成所有可用样本的叠加 BPC。

• 选中 Active Only，以仅从当前活动样本生成 BPC。

b. 单击 OK。

如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

显示 Data and Peaks Table
必要程序

• 打开样本。

Data and Peaks Table 包含两个不同的表格。Data 表显示由一个数据集构成的原始 (X, Y)
值，Peaks 表显示有关峰本身的信息。此表在图形激活时生成。

注释: 图中仅显示高于当前阈值的峰，使用图中 Y 轴上的蓝色箭头进行设置。请参阅以下章
节：在图形中使用数据。

该功能用来为当前的活动数据显示包含两个表格的窗格：一个表格涉及原始 (X, Y) 值，另一个
表格与峰列表有关。

1. 单击 Show > Data and Peaks Table。
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图 6-6 Show 菜单：Data and Peaks Table

2. 使用下表中的功能。

表 6-1 Data and Peaks Table 功能

目的 方法

根据该字段对表格进行排
序。

单击列标题。

复制当前选定的单元格。 右键单击该表格，然后单击 Copy。如果 Data 选项卡已激
活，则选定的 X 和 Y 值会被复制。如果 Peaks 选项卡已激
活，则选定的峰信息会被复制。

仅复制选定行。 首先，通过在行选择器列内拖动以选择行，使用 Shift 或
Ctrl 键可选择多行。然后，右键单击该表格，并单击
Copy。

选择多列。 按住 Ctrl 键，然后单击列标题。如果用户仅单击列标题，则
会对此列排序。

复制整表。 单击 Edit > Select All，然后单击 Edit > Copy。

导出数据为文本。 右键单击该窗格，然后单击 Export Data as Text。

可将整个数据列表保存至指定文件。X 和 Y 值用一个制表符
隔开，每对 (X, Y) 后都有一个硬回车。
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表 6-1 Data and Peaks Table 功能 (续)

目的 方法

导出峰列表数据为文本。 右键单击该窗格，然后单击 Export Peak List as Text。

可将整个峰列表保存至指定文件。这不包括低于当前阈值
（在相关图形的 Y 轴设定）的峰。峰度量指标用制表符隔
开，每个峰后面都有一个硬回车。

3. 检查化合物的峰面积、强度、质量和电荷状态。

显示 Sample Information
必要程序

• 打开样本。

Sample Information 窗格对用来采集活动数据的实验进行了文字描述。这些信息包括样本特定
信息，包括样本名称和有关数据采集的信息，如实验的数量和类型。

如果涉及同一数据文件的不同样本的两个或多个 Sample Information 窗格均可见，则单击树状
视图内有关任一窗格的某个项目会使所有其他窗格滚动至相应区域。这时假定所有窗格均存在
同名区域。如果用户想比较两个相似、但不完全相同的样本信息窗格，则该功能非常有用。

单击 Show > Sample Information。

显示 Graph Selection Information
必要程序

• 打开样本。

Graph Selection Information 对话框显示有关色谱图或质谱图内选定区域的信息，可在其中一
个这类窗格激活时生成。

1. 单击 Window > Graph Selection Window。
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图 6-7 Graph Selection Info 对话框

2. 在色谱图或质谱图中进行一项或多项选择。

图 6-8 Graph Selection Info 对话框

3. 适用时，从列表中选择一个选项：Default Info、XY Info、Standard Deviations、
Signal/Noise 或 Manual Reconstruct。
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图 6-9 选择信息选项

关于对话框中的字段的描述，请参阅文档：《帮助系统》。

4. （可选）手动计算信噪比。

a. 选择色谱图或在质量重建工作流中选择重建图形。

b. 用 Shift 键进行多选，一同选择噪声区域和目标峰。

c. 选择 Default Info > Signal/Noise。

5. （可选）单击 Options ( )，设置 Graph Info 选项，然后单击 OK。关于选项描述，请参
阅文档：《帮助系统》。

例如，要使用 3 Sigma 作为噪声因数，将 Noise multipler for S/N 设置为 3。

6. （可选）单击 Fill Peaks( )。
在活动图中，可在深浅交替填充峰与不以交替方式填充峰这两种模式之间进行切换。如果
用户想查看与 Peak Width at Base 相对应的峰范围，则该功能非常有用。

7. （可选）单击 Show Point Symbols( )。
活动窗格中的所有谱图可在用点符号表示数据点与不以点符号表示数据点这两种模式之间
进行切换。如果用户正在仔细检查一个峰并且想了解有多少个数据点构成该峰（而不是仅
使用主窗口所示的文本信息），则该功能非常有用。

在图形中编辑设置

必要程序

• 打开样本。

单击 Edit，然后使用 Edit 菜单中的功能。
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图 6-10 Edit 菜单：Options

项目 描述

1 复制当前数据至剪切板。当质谱图或色谱图激活时，会复制该活动图的一
张图片。

2 当质谱图激活时，将当前图形作为照片复制到剪切板。

3 将整个活动窗口的图像复制至剪切板。其中不包括该窗口的标题栏及其各
种窗格的工具栏。

4 将剪贴板中的数据粘贴到当前视图中。

5 当一个表格激活时，可选择表内的所有行。当一个文本窗格激活时，可选
择全部文本。

6 允许用户设置有关图形外观、峰标记和寻找、自动处理以及计算 XIC 范
围的选项。请参阅以下章节：设置选项。

7 恢复默认的 Explorer 选项。请参阅以下章节：重置选项。

在图形中使用数据

必要程序

• 打开样本。

1. 要设置标记峰的阈值以及诸如 Data and Peaks 表中的后续功能，可拖动图中 Y 轴所示的
蓝色箭头。

操作说明 — 处理

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统
84/301

软件用户指南
RUO-IDV-05-7560-ZH-I



图 6-11 Y 轴上的蓝色箭头

2. 使用 Graph 菜单中的功能。
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图 6-12 Graph 菜单：Options

项目 描述

1 选择要在后续操作中处理的图形部分。例如，选择色谱图中的一个区域，
然后双击以获得平均质谱图。使用 Set Selection 功能，以键入特定的 X
范围，从而可能比使用光标时更准确地设置选定部分。

a. 单击 Graph > Set Selection。

Set Selection 对话框随即打开。

b. 键入 Center 和 Width 值。

c. 单击 OK。

提示! 要在图中手动设置选定部分，请在绘图区拖动光标以进行选择。如
果按住 Shift 键，则任何当前选定部分会得以保留。
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项目 描述

2 出于绘图目的，可按照指定倍数，在一定范围扩大 Y 值。

a. 打开一个样本或多个样本。

b. 在图中选择一个部分。

c. 单击 Graph > Expand Selected Y-Values by。

Expand Selection 对话框随即打开。

d. 键入扩大系数。

e. 单击 OK。

3 清除所有扩大范围。
• 在范围已扩大的图形中，单击 Graph > Clear Expansion Ranges。

4 可从图中删除当前活动的轨迹。当存在一条以上的叠加轨迹时，该功能可
用。
• 在包含一条以上叠加轨迹的图中，单击 Graph > Remove Active

Trace。

5 可删除当前活动轨迹以外的所有轨迹。当存在一条以上的叠加轨迹时，该
功能可用。
• 在包含一条以上叠加轨迹的图中，单击 Graph > Remove All Traces

Except Active。

6 从图中删除所有数据点均低于当前所设阈值的叠加轨迹。

如果用户将图形放大并导致当前只有一部分 X 范围可见，则会打开一个
对话框。用户可选择是使用整个范围还是仅使用当前可用部分来删除低于
阈值的轨迹。

• 在包含一条以上叠加轨迹的图中，单击 Graph > Remove Traces
Below Threshold。

7 当活动图包含一条以上叠加轨迹时，可使用较为浅淡的线条，绘制除当前
活动轨迹以外的所有轨迹。使用该功能可将注意力集中于活动轨迹。这
样，不活动轨迹引起注意力分散的可能性就会减小。要恢复至原始样式，
请再次选择该功能。
• 在包含一条以上叠加轨迹的图中，单击 Graph > Fade Inactive

Trace。

8 当活动图形中包含一条以上叠加轨迹，请反转第二条轨迹。这可使其容易
目视比较两条相似轨迹。再次选择 Invert Second Overlay，可恢复至原
始视图。

9 将单一轨迹图形替换为对所有单独轨迹求和所得的图形。
• 在包含一条以上叠加轨迹的活动图中，单击 Graph > Sum Graph

Traces。
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项目 描述

10 为每个单独叠加轨迹创建一个图形。例如，如果用户从包含三个叠加轨迹
的图中开始，然后选择该功能，那么最终结果包含四个窗格：原图包含所
有叠加轨迹，其余三个图形各包含一个不同的数据集。
a. 在包含一条以上叠加轨迹的活动图中，单击 Graph > Split Traces

into Separate Panes。

Number of Columns 对话框随即打开。

b. 选择输出中的列数。

必需行数根据行数和叠加轨迹数确定。

c. 选择该复选框，可在新窗口中打开窗格。如果该复选框未选中，则会
在同一窗口内打开窗格。

11 可打开 Set Titles 对话框。使用该选项可手动更改轨迹的标题。

12 可打开 Color 对话框。使用该选项可为当前活动图的轨迹设置颜色。

13 可打开 Set Trace Colors Using Titles 对话框。当叠加有多条图形轨迹
时，软件可为叠加轨迹使用默认颜色。使用该选项可为标题包含指定文本
的轨迹设置特定颜色。

14 为当前活动图的数据创建副本，然后将其添加至该图中。使用该功能可查
看特定数据处理操作的效果。例如，如果用户使用该功能复制数据，然后
再对两条轨迹其中之一进行平滑，那么所得图形包含操作之前和之后的的
叠加轨迹。

• 在活动图中，单击 Graph > Duplicate Active Data。

15 为当前活动的图形创建副本。使用该功能可查看特定数据处理操作的效
果。例如，如果用户使用该功能复制数据，然后再对两条轨迹其中之一进
行平滑处理，那么操作之前和之后的轨迹显示在两张不同的图形中。链接
X 轴可使在缩放一个图形时，另一个图形也会自动缩放。

• 在活动图中，单击 Graph > Duplicate Graph。

16 可打开 Offset Traces 对话框。使用该选项可根据一系列叠加图形轨迹创
建一幅三维层叠图。

17 从 TIC 中删除生成的偏移。

使用双窗格操作工具

必要程序

• 打开 Explorer 工作区。

使用沿着窗格右边缘的图标，在两个窗格（源窗格和目标窗格）上执行操作。请参阅以下章
节：表 6-2。在所有情况下，单击源窗格内的图标，然后将其拖至目标窗格。
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表 6-2 双窗格工具

图标 名称 描述

Move Pane 改变窗格的相对位置。显示在每个窗格的右上角。单击
一个窗格中的图标，然后将其拖动至第二个窗格的顶
部、底部、左侧或右侧部分。根据光标释放位置的不
同，第一个窗格相对于第二个窗格的位置改变。当用户
拖动窗格时，第二个窗格的一侧红色高亮，指示第一个
窗格将要放置的位置。

注释: 用户也可以将窗格从一个窗口拖动至另一窗口。

Add Data 逐点对两个数据集进行求和。最初单击的源窗格中的数
据会被添加至目标窗格（拖放图标在该窗格中释放）。
修改后窗格的标题更新，以表明其已修改。

注释: 只有类型相同的两个数据集，才可以相加。例如，
用户不能将质谱图添加至色谱图中。

提示! 如果目标图含有一个以上的叠加轨迹，那么在默认
情况下，源数据只添加至活动目标数据中。按住 Ctrl
键，可将源数据添加到目标窗格内的所有数据集。

Subtract Data 从质谱中减除背景。与 Add Data 图标相似，区别在于
该图标会将源数据从目标数据中减除。

提示! 如果目标图含有一个以上的叠加轨迹，那么在默认
情况下，源数据只从活动目标数据中减除。按住 Ctrl
键，可将源数据添加到目标窗格内的所有数据集。

提示! 通常，不保留源数据内的强度大于目标数据内强度
的任何数据点。也就是说，负 Y 值会被舍弃。按住 Shift
键，可保留强度为负值的数据点。

Overlay Data 将源图内的活动数据叠加在目标图上。操作完成后，目
标图包含一个新系列和一份目标数据。

提示! 如果源图包含一条以上的叠加轨迹，那么在默认情
况下，只有活动数据的一个副本会移动至目标图中。按
住 Ctrl 键，可将源图内所有数据集的一个副本叠加在目
标图上。

移动窗格或窗口

必要程序

• 打开样本。
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单击 Window，然后使用 Window 菜单中的功能。

图 6-13 Window 菜单：Options

项目 描述

1 可打开一个窗口，其中显示活动图内选定区域的信息。例如，选定区域的
X 范围、选定点的强度范围等等。如果该窗口已经显示，则选择该菜单项
会将其关闭。请参阅以下章节：显示 Graph Selection Information。

2 可将窗口的信息布局从行格式更改为列格式。

3 可从窗口中删除当前活动窗格，并将其放在新窗口内。

4 排列任何已打开且尚未最小化的窗口，从而使其都并排位于一行内。

5 排列任何已打开且尚未最小化的窗口，从而使其都上下排列于一列内。

执行高斯平滑

必要程序

• 打开样本。

应用高斯平滑算法。这是一个具有指定宽度的过滤器，其加权因数符合高斯或正态函数。

1. 单击 Process > Gaussian Smooth。

图 6-14 Gaussian Smooth 对话框

2. 在 Smoothing width 字段中键入一个数值。
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这实际上是高斯函数在其最大高度一半时的宽度。总宽度较大是因为此项计算将高斯曲线
的两翼包括在内。如果高斯函数的半宽小于 1 个点，则允许使用分数值。

3. 如果选定图形中有多条迹线，则选择 Process all overlays (otherwise active data
only) ，以将该操作应用至所有迹线。
如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

4. 单击 OK。

阈值数据

必要程序

• 打开样本。

删除强度低于当前阈值设置的任何数据点。拖动图形 Y 轴所示的蓝色箭头，以设置阈值。

1. 单击 Process > Threshold Data。
如果活动图包含源自不同样本的叠加系列，则 Process All Overlays? 对话框随即打开。

图 6-15 Process All Overlays? 对话框

2. 如果 Process All Overlays? 对话框打开，则遵照以下步骤：

a. 执行以下任一操作：

• 选中 All Overlaid，以生成所有可用样本的叠加 TIC。

• 选中 Active Only，以仅从当前活动样本生成 TIC。

b. 单击 OK。

如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。
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使用图形选定的子集数据

必要程序

• 打开样本。

该功能仅在某图形只有一个选定区域激活时才可用。请删除选定区域以外的数据点。使用该功
能可将数据处理聚焦于完整数据的一个子集。

1. 在图中选择一个区域。

2. 单击 Process > Subset Data (using graph selection)。
如果活动图包含源自不同样本的叠加系列，则 Process All Overlays? 对话框随即打开。

图 6-16 Process All Overlays? 对话框

3. 如果 Process All Overlays? 对话框打开，则遵照以下步骤：

a. 执行以下任一操作：

• 选中 All Overlaid，以生成所有可用样本的叠加 XIC 或 TIC。

• 选中 Active Only，以仅从当前活动样本生成 XIC 或 TIC。

b. 单击 OK。

如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

基线减除色谱图

必要程序

• 打开样本。

从一张色谱图中去除变化相对缓慢的背景。

对于色谱图中的每个数据点，窗口在对应 X 值处居中，找到窗口内相对左右强度最小的点。这
两点之间用一条直线连接，Y 值在窗口中心计算得出。这是该点数据要去除的基线。
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1. 单击 Process > Baseline Subtract Chromatogram。

图 6-17 Baseline Subtract 对话框

2. 在 Subtraction half window 字段中键入一个数值（用分钟表示）。

3. 如果选定图形中有多条迹线，则选择 Process all overlays (otherwise active data
only) ，以将该操作应用至所有迹线。
如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

4. 单击 OK。

偏移色谱图

必要程序

• 打开样本。

用来偏移色谱图的时间值。

1. 单击 Process > Offset Chromatogram。

图 6-18 Offset 对话框

2. 在 Total offset 字段中键入一个数值（用分钟表示）。
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3. 如果选定图形中有多条迹线，则选择 Process all overlays (otherwise active data
only) ，以将该操作应用至所有迹线。
如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

4. 选择 Use incremental offset (to fan out overlays) 以在时间方向上将叠加分开。

5. 单击 OK。

为质谱创建质心

必要程序

• 打开样本。

为质谱创建质心，也就是说用质量和强度点取代轮廓谱图，这仅适用于检测到的峰。

1. 单击 Process > Centroid Spectrum。

图 6-19 Centroid 对话框

2. 选择要用于质心过程的度量：

• Intensity：对于每个峰，质心 Y 值就是构成该峰的最大数据点的强度。

• Height ：该度量与强度度量相似，区别在于若存在基线偏移，需从强度值中减除基线
强度。

• Area：对于每个峰，质心 Y 图就是该峰的总面积。这是一个准确的整数，因为报告值
同时取决于强度轮廓和峰宽。

• Intensity sum above 50%：对于每个峰，Y 值就是构成该峰的高于峰顶强度 50% 的
强度部分之和。该值非常有用，因为它不像 Intensity 和 Height 度量那样仅取决于单个
数据点的强度，并且它也不受可能是噪声或可能受到干扰的峰边缘的影响。
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3. 如果选定图形中有多条迹线，则选择 Process all overlays (otherwise active data
only) ，以将该操作应用至所有迹线。
如果 Only show this dialog again if the shift key is down 复选框已选中，则会始终使
用选定操作，直至用户按住 Shift 键更改选项。

4. 单击 OK。

导出数据为文本

必要程序

• 打开样本。

将当前活动的质谱图或色谱图保存至一个制表符分隔文本文件。

1. 单击 File > Export > Data as Text。
如果质谱数据已导出，则 Add Zero Intensity Points for Export 对话框随即打开。

图 6-20 Add Zero Intensity Points for Export 对话框

2. 如果 Add Zero Intensity Points for Export 对话框打开，则执行以下任一操作：

• 单击 No, leave data as-is 从导出的文件中排除强度为零的点。

• 单击 Yes, add points with zero intensity 将强度为零的点包含到导出的文件中。

然后单击 OK。

3. 键入导出文件的文件名。

4. 单击 Save。

导出峰列表为文本

必要程序

• 打开样本。

操作说明 — 处理

软件用户指南
RUO-IDV-05-7560-ZH-I

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统

95/301



用户可将当前活动的质谱图或色谱图的峰列表保存至一个制表符分隔的文本文件。该文件包含
诸如质心 X 值（质量或时间）、峰面积、高度等信息。

1. 单击 File > Export > Peak List as Text。

2. 键入导出文件的文件名。

3. 单击 Save。

打印数据

必要程序

• 打开样本。

1. 单击 File > Print，然后选择所需选项。
Print 对话框随即打开。

2. 选择打印机，然后单击 Print。

重置选项

必要程序

• 打开 Explorer 工作区。

用户可将 Explorer 工作区内的所有选项重置为默认值。这包括在前一节介绍的选项以及处理
选项。重置选项仅影响当前登录的 Windows 用户，而同一计算机的其他用户不受影响。

1. 单击 Edit > Reset Options。
此时会出现一个确认对话框。

2. 单击 OK。

设置选项

必要程序

• 打开 Explorer 工作区。

必要时可使用每个选项卡中的功能。

1. 单击 Edit > Options。
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图 6-21 Options 对话框：Graph Appearance 选项卡

2. 适用时，设置每个选项卡上的选项。关于选项描述，请参阅文档：《帮助系统》。

3. 单击 OK。

Analytics 工作区
对本工作区中特性的访问受用户指定角色控制。请参阅文档：《实验室主管指南》。

注释: 从 Analytics 工作区输出数据的受控方式为：导出 Results Table、将数据传输至 LIMS
以及报告。输出数据的其他来源，比如从结果表复制和粘贴，是不受控的方式。不得将这些非
受控方法用于受管制的用途。

Analytics 工作区不支持数字分组。不要对文本框（例如积分参数）中的数字或 Results Table
等网格中的数字分组。

处理方法包括积分选定峰的定量的标准。

审核人应当按照峰积分标准以及实验室标准操作规程 (SOP) 中的数据接受度来审查数据。

SCIEX OS 可以在 SCIEX OS 或 Analyst 软件采集数据时处理数据。任何采集的样本都可以添
加到 Results Table 中。要添加正在采集的样本，请先等待采集完成，然后将它们添加到
Results Table 中。
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定义项目的默认处理参数

该选项设置创建处理方法时所使用的默认找峰参数。如果成分较多，可根据色谱设置默认值，
这样就无需对每一种成分进行逐个调整。不过，没有哪一组参数对于所有成分都是理想的，因
此，对于某些成分而言，可能需要对某些参数逐一进行调整。

1. 在 Analytics 工作区中，单击 Projects > Project default settings。

注释: 请确保在状态面板选中当前项目名称。

此时 Project Default Settings 对话框打开。

2. 在 Quantitative Processing 页面上，执行这些步骤：

a. 从 Signal to Noise Algorithm 列表中选择信噪比算法。

b. 从 Integration Algorithm 列表中选择积分算法，然后设置默认参数进行定量处理。

关于参数描述，请参阅文档：《帮助系统》。

3. 在 Qualitative Processing 页面上，从 Library Search Algorithm 列表中选择库搜索算
法，然后设置定性处理的默认参数。

有关算法的信息，请参阅文档：《帮助系统》。

4. 在 Mass Reconstruction Processing 页面上，从 Integration Algorithm 列表中选择积分
算法，然后设置质量重建的默认积分参数。
关于参数描述，请参阅文档：《帮助系统》。

注释: 仅 MQ4 和求和算法可用。

5. 单击 Save。

6. 单击 Close。

使用工作区布局

使用工作区布局功能在 Analytics 工作区中保存自定义工作区布局。自定义布局与结果文件一
起保存，在打开文件时自动应用。这样可在用户分析结果时为其节省时间。保存的工作区布局
可应用于其他结果文件。它还可设置为项目的默认工作区布局，每当打开该项目中的结果文件
时就会应用。工作区布局可保存在任何位置，包括本地网络上。

用户可以在不同的已保存布局之间更改，以对其结果文件执行不同类型的数据分析。

注释: 所有工作区布局都使用 qlayout 文件扩展名保存。

注释: 任何可直接更改或修改数据的设置都不会保留在工作区布局中。

下表列出了与工作区布局保存在一起的 UI 元素。
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表 6-3 与工作区布局保存在一起的 UI 元素

窗格 保存的 UI 元素

Results Table • Qualify for Rules Filters 复选框。

• 合格的行筛选器。

• 表格排序选择。

• 突出显示的行和列。

• Table display settings。

• 列筛选器。

注释: 当工作区布局应用于不同 Results Table 时，如有可能，会应用
列筛选器设置。如果筛选的列在 Results Table 中不存在，或者如果筛
选选项不适用，则不会应用该设置。

Views 菜单 • Show hidden pane 设置。

• 是否选择了 Tabbed view 选项。

Samples 或
Components
and Groups

• Samples 或 Components and Groups 列表是否打开。

• 是否选择特定样本或成分以显示在 Results Table 中。

• 在 Samples 列表中，Options > Synchronize Sample Selection 的
设置。

• 在 Components and Groups 列表中，All Internal Standards、All
Analytes、All Components 和 Groups (where applicable) 选项的
选择。

• 在 Components and Groups 列表中，Options > Show IS 的设置。

Peak Review • Peak Review 窗格是否打开及其是否已停靠。

• 当前 View。

• 任何选定的 Options，包括 Peak review display settings 选项和 XIC
Graph Title 选项。

Calibration
Curve

• Calibration Curve 窗格是否打开。

• Options 菜单中的 Show excluded standards、Show quality
controls、Show legend、Use percent Y-axis 和 Log-log plot 设
置。
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表 6-3 与工作区布局保存在一起的 UI 元素 (续)

窗格 保存的 UI 元素

Metric Plot • Metric Plot 窗格是否打开。

• Link 菜单设置。

• Regression 对话框设置。

• Options 菜单中的 Display "N/A" as 0.0、Show sample names、
Show legend、Use percent Y-axis、Start Y-axis at 0 和 Connect
with lines 设置。

Statistics Pane • Statistics 窗格是否打开。

• 当前的 Sample grouping 选择。

• 当前的 Metric 选择。

保存当前工作区布局

1. 打开 Analytics 工作区。

2. 打开一个 Results Table。

3. 根据需要自定义工作区布局。

4. 单击 Views > Save current layout。
此时会打开 Save Workspace Layout As 对话框。

5. 键入工作区布局名称，然后单击 Save。

对当前项目应用其他工作区布局

对当前结果文件应用不同的工作区布局可让用户快速地对相同数据执行不同类型的结果分析。

1. 打开 Analytics 工作区。

2. 打开结果文件。

3. 单击 Views > Apply different layout to current results。
Apply a Workspace Layout 对话框打开。

4. 单击 Browse，选择布局，然后单击 Open。
Apply a Workspace Layout 对话框显示所选工作区布局的预览。

5. 单击 OK。

提示! 单击 Views > Recent layouts 并选择布局，以应用最近使用的工作区布局。

将当前工作区布局设置为项目默认值

设置项目默认工作区布局可在多个会话或用户之间保留布局。它还使在该项目内创建的任何新
结果文件打开时都使用项目默认工作区布局。

1. 打开 Analytics 工作区。
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2. 打开结果文件。

3. 自定义工作区布局以适应项目。

4. 单击 Views > Set current layout as project default。
Default Workspace Layout for the Project 对话框打开。

5. 在 Default layout name 字段中键入布局名称，然后单击 OK。

6. 单击 Results > Save。

设置项目 Secure Export Settings
只有被分配管理员角色的用户才能执行该任务。

选中该项后，文本文件中的数据在导出过程中会被加密。设置一个用于加密的密码。

1. 在 Analytics 工作区中，单击 Projects > Project secure export settings。

图 6-22 Secure Export Settings 对话框

2. 选择 Encrypt Results Table when exporting for this project 复选框。

3. 在 Password 字段键入密码。

4. 在 Confirm Password 字段再次键入密码。

5. 单击 OK。

启用项目修改峰警告

该选项默认为未选。如果选中该项，当用户在 Results Table 中对某个色谱图进行改动并保存
改动时，就会出现一条警告，提示用户已作改动。用户可以选择继续保存，或者返回 Results
Table。

在 Analytics 工作区中，单击 Projects > Enable project modified peak warning。

创建处理方法

处理方法包含数据处理的定量和定性设置。无针对性工作流程用于未知成分。
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提示! 要编辑现有的处理方法，请单击 Process Method > Open。

1. 打开 Analytics 工作区。

2. 单击 Process Method > New。

提示! 要编辑当前 Results Table 中的处理方法，单击 Process Method > Edit
embedded method，然后继续执行步骤 3。

3. 在 Workflow 页面上，选择至少一个工作流程以及参考样本。关于此页面上的字段的描
述，请参阅文档：《帮助系统》。

提示! 要使用质量重建工作流，仅选择 Quantitation。

4. 选择 Components 页面，然后执行以下步骤：

a. 若适用，单击 Options > Mass Reconstruction，然后单击确认对话框中的 Yes，选
择质量重建工作流。

b. 完成成分表。关于此表格上的字段的描述，请参阅文档：《帮助系统》。

注释: 仅当积分算法设置为 MQ4 或 Summation 时，质量重建工作流可用。

提示! 如果该组在 Components 表中进行定义，那么用户可选择对组内离子求和，即使相
应离子对的母离子扫描和实验指数不同时也不例外。求和离子未显示在表中，但却显示在
Integration 页面上，并且也作为 group name > Sum 显示在 Results Table 中。该功能有
助于定量分析蛋白质和肽。

提示! 如果成分的保留时间未知，则将质量或化学式的 Retention Time Mode 设置为
Find n peaks，其中 n 为 1、2、5、10 或全部。软件可识别指定数量的面积最大的特征
峰，指定合适的保留时间，然后执行针对性的峰处理工作流。处理完成后，Results Table
的内嵌方法可保存为目标方法。

提示! 如要从文本文件中导入成分和积分参数，可从 Import 菜单中选择适当的指令使用。
如果成分信息不包含浓度单位，则软件使用在 Project Default Settings 对话框中定义的
Concentration units。

注释: 无法从使用 AutoPeak 积分算法的处理方法导入积分参数。

注释: 积分参数可从 Analyst 软件定量方法导入。Analyst 软件参数映射到相应的
SCIEX OS 参数，无法映射的任何参数都使用项目默认值设置。

注释: 积分参数可从不使用 SignalFinder 算法的 MultiQuant 软件定量方法导入。对于
MQ4 方法，S/N Integration Threshold 从 MultiQuant 软件中的默认值 0 变为项目默认
值。MultiQuant 软件的参数映射到 SCIEX OS 的相应参数。

5. 选择 Integration 页面，然后执行这些步骤：

a. 为每种成分选择积分参数。关于此页面上的字段的描述，请参阅文档：《帮助系
统》。
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提示! 要定义自动离群值删除的规则，请单击 Options > Remove Outliers
Automatically。请参阅文档：《帮助系统》。

b. （可选）要查看噪声区域，单击 Options > Show Noise Regions。请参阅以下章
节：使用噪声区域。

注释: 仅当信噪比算法设置为 Standard Deviation 或 Peak to Peak 时显示 Show
Noise Regions。

6. （如果适用）选择 Library Search 页面，然后定义谱库搜索参数。关于此页面上的字段的
描述，请参阅帮助系统。

7. 选择 Calculated Columns 页，然后定义自定义计算列中使用的自定义化学式。关于此页
面上的字段的描述，请参阅帮助系统。

注释: 有关计算列的更多信息，请参阅以下章节：计算列。

8. 选择 Flagging Rules 页，然后选择在 Results Table 中用于标记结果的规则。关于此页面
上的字段的描述，请参阅文档：《帮助系统》。

或者，创建自定义标记规则，或为预定义规则自定义下列值：

• 以下各项的接受度标准：

• 接受度标准和质量对照

• 未知样本的计算浓度范围

• 峰积分

• 质量准确度、保留时间置信度、同位素匹配、谱库分数和化学式查找器分数的红绿灯设
置

• 离子率接受度的红绿灯设置

离子率为峰响应率，即定性离子和定量离子的峰面积或高度。

提示! 如要从文本文件导入标记规则，可单击 Import。

9. 选择 Formula Finder 页面，然后选择化学式查找器设置。关于此页面上的字段的描述，
请参阅文档：《帮助系统》。

10. （如果选择了无针对性工作流程）选择 Non-targeted Peaks 页面，然后定义无针对性搜
索参数。关于此页面上的字段的描述，请参阅文档：《帮助系统》。

11. 单击 Save。

提示! 如果创建了无针对性方法，则当前项目的默认参数用于峰积分，那些参数保存在处
理方法文件中。如果处理方法包含目标分析物，那么目标成分的自定义积分参数将不会影
响无针对性峰积分。如果用户稍后更改了项目默认参数，那么更改后参数将不会影响现有
的无针对性方法，它仍会包含方法创建时的参数。只有新创建的无针对性方法才使用更改
后参数。

操作说明 — 处理

软件用户指南
RUO-IDV-05-7560-ZH-I

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统

103/301



处理数据

1. 打开 Analytics 工作区。

2. 单击 Results > New。

3. 在 Process New Results 对话框中，使用箭头 (  和 ) 选择要处理的样本。

4. 按以下方式之一选择处理方法：

• 单击 Browse，然后选择处理方法并单击 Open。

• 单击 New，然后创建新的处理方法。请参阅以下章节：创建处理方法。

5. （可选）单击 Edit 以编辑处理方法。请参阅以下章节：创建处理方法。

6. 为无针对性工作流程选择对比样本。

7. 单击 Process。

注释: 在无针对性分析中，执行按加合物自动分组。如果保留时间相同的化合物之间存在
的质量差与一种常见加合物相关，则分组算法会为这些化合物分配加合物改性剂。此功能
有助于防止调查具有不同电荷加合物的重复化合物。

如果数据包含的自定义批次列与预定义 Results Table 列或现有化学式同名，将会显示一
条警告消息。单击 OK 继续。这些列名称的开头会添加一个下划线 (_)。

8. 要显示或隐藏样本类型，单击 Sample Type 列上的筛选器图标 ( )，然后选择或清除所
需的复选框。

9. 要设置接受度筛选器，单击任何接受度列上的筛选器图标 ( )，选择 Filter by Flag，然
后选择 Pass 或 Fail。

注释: Acceptance 列包括 Accuracy、Accuracy Acceptance、Asymmetry Factor、
Calculated Concentration、Concentration Acceptance、Integration Acceptance、
Quality Retention Time Delta (min)、Retention Time Error (%) 和 Total Width。

10. 要选择定性置信度筛选器，单击 Confidence 红绿灯，然后选择或清除相应的复选框。

注释: 使用 AutoPeak 算法生成 Results Table 后，如果用户更改了 XIC 宽度和预计 RT，
那么除非用户使用新的 XIC 宽度和预计 RT 值更新该模型，否则数据将使用以前的算法模
型进行重新处理。

11. 要根据 Results Table 列的各个值进行筛选，请单击列标题上的筛选器图标 ( )，然后选
择要显示在 Results Table 中的值的复选框。

提示! 要应用其他自定义筛选器，请选择 Text Filters。

提示! 要在对 Results Table 进行更改（例如，面积计数更改）后重新应用筛选器，单击

Reapply Filter( )。

12. 按以下方式之一选择保存 Results 文件：
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• 单击 Results > Save。

• 要防止对 Results Table 进行更改，请单击 Results > Lock results file and save。

添加样本

前提条件

• 在 Analytics 工作区中，打开 Results Table。

本选项可向当前活动的 Results Table 内添加其他样本。

1. 单击 More > Add samples。

2. 在 Select Samples 对话框中选择所需样本。

• Available 窗格中会显示子文件夹、wiff2 文件以及当前项目的 Data 文件夹项下的可用
样本。

• 展开各个文件夹查看任何子文件夹或 wiff2 文件。如果 wiff2 文件已展开，就会显示可
用样本。

• 使用箭头添加 ( ) 或删除 ( ) 样本。

• 按照以下方式选择样本：

• 双击单个样本。

• 选择一个样本或数据文件，然后单击 。

• 将样本或数据文件从左侧窗格拖动到右侧窗格中。

按 Shift 或 Ctrl 可选择多个文件或样本，然后一起移动。

3. 单击 OK。
将新样本并入并添加到现有表内时，会出现一个进度条。

创建报告

前提条件

• 在 Analytics 工作区中，打开 Results Table。

提示! 如要选择包含在报告中的分析物，可使用 Results Table 中的 Reportable 列。请参阅以
下章节：Results Table 列。

1. 单击 Reporting > Create Report and Save Results Table。
Create Report 对话框随即打开。

2. 从 Template name 列表中选择一个模板。

3. 选择一种报告格式。
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4. 要更改文件名和位置，请单击 Browse，导航至另一个位置，键入 File name，然后单击
Save。

注释: 默认情况下，报告保存在
ProgramData\SCIEX\Analytics\Reporter\Reports 中。

5. 根据需要单击 Create an individual report for each sample 复选框。

6. （可选）为报告选择另一个徽标：

a. 单击 Replace Logo。

b. 使用 Replace Logo 对话框中的选项按需要修改徽标。

c. 单击 Save。

d. 单击 Cancel。

7. 单击 View Pages 可查看报告布局。

8. 单击 Create。

提示! 要使用 Per Sample Quant、Per Sample Qual、Per Sample Visible Rows Using
Visible Analytes 或 Positive Hits Qual 等模板报告所选的结果，使用筛选器或隐藏
Results Table 中不需要的行。

提示! 单击 Create Report 对话框中的 Template View 中的示例可查看报告模板布局。要
查看某个模板，用户必须有一个与模板同名的 jpg 文件，此外还要附加后缀
[Snapshot_X]，其中，X 是序列中的快照编号。不要在文件名和后缀之间使用空格。

例如，All Peaks Qual.docx 模板可命名为 All Peaks Qual[Snapshot_1].jpg、All Peaks
Qual[Snapshot_2].JPG 或 All Peaks Qual[Snapshot_3].jpg

导出并保存 Results Table

前提条件

• 在 Analytics 工作区中，打开 Results Table。

提示! 如要选择要导出的分析物，可使用 Results Table 中的 Reportable 列。请参阅以下章
节：Results Table 列。

1. 单击 Reporting > Export results > Export and save Results Table。

此时 Export 对话框打开。

2. 按需要选择选项。

关于选项描述，请参阅文档：《帮助系统》。

3. 单击 OK。
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导出 Results Table – Metric

前提条件

• 在 Analytics 工作区中，打开 Results Table。

注释: 在数据从 Analytics 工作区导出之后，制造商不承担包括间接或从属损害在内的责任或偶
然责任。

导出结果表是在 Analytics 工作区输出数据的受控方法之一。

本特性用于创建一份制表符分隔的文本文件，其中包含了处于活动状态的 Results Table 中的
信息。导出所有样本的信息，并导出选定度量或字段中的所有成分或仅可见成分。

1. 单击 Reporting > Export results > Results Table - Metric。

此时 Export Metric 对话框打开。

2. 选择 Metric 字段中要导出的列，然后设置选项。请参阅文档：《帮助系统》。

3. 单击 OK。

将结果传输到 Watson LIMS 中

前提条件

• Results Table 已打开并锁定。

• Watson LIMS 软件已打开。

注释: 已传输 Results Table 中列的子集，包括一些隐藏列和未指定为 Reportable 的一些列。

1. 单击 Reporting > Initiate Transfer to Watson LIMS。
传输对话框随即打开。

2. 在 Watson LIMS 中，导入数据。

3. 在 SCIEX OS 的传输对话框中，执行以下操作之一：

• 如传输成功完成，则单击 Confirm。

• 如传输未成功完成，则单击 Decline。

将结果传输到另一个 LIMS 中

必要程序

• 在 Configuration 工作区中配置 LIMS。请参阅以下章节：选择实验室信息管理系统
(LIMS) 设置。

• 打开一个锁定的 Results Table。
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提示! 如要选择要导出的分析物，可使用 Results Table 中的 Reportable 列。请参阅以下章
节：Results Table 列。

1. 单击 Reporting > Transfer Results to LIMS。
LIMS Transfer 对话框随即打开。

2. 从 Template 列表中选择一个模板。

3. 单击 Transfer。

使用 Results Table
Results Table 总结每个未知样本中的分析物基于校正曲线的计算所得浓度和定性分析结果，
如：谱库匹配、Formula Finder 结果等等。Results Table 还包括校正曲线及统计结果。用户
可以自定义 Results Table，以及以不同布局查看 Results Table。

注释: 带星号 (*) 的 Results Table 列为自定义文本或计算列。

Results Table 中的数据可以按 txt 文件形式导出，以用于其他应用程序，如 Microsoft Excel。
用户也可以导出 Results Table 中的所有数据，或只是可见列中的数据。

提示! 如果 Results Table 的多个会话已垂直或水平平铺，则单击 Views > Reset layout 以将
Results Table 恢复至其原始布局。

使用右键菜单编辑 Results Table 行。要显示此菜单，在 Results Table 的任意位置单击鼠标右
键。

图 6-23 右键菜单

表 6-4 右键菜单命令

标签 描述

Copy （复制）使用本选项将当前数据复制到剪切板。

Paste （粘贴）使用本选项将剪切板中的数据粘贴到当前视图。

Copy Entire Table （复制整个表）使用本选项将整个表复制到剪切板。

Fill Down （往下填入）（成分）使用本选项将选中的第一行的信息复制到
后面的所有的选定行中。

Select All Rows （选中所有行）通过该选项在当前活动的 Results Table 中选中
所有行。如果用户接下来想对选中的行应用某个命令，如
Copy，该命令较为适用。
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表 6-4 右键菜单命令 (续)

标签 描述

Apply Current Analyte's
Actual Concentrations
to All

（将当前分析物的实际浓度应用至全部）（分析物）如果分析物
不止一种，而且这些样本中所有分析物的浓度均相同，则通过该
选项可为所有标准物样本的分析物提供一个设置实际浓度字段的
快捷方式。要使用本功能：

1. 使用 Components and Groups List 只显示表中的一个特
定分析物。请参阅以下章节：Components and Groups 列
表。

2. （可选）筛选 Sample Type 列，以只查看标准物样本。

3. 指定分析物的实际浓度，可以在单元格中键入，也可以选择
列，然后粘贴文本。

4. 选择 Apply Current Analyte's Actual Concentrations to
All。

必要时，可返回查看所有成分和样本类型。

Apply Current IS's
Actual Concentrations
to All

（将当前 IS 的实际浓度应用至全部）（内标物）如果内标物不
止一种，而且这些样本中所有内标物的浓度均相同，则通过该选
项可为所有标准物样本的内标物提供一个设置实际浓度字段的快
捷方式。要使用本功能：

1. 使用 Components and Groups List 只显示表中的一个特
定内部标准物。请参阅以下章节：Components and Groups
列表。

2. （可选）筛选 Sample Type 列，以只查看标准物样本。

3. 指定内标物的实际浓度，可以在单元格中键入，也可以选择
列，然后粘贴文本。

4. 选择 Apply Current IS's Actual Concentrations to All。

必要时，可返回查看所有成分和样本类型。

Results Table 过滤器

使用 Results Table 顶部的字段查看和筛选内容。

图 6-24 筛选控件
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表 6-5 Results Table 过滤器

标签 描述

x of y rows （y 行中的 x 行）显示总行数 (y) 中可见的行数 (x)。

Filters （筛选器）显示应用了筛选器的列数。

Qualify for
Rules Filters

（符合规则筛选器条件）在符合该等接受度标准筛选器或置信度红绿灯筛
选器的行与不符合这些筛选器的行之间切换 Results Table 的视图。接受
度标准和置信度红绿灯适用于处理方法。

Reapply Filter （重新应用筛选器）在对 Results Table 进行更改（例如，面积计数更
改）后重新应用筛选器。

注释: 当添加或更改另一项筛选器时，所有筛选器自动重新应用。

Clear （清除）清除所有筛选器。

Results Table 列

注释:

• 带星号 (*) 的列为自定义文本列、计算列或作为组合标记规则结果创建的列。

• 名称以下划线 (_) 开头的列是与预定义 Results Table 列或化学式同名的自定义批次列。

• Format 列指示如何在化学式中验证字段。

• 在包含数字的列中，用户可以更改数字格式和有效位数。在 Number Format 列中选择
Decimal、Significant Digits 或 Scientific Notation，然后在 Results Table Display
Settings 对话框中键入 Number Format Precision 列中的有效位数。

标签 描述 格式 是否支持 LIS

Accuracy （准确度）显示标准物和质量对照 (QC)
样本的准确度。对于其他样本类型，该值
会被设定为 N/A。

对于已知浓度的标准物，标准物和 QC 样
本的准确度会被定义为 100% ×
(Calculated Concentration)/(Actual
Concentration)。

数值 是

Accuracy
Acceptance

（准确度接受度）显示准确度的可接受状
态。

文本 否

Acq. Method
Name

（采集方法名称）显示采集样本所用采集
方法的名称。

文本 是

Acquisition Date
& Time

（采集日期和时间）显示采集样本的日期
和时间。

文本 是
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标签 描述 格式 是否支持 LIS

Actual
Concentration

（实际浓度）对于标准物和 QC 样本，显
示预计的已知浓度。

数值 是

Adduct/ Charge （加成/电荷）显示化合物的加成物或电
荷状态。在针对性工作流中，该值由用户
设置。在非针对性工作流中，如果启用了
按加成物分组，则由软件自动设置该值。

文本 否

Area （面积）显示检测到的峰面积。如果未检
测到峰，则该值会被设定为 N/A（不适
用）。

数值 是

Area / Height （面积/高度）显示用检测到的峰面积除
以高度所得的数值。如果未检测到峰，则
该值会被设定为 N/A（不适用）。

数值 否

Area Ratio （面积比）对于使用内标物的分析物，显
示分析物 Area 与 IS Area 的比。对于内
标物或没有内标物的分析物，该值会被设
定为 N/A（不适用）。

数值 是

Area Ratio of
comparison

（对比的面积比）显示样本/对照样本的
面积比。

• 如果未在对照品中发现峰，则该值为
N/A（不适用）。

• 如果未在样本中发现峰，则该值为 0。

• 如果样本中的每个峰都低于 Area
Ratio Threshold，则该值为 N/A（不
适用）。

• 如果没有使用对比样本，则该值为 No
control sample（无对照样本）。

• 对于对照样本来说，找到的峰的面积
比始终为 1。

仅适用于定性工作流程。

数值 否

Asymmetry
Factor

（不对称因子）显示从峰的中心线到背坡
的距离除以从中心线到前坡的距离，所有
测量结果均在最大峰高的 10% 处测得。

数值 是

AutoPeak
Asymmetry

（AutoPeak 不对称）显示积分峰相对于
根据模型预计的对称性的不对称率。比率
为 1 表示拟合良好。如果该值不为 1，则
离子源可能已饱和或积分可能不正确。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否
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标签 描述 格式 是否支持 LIS

AutoPeak
Candidate
Model Quality

（AutoPeak 候选模型质量）显示峰是否
适用于创建峰模型。如果该值明显大于
1，则用于创建定量方法的样本不适合。
使用较大响应峰值创建模型，然后将该峰
值用于所有样本。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否

AutoPeak Group
Confidence

（AutoPeak 分组置信度）显示一组实际
峰已经过积分计算且积分不包括假阳性噪
声峰的概率。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否

AutoPeak
Integration
Quality

（AutoPeak 积分质量）显示数据质量。
质量表示为 0 到 1 之间的一个数值。如果
质量低于 0.6，则进一步调查积分。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否

AutoPeak Model
Source

（AutoPeak 模型源）显示用于创建峰模
型的样本和成分的名称。如果用于创建模
型的成分与进行积分计算的成分不同，则
请检查该模型以确定其是否合适。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否

AutoPeak Num
Peaks

（AutoPeak 峰的数量）显示算法所检测
到的邻近重叠峰的数量。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否

AutoPeak Peak
Width
Confidence

（AutoPeak 峰宽置信度）显示峰宽的置
信度。值为 1 表示实际峰宽与预计峰宽相
等。值大于 1 表示实际峰宽大于预计峰
宽。值小于 1 表示实际峰宽小于预计峰
宽，或者由于色谱图条件更改峰变得更
宽。

仅适用于使用 AutoPeak 积分算法的处理
方法。

数值 否
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标签 描述 格式 是否支持 LIS

AutoPeak
Saturated acc

（AutoPeak 已饱和）如果使用了
Saturation correction 选项且对应的峰
已饱和，从而使拟合模型高于峰，该字段
中就显示 Yes（是）。否则，该列为空
白。如果浓度更高的样本的准确度和
%CV 超出可接受范围，则应当调整
Saturation correction。

仅适用于使用 AutoPeak 积分算法的处理
方法。

文本 否

Barcode （条形码）显示样本的唯一 ID。该唯一
ID 的初始值使用采集数据所用批次指定
的原始值。

Barcode 最多可以包含 20 个字符。
Barcode 不能包含任何这些无效字符：
\ / : * ? " < > |= 或 ASCII 表中的 0 至 31
号字符。

文本 是

Baseline Delta/
Height

（基线差值/高度）显示基线高度（在峰
的起点和终点处）与实际峰高高度差的绝
对值。该值大于 0.1 表示基线积分可能不
正确，并且应当对该峰重新检查。

数值 否

Calculated
Concentration

（计算所得浓度）对于浓度已知的标准
物，显示根据校准曲线反向计算出的浓度
值。回归等式所描述的是各种回归类型和
加权的回归计算是怎样进行的。

数值 是

Combined Score （综合评分）（可选）显示可用于相对比
较的单一评分。

仅适用于定性工作流程。

数值 否

Comparison （对比）显示对比样本的成分。 数值 否

Component
Comment

（成分评注）显示有关分析物或内标物的
任意评注，可应用于所有样本。

文本 否

Component
Group Name

（成分组名称）显示与分析物或内标物相
关的任何组名称。

文本 否

Component
Index

（成分索引）显示分析物或内标物在原处
理方法中的索引。

数值 是
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标签 描述 格式 是否支持 LIS

Component
Name

（成分名称）显示分析物或内标物的名
称。

此列在 Results Table 中始终可见。在
Column Settings 对话框中，该复选框不
可用。

Component Name 最多可以包含 50 个
字符。

注释:

• Component Name 只能在处理方法中
更改，在 Result Table 中不可更改。

• 该列在实验室信息管理系统 (LIMS) 传
输中是必需的。

文本 是

Component
Type

（成分类型）显示分析物类型：
Quantifier、Qualifier 或 Internal
Standard。

文本 否

Conc. Units （浓度单位）显示浓度单位。 文本 是

Concentration
Acceptance

（浓度接受度）显示计算所得浓度的可接
受状态。

数值 否

Concentration
Ratio

（浓度比）对于使用内标物的分析物，显
示 Actual Concentration 与 IS Actual
Concentration 的比。对于内标物或没有
内标物的分析物，该值会被设定为 N/A
（不适用）。

数值 否

Difference from
Average Sample
Time

（与平均样本时间之差）显示此样本的分
析时间与所有样本的平均分析时间的差
异。

数值 否

Dilution Factor （稀释系数）显示样本被稀释的系数。该
系数用于计算校准曲线。

数值 是

End Time （结束时间）显示所检测到色谱峰的结束
保留时间，单位为分钟。

数值 是

End Time at 10% （10% 处的结束时间）显示沿色谱峰背
侧的时间（单位为分钟），强度在峰高的
10% 处。

数值 否

End Time at 5% （5% 处的结束时间）显示沿色谱峰背侧
的时间（单位为分钟），强度在峰高的
5% 处。

数值 否
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标签 描述 格式 是否支持 LIS

Expected Ion
Ratio

（预计离子率）显示未知、QC 和标准物
样本的预计离子率。

对于组中的每种成分，Expected Ion
Ratio 是其标准物离子率的平均值。如果
符合下列条件，标准物不会包含在成分
Expected Ion Ratio 的计算中：

1. 峰面积为 N/A。

2. 未选择 Use 列。

数值 是

Expected RT （预计 RT）显示处理方法中原来的预计
保留时间，单位为分钟。

数值 是

Expected MW （预计分子量）显示处理方法中原来的预
计分子量，单位为 Da。

仅适用于质量重建工作流。

数值 是

Formula （化学式）（可选）显示一个有效的化学
式。如果该化学式无效，则软件不会对其
保留。如果该化学式有效，Mass (Da) 列
和 Isotope 列会自动填充。

文本 是

Formula
Confidence

（化学式置信度）以百分比显示 Formula
Finder Score 的置信度。其计算依据
是：

• 当前 MS 谱图与化合物的理论谱图的
拟合程度（基于质量）。

• 采集的 MS/MS 谱图与在 LibraryView
软件数据库中找到的 MS/MS 谱图的拟
合程度。

MS 谱图分数的权重是 MS/MS 谱图分数
的两倍。

仅适用于定性工作流程。

文本 否

Formula Finder （化学式查找器）显示可用于相对比较的
单一评分。该值可使用源自 Peak Review
菜单中的 Formula Finder Results Table
内的数据进行更新。

仅适用于定性工作流程。

数值 否
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标签 描述 格式 是否支持 LIS

Formula Finder
Results

（化学式查找器结果）（可选）显示化学
式查找器结果的最佳匹配。

仅适用于定性工作流程。

文本 否

Formula Finder
Score

（化学式查找器评分）（可选）显示可用
于相对比较的单一评分。

数值 是

Found at
Fragment

（在碎片处发现）（可选）显示在发现匹
配质谱处的最佳请求碎片质量 (Da)。

仅适用于定性工作流程。

数值 是

Found at Mass （在质量处发现）（可选）显示在发现匹
配质谱处的最佳请求提取质量 (Da)。

仅适用于定性工作流程。

数值 是

Fragment Mass （碎片质量）（可选）显示方法中所规定
的碎片质量。碎片的母离子从 Extraction
Mass (Da) 列的 MS/MS 中提取而得。如
果提供，则该值必须为数字。

数值 是

Fragment Mass
Error (ppm)

（碎片质量误差 (ppm)）（可选）显示在
碎片和碎片质量处发现的差别，单位为
ppm。

数值 是

Fragment Mass
Error (mDa)

（碎片质量误差 (mDa)）（可选）显示在
碎片和碎片质量处发现的差别，单位为
mDa。

数值 是

Fragment Mass
Error
Confidence

（碎片质量误差置信度）（可选）显示碎
片质量误差的置信度。

文本 是

Height （峰高）显示检测到的峰高。如果未检测
到峰，则该值会被设定为 N/A（不适
用）。

数值 是

Height Ratio （峰高比）对于使用内标物的分析物，显
示 Height 与 IS Height 的比。对于内标
物或没有内标物的分析物，该值会被设定
为 N/A（不适用）。

数值 是

Index （索引）显示原始未排序行的索引。如果
根据另一列对表进行排列，则可以通过在
该列上排列返回原有的顺序。

数值 否

Injection Volume （注射体积）显示在方法中储存并通过自
动进样器注射的样本量。

数值 是
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Integration
Acceptance

（积分接受度）显示峰积分对接受度标准
的符合程度。它是根据标记规则中配置的
以下因素计算得到：

• 积分质量

• 不对称因子

• 总峰宽，单位为分钟

• 保留时间误差，以百分比或分钟计量

数值 否

Integration Type （积分类型）显示积分的类型。

• Baseline：通常只对一个独立峰进行
积分。

• Valley：表示有两个相邻的峰，且该信
号不会回到两峰之间的基线值。

• N/A（不适用）：表示未检测到峰。

• Manual：表示该峰通过手动方式积
分。

文本 是
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Ion Ratio （离子率）显示离子率。Ion Ratios 是在
一种分析物至少有两个 MRM 离子对被采
集到一组的情况下确定的。

组内的所有分析物构成一个分析物子组。
组内的所有内标物构成一个 IS 子组。子
组中的第一个成分被用作定量离子。子组
中的其他成分被用作定性离子。

离子率 =（定性离子的峰面积或高度）/
（定量离子的峰面积或高度）

无论是峰面积还是峰高都可以计算离子
率。如果处理方法使用了面积计算
Results Table 内第一个成分（即成分索
引为 1 的成分）的回归部分，那么峰面积
会用来计算整个 Results Table 的离子
率。如果在第一个成分的回归计算中使用
了峰高，那么峰高会用于此项计算。

• 如果某成分不在组内，则 Ion Ratio 值
会被设定为 N/A（不适用）。

• 如果未发现峰，则 Ion Ratio 值会被设
定为 N/A（不适用）。

• 如果离子率在分析物和 IS 子组应用于
所有成分，定性离子会作为定量离子
使用。

• 如果定量离子或定性离子的峰积分有
变动，需再次计算离子率。

注释: 用户可以定义处理方法中离子率的
标记规则。

数值 是

Ion Ratio
Acceptance

（离子率接受度）显示离子率的可接受状
态。

数值 否

Ion Ratio
Confidence

（离子率置信度）显示离子率的置信度。

仅适用于定性工作流程。

文本 否
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IS （内标物）显示此行是否代表一种内标
物。复选框被勾选表示该行的成分是内标
物而非分析物。

注释: 对于名称包含 .heavy 或 -cis 的样
本，自动选中 IS 复选框，因为这些样本
定义为蛋白质组学工作流中的内标。对于
其他工作流，它们不是内标，因此应清除
IS 复选框。

数值 否

IS Actual
Concentration

（IS 实际浓度）显示与当前分析物有关的
内标物的实际浓度。对于内标物或没有内
标物的分析物，该值会被设定为 N/A（不
适用）。

数值 否

IS Area （IS 面积）显示与当前分析物有关的内标
物的面积。对于内标物或没有内标物的分
析物，该值会被设定为 N/A（不适用）。

数值 否

IS Area / Height （IS 面积/高度）显示与当前分析物有关
的内标物 IS Area 与 IS Height 之比。对
于内标物或没有内标物的分析物，该值会
被设定为 N/A（不适用）。

数值 否

IS Baseline
Delta / Height

（IS 基线差值/高度）显示内标物基线高
度（在峰的起点和终点处）与实际峰高高
度差的绝对值。该值大于 0.1 表示基线积
分可能不正确，并且应当对该峰重新检
查。

数值 否

IS Comment （IS 评注）显示与当前分析物有关的内标
物的任意评注。对于内标物或没有内标物
的分析物，该值会被设定为 N/A（不适
用）。

文本 否

IS End Time （IS 结束时间）显示与当前分析物有关的
内标物采集结束时间。对于内标物或没有
内标物的分析物，该值会被设定为 N/A
（不适用）。

数值 否

IS Expected MW （IS 预计分子量）显示与当前分析物有关
的内标物的预计分子量，单位为 Da。对
于内标物或没有内标物的分析物，该值会
被设定为 N/A（不适用）。

仅适用于质量重建工作流。

数值 是
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IS Expected RT （IS 预计保留时间）显示与当前分析物有
关的内标物的预计保留时间。对于内标物
或没有内标物的分析物，该值会被设定为
N/A（不适用）。

数值 否

IS Height （IS 高度）显示与当前分析物有关的内标
物高度。对于内标物或没有内标物的分析
物，该值会被设定为 N/A（不适用）。

数值 否

IS Integration
Type

（IS 积分类型）显示与当前分析物有关的
内标物的积分类型。对于内标物或没有内
标物的分析物，该值会被设定为 N/A（不
适用）。

文本 否

IS Mass Info （IS 质量信息）显示与当前分析物有关的
内标物的质量信息。对于内标物或没有内
标物的分析物，该值会被设定为 N/A（不
适用）。

文本 否

IS MW （IS 分子量）显示发现的与当前分析物有
关的内标物分子量，单位为 Da。对于内
标物或没有内标物的分析物，该值会被设
定为 N/A（不适用）。

仅适用于质量重建工作流。

数值 否

IS MW Delta (Da) (IS MW Delta (Da)) 显示内标物预计和发
现分子量之差，单位为 Da。

仅适用于质量重建工作流。

数值 是

IS MW Delta
(ppm)

(IS MW Delta (ppm)) 显示内标物预计和
发现分子量之差，单位为 ppm。

仅适用于质量重建工作流。

数值 是

IS Name （IS 名称）显示与当前分析物有关的内标
物名称。对于内标物或没有内标物的分析
物，该值会被设定为 N/A（不适用）。

文本 否

IS Peak
Comment

（IS 峰评注）显示与当前分析物有关的内
标物的峰评注。对于内标物或没有内标物
的分析物，该值会被设定为 N/A（不适
用）。

文本 否

IS Quality （IS 质量）显示与当前分析物有关的内标
物质量。对于内标物或没有内标物的分析
物，该值会被设定为 N/A（不适用）。

数值 否
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IS Region
Height

（IS 区域高度）显示内标物区域的高度。
对于内标物或没有内标物的分析物，该值
会被设定为 N/A（不适用）。

数值 否

IS Retention
Time

（IS 保留时间）显示与当前分析物有关的
内标物的保留时间。对于内标物或没有内
标物的分析物，该值会被设定为 N/A（不
适用）。

数值 否

IS Signal / Noise （IS 信噪比）显示与当前分析物有关的内
标物的信噪比。对于内标物或没有内标物
的分析物，该值会被设定为 N/A（不适
用）。

数值 否

IS Start Time （IS 开始时间）显示与当前分析物有关的
内标物的开始时间。对于内标物或没有内
标物的分析物，该值会被设定为 N/A（不
适用）。

数值 否

IS Total Width （IS 总计宽度）显示与当前分析物有关的
内标物的总计宽度。对于内标物或没有内
标物的分析物，该值会被设定为 N/A（不
适用）。

数值 否

IS Width at 50% （50% 处的 IS 宽度）显示与当前分析物
有关的内标物的 50% 处宽度。对于内标
物或没有内标物的分析物，该值会被设定
为 N/A（不适用）。

数值 否

Isotope
Confidence

（同位素置信度）显示同位素比的置信
度。

仅适用于定性工作流程。

文本 否

Isotope Ratio
Difference

（同位素比）识别理论同位素模式（基于
化学式）与根据所采集质谱所确定同位素
模式之间的差异。

仅适用于定性工作流程。

数值 否

LC Method （LC 方法）显示采集数据所用液相色谱
方法的名称。

文本 否

Library
Confidence

（谱库置信度）基于匹配的 Library
Score 显示 Library Hit 的置信度。

仅适用于定性工作流程。

文本 否
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Library Hit （谱库匹配）显示最佳谱库匹配的化合物
名称，即化合物的纯度评分最高并且其化
学式与所需化学式匹配。

该值可使用源自峰检查菜单中的谱库搜索
Results Table 格内的数据进行更新。仅
适用于定性工作流程。

文本 否

Library Score （谱库评分）显示谱库匹配与所发现质量
之间的拟合程度。

仅适用于定性工作流程。

数值 否

Mass Error
(ppm)

（质量误差 (ppm)）显示所发现质量与提
取质量之间的差值，以百万分率表示。

仅适用于定性工作流程。

数值 否

Mass Error
(mDa)

（质量误差 (mDa)）显示所发现质量与提
取质量之间的差值，以毫道尔顿表示。

仅适用于定性工作流程。

数值 否

Mass Error
Confidence

（质量误差置信度）显示质量误差的置信
度。

仅适用于定性工作流程。

文本 否

Mass Info （质量信息）显示与成分有关的质量信
息。

• 对于 MRM 实验来说就是 Q1/Q3 比，
对于轮廓（全扫描）实验来说就是开
始－停止。

• 对于 UV、ADC 或 DAD 实验，这是指
波长 (DAD) 或通道信息 (UV/ADC)。

如果存在碎片质量，则会将其用于 XIC 提
取。

如果没有碎片质量，则母离子质量应该用
于 XIC 提取。

文本 是

Modified （已修改）显示找峰参数是否已修改。复
选框已选中表示处理方法中的找峰参数已
使用 Peak Review 窗格进行过修改。

数值 是

MS Method （MS 方法）显示采集数据所用质谱方法
的名称。

文本 否
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MW (MW) 显示重建图形中发现的分析物分子
量，单位为 Da。

仅适用于质量重建工作流。

数值 是

MW Delta (Da) (MW Delta (Da)) 显示预计和发现分子量
之差，单位为 Da。

仅适用于质量重建工作流。

数值 是

MW Delta (ppm) (MW Delta (ppm)) 显示预计和发现分子量
之差，单位为 ppm。

仅适用于质量重建工作流。

数值 是

Non-Targeted
Peak

（无针对性峰）该复选标记表示此峰是否
通过增强型峰查找器找到的。

仅适用于定性工作流程。

数值 否

Operator Name （操作人员姓名）显示负责采集样本的仪
器操作人员的姓名。

文本 是

Original
Filename

（原始文件名）显示文件的名称。 文本 是

Outlier Reasons （离群值原因）在定量方法中启用自动删
除离群值后，显示发现哪个标准超出了成
分的预确定限制。

Outlier Reasons 列与定量方法中的离群
值自动删除规则关联。这是 Results
Table 中的一个预设列。

离群值被标注的原因：

• 准确度

• 浓度

• 离子率

如果定量离子或定性离子中只有一个
有峰，则将为这两个成分标记离子
率。如果这些成分都没有峰，则不为
任何一个成分标记离子率。

• 无法计算预计离子率

• 用户创建的自定义标记规则失败

文本 否

Peak Comment （峰评注）显示对该行的任意评注。 文本 否
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软件用户指南
RUO-IDV-05-7560-ZH-I

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统

123/301
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Plate Number （孔板编号）显示用来采集数据的自动进
样器孔板号，如 Batch Editor 所示。

文本 是

Points Across
Baseline

（基线上的点数）显示色谱峰扫描次数。 数值 否

Points Across
Half Height

（一半峰高处的点数）显示约 50% 峰高
处的色谱峰扫描次数。

数值 否

Polarity （极性）显示用来采集样本的实验极性。 文本 否

Precursor Mass （母离子质量）显示从处理方法中获得的
处理输入参数。

此列在 Results Table 中始终可见。在
Column Settings 对话框中，该复选框不
可用。

数值 否

Proc. Method
Name

（处理方法名称）显示创建 Results
Table 的处理方法的名称。

文本 是

Quality （质量）显示积分峰的质量。将比较积分
峰的面积与更大 RT 窗口的面积。值为 0
表示峰的积分欠佳或不存在峰。值为 1.0
表示不需要检查的积分良好的峰。

数值 否

Rack Number （支架编号）显示用来采集数据的自动进
样器支架号，可在 Batch Editor 中指定。

文本 是

Region Height （区域高度）显示检测到的峰附近的最大
峰的高度。它与 Quality 字段结合使用效
果较好。质量较低而 Region Height 较
合理的峰必须经过检查。如果 Region
Height 很小，则不存在明显峰。

数值 否

Relative RT （相对 RT）对于使用内标物的分析物，
显示 Retention Time 与 IS Retention
Time 的比。对于内标物或没有内标物的
分析物，该值会被设定为 N/A（不适
用）。

数值 是

Reportable （可报告）显示结果是否包含在报告、输
出和 LIMS 传输中。

数值 是

Retention Time （保留时间）显示所检测到色谱峰的实际
保留时间，单位为分钟。

数值 是

Retention Time
Delta (min)

（保留时间差值）表示为质量定义的保留
时间与实际保留时间之间的差值。

数值 否
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Retention Time
Error (%)

（保留时间误差 (%)）显示“在 RT 发现”
与“预计 RT”之间存在的误差百分比。

仅适用于定性工作流程。

数值 否

RT Confidence （RT 置信度）显示保留时间的置信度。

仅适用于定性工作流程。

文本 否

Sample
Comment

（样本评注）显示样本的用户指定评注。 文本 是

Sample ID （样本 ID）显示样本的用户指定标识。
提交样本供采集之前，Sample ID 在
Batch Editor 中指定。

如果在处理方法中启用了标准物添加工作
流，则 Sample ID 将作为组标识符用于
每个标准物添加组。SCIEX OS 将分析物
浓度未知的每一份样本链接到已添加相同
分析物且所添加分析物浓度已知且不同的
多个样本。

Sample ID 最多可以包含 252 个字符。
Sample ID 不能包含任何这些无效字符：
\ / : * ? " < > |= 或 ASCII 表中的 0 至 31
号字符。

文本 是

Sample Index （样本索引）显示当前样本的索引。

注释: 此列锁定，始终在 Results Table 左
侧显示。

数值 是

Sample Name （样本名称）显示样本的用户指定名称。
提交样本供采集之前，Sample Name 在
Batch Editor 中指定。

Sample Name 必须包含 1 到 252 个字
符。Sample Name 不能包含任何这些无
效字符：\ / : * ? " < > |= 或 ASCII 表中的
0 至 31 号字符。

注释: 此列锁定，始终在 Results Table 左
侧显示。

文本 是

Sample Type （样本类型）显示样本的类型。 文本 是

Scanned
Barcode

（扫描的条形码）显示注射之前扫描的条
形码。

文本 是
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标签 描述 格式 是否支持 LIS

Signal / Noise （信噪比）显示检测到的峰的高度与色谱
图中的噪声之比的估计值。

对于 AutoPeak 积分算法，用计算所得的
相对噪声和峰顶位置的基线来估算噪声。
MQ4 积分算法与之相似，但基线是用整
个色谱图来估算的。

数值 是

Slope of
Baseline

（基线的斜率）显示来自基线的积分峰的
斜率：

（（峰停止时的强度）–（峰开始时的强
度））÷ 峰宽

数值 否

Start Time （开始时间）显示所检测到色谱峰的开始
保留时间，单位为分钟。

数值 是

Start Time at
10%

（10% 处的开始时间）显示沿色谱峰前
侧的时间（单位为分钟），强度在峰高的
10% 处。

数值 否

Start Time at 5% （5% 处的开始时间）显示沿色谱峰前侧
的时间（单位为分钟），强度在峰高的
5% 处。

数值 否

Std Addition
Accuracy

（标准物添加准确度）显示通过添加不同
浓度的标准物而进行定量分析的已知浓度
样本的精度。当在处理方法中启用了标准
物添加工作流时，所有样本的 Sample
Type 会自动设置为 Standard。如果
Sample Type 更改为另一种类型，或者
标准物添加工作流未启用，则此值将设定
为 N/A（不适用）。对于已知浓度的样
本，例如一个批次中的质量对照样本，
Std Addition Accuracy 定义为：

100% x（标准物添加计算所得浓度）/
（标准物添加实际浓度）。

数值 否

Std Addition
Actual
Concentration

（标准物添加实际浓度）显示通过标准物
添加定量分析的样本的用户指定预计已知
浓度。例如，一个批次中的质量对照样
本。如果 Sample Type 不是 Standard，
则此值将设定为 N/A（不适用）。

数值 否
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标签 描述 格式 是否支持 LIS

Std Addition
Calculated
Concentration

（标准物添加计算所得浓度）显示通过采
用线性回归和无加权将标准物添加曲线外
推为 X 截距的反向计算出的浓度值。对于
通过标准物添加定量分析的样本，Std
Addition Calculated Concentration 定
义为：

截距/斜率

如果 Sample Type 不是 Standard，如果
未在处理方法中启用标准物添加工作流，
或者如果在标准物添加组的未加标样本中
没有发现峰，则该值将设定为 N/A（不适
用）。

数值 否

Tailing Factor （拖尾因子）显示从峰的前坡到背坡的距
离除以从峰的中心线到前坡距离的两倍。
所有测量结果均在最大峰高的 5% 处测
得。

数值 否

Time Since First
Sample (min)

（从第一个样本起的时间（分））显示从
开始第一个样本的采集后经过的时间，单
位为分钟。

数值 否

Time Since Last
Sample (sec)

（从最后一个样本起的时间（秒））显示
从开始最后一个样本的采集后经过的时
间，单位为秒。

数值 否

Total Width （总峰宽）显示色谱峰在基线处的宽度，
单位为分钟。

数值 是

Used （已使用）显示结果是否已使用。

• 对于所有样本，复选框选中表示该结
果用于计算参考值和执行标记规则。

• 对于标准物样本而言，复选框选中表
示结果用于绘制校准曲线、回归和统
计结果。

• 对于 QC 样本而言，复选框选中表示
该结果用于质控统计计算。

• 对于其它样本类型，复选框选中表示
结果用于计算。

数值 是

Vial Number （进样瓶编号）显示采集数据所用自动进
样器的进样瓶号，与该批次最初指定的编
号相同。

文本 是

Width at 10% （10% 峰高处的峰宽）显示在 10% 峰高
处测得的峰宽度。

数值 否
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标签 描述 格式 是否支持 LIS

Width at 5% （5% 峰高处的峰宽）显示在 5% 峰高处
测得的峰宽度。

数值 否

Width at 50% （50% 时的峰宽）显示在最大强度一半
处测得的色谱峰的宽度，单位为分钟。

数值 是

XIC Width (Da) （XIC 宽度 (Da)）显示提取的离子色谱图
宽度，单位为道尔顿。

数值 是

XIC Width (ppm) （XIC 宽度 (ppm)）显示提取的离子色谱
图宽度，单位为 ppm（百万分率）。

数值 是

接受度筛选器

采用 Results Table 列 Filter 菜单中的 Filter by Flag 选项，选择是否依据接受度标准筛选列。
可按接受度标准筛选 Results Table，如下所示：

• Pass:显示符合处理方法所定义标准的行。

• Fail:显示不符合处理方法所定义标准的行。

图 6-25 Filter By Flag

应用了标记规则的任何列都可以选择使用接受度过滤器以及下列接受度标准：

• Accuracy

• Accuracy Acceptance

• Asymmetry Factor

• Calculated Concentration

• Concentration Acceptance

• Integration Acceptance

• Quality

• Retention Time Delta（min）

• Retention Time Error（%）

• Total Width
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置信度红绿灯

用接受度标准来定义合格的行。合格的行是指其接受度标准符合处理方法中所定义的标准的
行。

图 6-26 合格的行

置信度红绿灯显示 Qualitative Rule 或 Ion Ratio Acceptance 规则应用于各行的置信度状态。
有关标记规则的信息，请参阅文档：《帮助系统》。

提示! Result Table 可用置信度红绿灯过滤器进行过滤。选择 Qualify for Rules Filters 复选
框，在符合置信度筛选器的行与不符合置信度筛选器的行之间切换 Results Table 视图。置信
度筛选器包括：Pass、Marginal、Fail 和 N/A。

表 6-6 置信度红绿灯

红绿灯图标 描述

显示哪些成分达到了处理方法所定义的置信度水平。

显示哪些成分达到了处理方法所定义的边缘百分比差值水平。

显示哪些成分达到了处理方法所定义的不合格百分比差值水平。

显示哪些置信度参数不适用于该成分。

Components and Groups 列表

当 Results Table 打开时，主窗口的左侧就会出现一个当前成分和分组的列表。用该列表可以
更改结果中显示哪些成分，以及任何关联的 Peak Review 或 Calibration Curve 窗格中显示哪
些成分。全部信息均按处理方法中的定义显示。
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图 6-27 Components and Groups

单击列表中的各项以仅显示该项的成分。使用 Shift+click 或 Ctrl+click 来选择多项，如两种
特定的分析物。

提示! 将窗格右侧边缘左右拖动可以更改列表宽度。

Results Table 中各行的顺序不会受到过滤的影响。在预设值中，该表首先按样本排序，然后
再按成分，其顺序如处理方法所示。
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表 6-7 选项

标签 描述

Show IS （显示 IS）单击显示 Results Table 中当前选择的分析物以及相应内标物
行。这与单击分析物，然后在按住 Ctrl 的同时单击内标物（这样两者都可以
被选中）效果相同。

Find （查找）单击查找列表中与特定文本匹配的项目。

检查峰

必要程序

• 打开一个 Results Table。

使用 Peak Review 窗格：

• 目测检查原始色谱图，这样就可以确定找峰程序的质量。

• 更正积分不当的色谱图，既可以采用调整找峰参数的办法，也可以通过手动方式选择积分
的起点和终点。色谱图积分更正完成后，Results Table 会用新的峰面积及其他参数自动更
新。

• 目视检查所积分 XIC 中的 MS 和 MS/MS 质谱图。

• 检查 Library Search 结果以及 Formula Finding 结果，必要时在 Results Table 中手动更新
这些结果。

• （质量重建工作流）肉眼检查 Average 谱图和 Reconstruction 谱图。

• （质量重建工作流）调整找峰参数或手动选择 XIC 区域，纠正 XIC 区域未正确选择的色谱
图。选定新的 XIC 区域后，再次生成 Average 谱图和 Reconstruction 谱图。

• （质量重建工作流）调整 Mass Peak Selection 参数或手动选择质量峰，纠正未正确选择的
质量峰。质量峰更改后，Results Table 会用新的峰及其他参数自动更新。

1. 单击 Displays the peak review( )。

2. 在左侧窗格的 Components and Group 列表中选择一个成分。

3. （可选）使用 View 菜单自定义 Peak Review 窗格的布局。关于 View 选项描述，请参阅
文档：《帮助系统》。

4. （可选）单击 Options > Peak review display settings 改变 Peak Review 窗格的外
观。例如，选择要同时查看的色谱图数量。关于选项描述，请参阅文档：《帮助系统》。
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图 6-28 Peak Review Options 对话框

5. （可选）如要放大峰，可使用下列方法：

• 单击 Options > Peak review display settings，然后单击 Zooming 以更改峰的缩放
参数。

• 将光标拖动至 X 轴或 Y 轴上要放大的区域。

6. （可选）如要放大峰使其充满整个 Peak Review 窗格，可选择峰，然后单击 Peak

magnifier( )。

提示! 当 Peak Review 窗格中的图标为黑色时，启用相应的功能。要禁用该功能，再次单
击图标。

7. （可选）要查看和调整图形上的噪声区域，单击 Options > Show Noise Regions，然后
调整噪声区域（如适用）。请参阅以下章节：使用噪声区域。

注释: 仅在使用 Peak to Peak 或 Standard Deviation 信噪比算法时可以调整噪声区域。

8. 如果色谱图或重建图中含有多个峰，并且有一个不正确的峰被积分，则拖拽鼠标将正确的
峰画入框内，设置一个新的预计保留时间或预期分子量。如有必要，可调整找峰参数和积
分参数。

9. （可选）要将新参数应用至样本成分或组的所有样本，请使用右键菜单选项。更多信息，
请参阅以下章节：使用 Peak Review 窗格中的峰值。

提示! 要查看积分的峰，请单击 Displays the peak review ( )。在 Peak Review 窗格
中，选择 Options > Show navigation controls。然后单击导航图标。关于图标的描
述，请参阅文档：《帮助系统》。
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提示! 单击 Set peak to "not found"( ) 可清除积分。用户在对峰进行手动积分前可以
查看原始数据。积分参数无法编辑。

10. 单击 Peak Review 窗格中的 Enable manual integration mode ( )，以使用 Manual
Integration 模式。

11. 将光标从所关注的峰一侧的底部拖至另一侧。
此时该峰已进行手动积分计算，而之前所使用的积分参数不可用。

提示! 如果峰刚刚已修改，则可以通过右键单击和单击 Revert Peak to Original Method
将峰恢复至原始方法。

提示! 要清除手动积分并启用积分参数字段，请清除 Manual Integration 复选框，然后再

次单击 Enable manual integration mode ( )。

12. （可选）如要在 Explorer 工作区中显示当前峰，可单击 Open data exploration( )。

保留当前缩放比例。

注释: 对峰的手动积分会持续存在，直到用户在 Peak Review 窗格更改该峰的积分，或者
编辑嵌入式方法以更改成分。

注释: 在质量重建工作流中，如手动积分重建质量峰，则相应的 XIC 区域和平均谱图依然
存在，直到用户在 Peak Review 窗格更改该峰的积分，或者编辑嵌入式方法以更改成
分。

使用 Peak Review 窗格中的峰值

表 6-8 Peak Review 功能

目的 方法

复制积分参数 将该命令与 Paste Integration Parameters 结合使用，可将一个
色谱图的找峰参数复制到另一个色谱图。如果需要对若干个色谱
图进行相同的参数调整，就可以使用该命令。

1. 在一个有活动色谱图打开的图表中单击右键，然后单击
Copy Integration Parameters。

2. 要将改动应用至成分的所有色谱图，请使用 Update
Processing Method for Component 命令。

3. 要将改动应用至组的所有色谱图，请使用 Update
Processing Method for Group 命令。
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表 6-8 Peak Review 功能 (续)

目的 方法

粘贴积分参数 将该命令与 Copy Integration Parameters 结合使用，可将一个
色谱图的找峰参数复制到另一个色谱图。

1. 在一个有活动色谱图打开的图表中单击右键，然后单击
Copy Integration Parameters。

2. 在另一个色谱图上单击右键，然后单击 Paste Integration
Parameters。

更新成分的处理方法 在对特定色谱图的找峰参数进行调整后，可使用此命令修改用
Results Table 保存的处理方法的副本，以将这些参数用于相关成
分。

• 调整找峰参数，右键单击，然后选择 Update Processing
Method for Component。

所有包含该成分的样本都将自动使用新的参数进行积分计算，
并更新 Peak Review 窗格和 Results Table。如果以手动方式
对某个峰进行积分计算，系统就会询问用户是将重新计算的积
分应用到所有峰，还是仅应用到那些未采用手动积分的峰。

更新组的处理方法 （不适用于质量重建工作流）它与 Update Processing Method
for Component 选项类似，唯一差别是积分适用于与当前活动
色谱图的成分同组的所有成分。如果用户指定了每个分组的各种
成分，并且估计已经分配至指定分组的成分有相同的保留时间，
那么该命令非常有用，因为它允许用户一次性重新设置分组中所
有成分的参数，包括预计保留时间。如果组内的成分保留时间不
同，则该命令不适用。

• 调整找峰参数，右键单击，然后选择 Update Processing
Method for Group。

更新组的处理方法，不含
Expected MW

（仅适用于质量重建工作流）它与 Update Processing Method
for Component 选项类似，唯一差别是积分适用于与当前活动
色谱图和重建图的成分同组的所有成分。如果用户指定了每个分
组的各种成分，并且估计已经分配至指定分组的成分有相同的保
留时间和积分参数，那么该命令非常有用，因为它允许用户一次
性重新设置分组中所有成分的参数，包括预计保留时间。如果组
内的成分保留时间不同，则该命令不适用。此命令不适用于
Expected MW。

• 调整找峰和积分参数，右键单击，然后选择 Update
Processing Method for Group, Excluding Expected
MW。
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表 6-8 Peak Review 功能 (续)

目的 方法

将积分参数应用到组内样
本

（不适用于质量重建工作流）在对特定色谱图的找峰参数进行调
整后，可使用此命令将参数应用至与更改化合物属于同一个组的
样本中的所有化合物。

• 调整色谱图的找峰参数，右键单击，然后选择 Apply
integration parameters to sample within a group。

将积分参数应用到组内样
本，不含 Expected MW

（仅适用于质量重建工作流）在对特定色谱图的找峰参数和重建
图的积分参数进行调整后，可使用此命令将参数应用至与更改化
合物属于同一个组的样本中的所有化合物。此命令不适用于
Expected MW。

• 对色谱图的找峰参数和去卷积质量峰的积分参数进行调整，右
键单击然后选择 Apply integration parameters to sample
within a group, excluding Expected MW。

将峰还原至原来的方法 特定色谱图的找峰参数调整完毕后，可使用此命令将用 Results
Table 保存的处理方法备份中的原始参数应用到色谱图。

• 在一个有活动色谱图打开的图形中单击右键，然后选择
Revert Peak to Original Method。

还原成分的所有峰 某些色谱图的找峰参数调整完毕后，可使用此命令将用 Results
Table 保存的处理方法副本中的原始参数应用到与活动色谱相同
成分的所有色谱图。如果以手动方式对某个峰进行积分计算，系
统就会询问用户是将重新计算的积分应用到所有峰，还是仅应用
到那些未采用手动积分的峰。

• 在一个有活动色谱图打开的图形中单击右键，然后选择
Revert All Peaks for Component。

使用噪声区域

如使用 Peak to Peak 或 Standard Deviation 信噪比算法，可在处理方法的 Integration 页面
和 Peak Review 窗格交互调整噪声区域。

1. 单击图形上的噪声区域，将其移动到所需的位置。

2. 移动光标到噪声区域的左边缘或右边缘，直到显示双头箭头。然后拖动边缘到所需的位
置，以调整噪声区域的大小。

使用谱库搜索或化学式查找器结果分析峰

提示! 单击 Options > Peak review display settings，更改窗格内显示的行数。用户也可向
上拖长窗格，以扩大 Peak Review 窗格。

1. 在 Peak Review 窗格内，单击 View，然后再单击 XIC + MS、XIC + MS/MS 或 XIC +
MS + MS/MS。
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搜索结果显示在下图中。

图 6-29 谱库搜索结果

2. 单击蓝色箭头，扩展 Library Search Results，从而显示更多可能的谱库匹配。

所选谱库匹配的化学结构也显示在表中。

3. 再次单击该箭头，以折叠表格。
折叠后表格中所示的结果也显示在 Results Table 内。

4. （可选）在表中选择一行，然后单击 图标，以更新 Results Table 内的结果，从而使
用该分析中的特定谱库匹配。

5. （可选）单击 ，以使用所选化合物的信息更新处理方法。

6. 要添加谱图到谱库数据库中，请遵照以下步骤：

a. 右键单击谱图，然后单击 Add spectrum to library。
Add spectrum to library 对话框随即打开。

b. 更新 Compound Name、Library 和 Precursor m/z 字段。

c. 单击 OK。

7. 单击蓝色箭头，扩展 Formula Finder Results，从而显示更多可能的结果。
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图 6-30 化学式查找器结果

如果化合物更新自 ChemSpider，那么所选化学式查找器结果的化学结构也显示在表中。

8. 再次单击该箭头，以折叠表格。
折叠后表格中所示的结果也显示在 Results Table 内。

9. 单击 ，以使用所选化合物更新 Results Table 中的 Formula Finder Results 列。

10. 单击 ，以使用所选化合物的信息更新处理方法。

提示! 单击 Options > Get Chemspider hit count，显示下图表格中的 ChemSpider Hit
Count 列。

11. 单击 ，打开 ChemSpider 应用程序。

请参阅以下章节：ChemSpider。

ChemSpider

注释: 该工作站必须包含一个可访问 ChemSpider 数据库的有效许可证文件。

注释: 下图中的信息仅用作示例。
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图 6-31 ChemSpider 会话

项目 描述

1 Results 窗格：显示与所选分子式匹配的建议化合物列表。具体结果以 40
种化合物为一组进行显示。使用向右箭头，可前进至列表中的下一组。使
用向左箭头，可返回至列表中的前一组。

2 Spectra 窗格：显示已采集的质谱（红色）以及匹配的碎片（蓝色）。蓝
色碎片越多，表明匹配效果越好。

3 Structure 窗格：显示结果窗格内所选化合物的化学结构。

4 Fragment 表窗格，Fragments 选项卡：显示所选化合物的匹配碎片总
数。

4 Fragment 表窗格，Peaks 选项卡：显示所选化合物的峰总数、匹配峰数
以及占总强度的 %。Assigned 列中的复选框会为匹配峰自动选定。

表 6-9 ChemSpider 的功能

当您执行这项操作时…… ……这将出现

在 Filter XIC List 图标旁边的字段中键
入该信息。

结果窗格刷新并且仅包含与所输入标准匹配的结
果。

在结果窗格内的条目中单击 其余窗格刷新，显示与该选项相关的信息。

单击碎片表窗格的 Fragments 选项卡中
的条目

其余窗格刷新。在质谱窗格中，红色箭头会显示在
匹配碎片（蓝色）的顶部和底部。在结构窗格中，
与该碎片匹配的化学结构成分会突出显示（粗
体）。
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表 6-9 ChemSpider 的功能 (续)

当您执行这项操作时…… ……这将出现

单击碎片表窗格的 AssignedPeaks 选
项卡中的 条目

其余窗格刷新。在质谱窗格中，红色箭头会显示在
匹配碎片（蓝色）的顶部和底部。在结构窗格中，
与该碎片匹配的化学结构成分会突出显示（粗
体）。

单击 ChemSpider results for 字段右侧
的向下箭头，并选择 ChemSpider web
site 选项

ChemSpider 网站 (www.chemspider.com) 随即在
浏览器窗口中打开。有关访问信息，请参阅
ChemSpider 帮助。

单击 ChemSpider results for 字段右侧
的向下箭头，并选择 Refresh 选项

所有更改都将撤销，会话还原至原始搜索结果。

单击 Select 在 ChemSpider 会话中选中的信息会被复制到软件
会话内的 Formula Finder Results 窗格。
ChemSpider 会话关闭。

Peak Review 窗格提示

• 在特定列上对 Results Table 进行排序，并且只检查排在最上面或最下面的色谱图。

• Peak Review 窗格始终与相应的 Results Table 同步，并按表中的相同顺序显示相同峰的色
谱图。对 Results Table 所作的任何改动（如行排列、筛选样本类型或者选择任何成分）都
会在 Peak Review 窗格中自动反映出来。

• 用窗格右侧的滚动条翻看现有色谱图。当 Peak Review 窗格处于活动状态时，用键盘上的
上下箭头键或鼠标上的滚轮在色谱图间移动光标。

• 单击第一列左侧的淡蓝色区，在 Results Table 内选择一行，在 Peak Review 窗格内显示相
应的峰。如果用户滚动到 Peak Review 窗格内的某个色谱图，Results Table 就会突出显示
相应的行，然后将其带入视图中。

• Analytics 工作区不支持数字分组。用户不得在任何文本框（如积分参数）和表格（如
Results Table）中对数字进行分组。

• 任何时点都有一个色谱图处于活动状态，并以黑体字标题来表示。单击某个色谱图范围内
的任意位置，使之处于活动状态。

小心: 潜在的数据丢失。注意不要在色谱图内拖动光标，否则会改变预计保留时间并导致积
分发生改变。

• 如果用户在色谱图中的某个峰周围拖动光标，则 Expected RT 积分参数就会随峰的实际保
留时间一起更新。新的保留时间就会自动应用，而且软件会对该峰再次进行积分，对
Results Table 相应进行更新。

• （质量重建工作流）如果用户在重建图中的某个峰周围拖动光标，则 Expected MW 参数
就会以峰的实际分子量更新。新的分子量就会自动应用，而且软件会对该峰再次进行积
分，对 Results Table 相应进行更新。

• （质量重建工作流）如果未选择 Recentered on the largest XIC Peak，则用户可以手动
选择所需的 XIC 区域。在 XIC 区域中心的时间为预计 RT，XIC 区域内最大峰的 RT 为发现
的 RT。
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• 如果用户在手动积分模式下检查峰，在峰周围拖动光标就会以手动方式对选中的峰进行积
分。拖动的同时按住 Shift 可帮助保持线条平直。

• 色谱图处于活动状态后，窗格左侧所显示的积分参数便会更新，以反映新的活动色谱图的
情况。如果用户调整了色谱峰的积分参数，然后单击 Apply，就会对当前处于活动状态的
色谱图产生影响。

• 用户必须在峰检查期间检查峰形，以识别潜在的饱和峰，并确保部分或不正确的积分不会
错误地导致报告的浓度不正确。

• 用户必须在峰检查期间检查色谱图中是否存在可能表示系统问题的噪音过大尖峰。

• 在 Y 轴范围内双击，按整个数据集内的最强峰调节轴上的标度。在轴范围内选择一个强度
范围即可放大视图。

• 在 X 轴范围内双击返回图表的主视图，所有数据在主视图中均可见。在轴范围内选择一个
时间范围即可放大视图。

• 在 Results Table 中逐个样本进行导览时，单击 Results > Cache all chromatograms for
faster peak review 可提高性能。

浓度极高（远远超过定量上限或 ULOQ）的样本可能会导致越来越宽、越来越饱和的峰，且其
峰形出现扭曲或分裂。

下图显示可以使用线性回归进行定量的最大浓度。

图 6-32 非饱和峰和饱和峰的示例

项目 描述

1 显示可用于定量分析的可接受峰。

2 显示饱和的峰。生成此峰的样本浓度远远超过 ULOQ。当峰达到饱和时，
由于增益抑制，峰变得越来越宽，且峰的顶端反转。应从定量分析中排除
此类峰，因为部分积分可能会导致报告的浓度不正确。

3 显示导致 LC 峰分成两个峰的极端饱和情况。应从定量分析中排除此类
峰，因为部分积分可能会导致报告的浓度不正确。
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使用统计量分析数据

必要程序

• 打开一个 Results Table。

使用 Statistics 窗格查看有关分析重现性的信息。表中每一行都汇总了源自相同分析物（预计
具有相同响应）的一组相关峰的平均值和标准差之类的信息。

查看峰积分、校准曲线和使用迭代过程的样本统计量。Results Table 中 Actual
Concentration 字段的精确度组也用于统计表。

注释: 有关统计量（包括 %CV 和准确度）验收值的信息，请参阅实验室标准操作程序。

打开 Results Table，然后单击 Views > Statistics pane。

Statistics 窗格列

标签 描述

Row （行）显示行数。

Component
Name

（成分方法）显示分析物的名称。

Sample Name/
Actual
Concentration

（样本名称/实际浓度）当样本按实际浓度分组时，显示浓度。当样本按照
样本名称分组时，显示样本名称。

Num. Values (数值）显示 m 中有 n，其中 n 是相同实际浓度（或相同样本名称）的样
本总数，而 m 是这些样本中用于计算的样本数。如果相应的峰不能进行
积分计算，或者 Used 字段被手动清空，样本就不会被使用。

Mean （平均值）显示所用样本的平均值。

Standard
Deviation

（标准差）显示所用样本的标准差。

Percent CV （百分比 CV）显示变异系数，以百分比表示：100 * Standard Deviation /
Mean。

Accuracy （准确度）显示平均值除以实际浓度，以百分比表示：100 * Mean /
Actual Concentration。只有在按实际浓度分组时才会显示该字段，按样本
名称分组时不显示。

Values （值）显示其他列中的样本的单个值。如果对应样本无法积分，则会显示
N/A。如果 Used 字段已手动清除，则显示该值时会带有一条删除线。
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标签 描述

Group by （分组依据）明确说明有关给定分析物的样本如何分组，以计算统计量。
其中包括以下选项：

• Group by Concentration for Standards（按标准物浓度分组）：标
准物样本按照实际浓度分组。

• Group by Concentration for QCs（按质量对照品的浓度分组）：质
量对照品样本按照实际浓度分组。

• Group by Sample Name for Standards（按标准物的样本名称分
组）：标准物重复样本按照 Sample Name 字段进行分组。

• Group by Sample Name for QCs（按质量对照品的样本名称分
组）：质量对照品重复样本按照 Sample Name 字段进行分组。

• Group by Sample Name for All Samples（按所有样本的样本名称分
组）：所有重复样本按照 Sample Name 字段进行分组。

度量 明确说明用于计算统计量的实际度量。其中包括以下选项：

• Calculated Concentration（计算所得浓度）：使用 Results Table 中
的 Calculated Concentration 字段。

• Area（面积）：使用 Results Table 中的 Area 字段。

• Height（高度）：使用 Results Table 中的 Height 字段。

• Calibration Y-Value（校准 Y 值）：使用为分析物指定的回归参数。
这是一种没有对应内标物的分析物的 Area 或 Height，或者一种使用
了内标物的分析物的 Area Ratio 或 Height Ratio。

Save Results
and Export

（保存结果和导出）单击以保存结果并导出统计表。Export Statistics 对
话框随即打开。

Statistics Pane 提示

• 在 Components and Groups 列表中，选择 All Components 以查看 Statistics 表中所有
分析物的条目。选择单独成分，以仅查看该分析物的条目。如果用户从列表中选择单个内
标物，则 Statistics 表为空。请参阅以下章节：Components and Groups 列表。

• 单击 Statistics 窗格中可见行的其中一个 Value 单元格，以在 Results Table 中选择相应的
行用于分析物和样本。如果 Peak Review 窗格可见，则它会与 Results Table 关联，并且会
在单击相应的单元格时进行更新。

• 单击其中一个列标题对统计数据进行排序。

• 复制整个 Statistics 表，或者仅通过选择行然后按下 Ctrl+C 来复制相关的行。

• 使用 Group by 列表指定（给定分析物的）样本应当如何分组进行统计计算。

• 使用 Metric 列表指定用于计算统计数据、计算所得浓度、面积等的度量。

• 调整列宽以优化显示。这些宽度在下一次显示 Statistics 窗格时会保留。
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• 要更改 Statistics 表的格式和精度，请在 Results Table 中更改它们。请参阅以下章节：
#unique_160。

• 要更改单个值的 Use Peak 选项，右键单击 Statistics 窗格中的单元格，然后选择 Use
Peak。Results Table 中的 Use Peak 列将更新。

查看 Calibration Curve
必要程序

• 打开一个 Results Table。

使用校准曲线通过将未知样本与一组已知浓度的标准物样本进行比较，来确定未知样本中物质
的浓度。请参阅以下章节：校准曲线。

1. 单击 Displays the Calibration Curve( )。

2. 要设置回归选项，单击 Regression。请参阅文档：《帮助系统》。

Export Calibration
使用 Export Calibration 将一份与当前 Results Table 相关联的所有分析物的校准等式副本保存
到一个外部文件 (mqcal)。这样用户就可以将一整套标准物样本的校准等式应用到不属于同一
个 Results Table 的其他样本。

典型的工作流为：

1. 创建一个仅包含标准物的 Results Table。

2. 使用 Peak Review 窗格确保积分成功。

3. 在 Calibration Curve 窗格中，单击 Options > Export calibration (and save results)以
保存校准副本。

4. 新建一个含未知浓度样本的 Results Table。

5. 在 Calibration Curve 窗格中，单击 Options > Assign external calibration 以将导出的
校准等式应用到新的 Results Table。

注释: 用户可以为新的 Results Table 指定应用 (mqcal) 校准文件。

如果原来的 Results Table（含标准物样本）已被改动，则必须重新导出 Results Table，以保
存更新后的校准等式。之前导出的校准等式不会自动更新。

使用度量图表分析数据

必要程序

• 打开一个 Results Table。

用 Metric Plot 对照行号或另一列，按 Results Table 列中的数值绘图。这些图表能够为目测数
据检查提供极大帮助。
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如果选择了一列，生成的图表会作为表内行号的方程，显示列内的数值。如果选择了两列，则
列内的数值便会相互对照绘制。两列中待选择的第一列含 X 值，而第二列则含 Y 值。

1. 在 Results Table 中选择一列或两列。

提示! 要选择第二列，在单击列标题的同时按下 Ctrl。

2. 单击 More > Create Metric Plot with new settings。

3. 在 Metric Plot 中，单击 Link，然后再单击 Link to results table columns 或 Link to
results table rows，以将 Results Table 中的滚动内容链接至 Metric Plot。
有关 Link 菜单的更多信息，请参阅文档：《帮助系统》。

4. 要更新度量图表，请选择 Results Table 中的相关行，然后在 Metric Plot 窗格中，单击
Link > Plot selected rows only。

提示! 要选择多个行，请在选中行的同时按下 Ctrl。

5. （可选）通过从 Options 菜单中选择选项来自定义 Metric Plot 选项。关于选项描述，请
参阅文档：《帮助系统》。

度量图表提示

• 如果用户左键单击某个数据点，Results Tabble 中的相应行便会被自动选中，并滚动显示。
如果 Peak Review 窗格打开，则该窗格也会更新，并显示对应的色谱图。这为对色谱峰执
行离群值检查提供了一种便捷方法。

• 标题区始终显示活动轨迹的名称。如果多种成分的轨迹被叠加在一起，可以切换不同标
题，以显示所有轨迹的信息，或者通过单击标题左侧的加号 (+) 仅显示当前活动轨迹。单击
标题或相应标题左侧的彩色点，或选择 Metric Plot 中的某个数据点便可激活与之对应的轨
迹。

• Metric Plot 可用来绘制内标物或质量对照品样本的峰面积，从而监测可能的偏差或趋势。

编辑报告模板

小心: 潜在的数据丢失。为防止用户改动模板，一定要将 Reporter 模板放在一个安全的只读
文件夹内，只有系统管理员才有写入权限。

用户负责验证自定义模板。

1. 打开 docx 模板。

提示! 模板位于 C:\ProgramData\SCIEX\Analytics\Reporter。

选中某个区域时，Reporter 模板编辑器在右侧打开。模板编辑器会自动加入标签信息。
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图 6-33 Reporter 模板编辑器

项目 描述

1 显示当前标签的报告模板。

2 图标:

• 添加新标签。

• 添加图片标签。

• 显示内容区。

• 查看文件变更日志。

3 Created with：显示提供标签信息的软件名称。

4 Field Type：显示适用于该软件的字段类型。

5 根据选定字段类型显示可用属性列表。例如，标签名称和数字格式。

6 Save Tag Parameters：单击以保存改动。如果未保存改动，则会显示
一条消息，提示用户保存所作改动。

2. 使用下表中的程序。

表 6-10 Reporter 软件功能

目的 方法

更改字段类型。 在标签内单击，选择一个新的字段类型，然后选择属性。

更改字段类型的属性。 在选项卡内单击，然后根据要求更改属性。

添加标签。 单击 Add new tag 图标，选择 Field Type，然后选择属性。

添加图片。 单击 Add picture tag 图标，然后选择属性。
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表 6-10 Reporter 软件功能 (续)

目的 方法

显示标签的起始和终止位
置。

单击 Show content area 图标。

显示文档变更日志。 单击 View document change log 图标。

复制并粘贴标签。 复制选定标签并将它们粘贴到新位置，然后更新字段类型属
性。

属性不会被复制，必须进行选择。

标签之间的跳转。 用左右箭头键在标签之间来回移动。

删除标签。 执行以下任一操作：

• 如果光标位于标签的左侧，按 Delete 键。

• 如果光标位于标签的右侧，按 Backspace 键。

3. 作出更改后，单击 Save Tag Parameters。

提示! 强制信息在字段左侧用闪动的红色惊叹号表示。

Reporter 模板

自定义报告模板由用户自行验证。

一些报告模板使用查询。用户可以使用基于 Microsoft Excel 的公式创建查询，从而评估、处
理和列出报告 Results Table 中的数据。报告模板中的 Metafield 标签用于说明报告应当使用的
查询文件的名称。要使用查询，必须在报告模板的 MetaField 标签中指定查询文件名称。查询
还必须具有“.query”的扩展名，以便被识别为查询。查询必须存储在报告模板所存储的
Reporter 文件夹中。

当使用 Reporter 模板时，特别是当在模板中使用查询时，建议用户验证所生成的结果。如果
在验证后对报告模板进行了修改，则应重新验证报告模板。修改报告模板包括修改 Reporter
标签或查询。

表 6-11 默认模板

模板 模板说明（如 Create Report 对话
框所示）

补充说明

所有峰定性 这份报告针对每个样本显示一个区
域，其中包含文件信息、样本信
息、分析物结果表格以及所有分析
物和内标物的叠加色谱图。Analyte
Results Table 按照其在 Results
Table 内的显示内容打印。所有定性
置信度红绿灯均在表格开头处列
出。

不适用
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

分析物 20% 报告 这份报告针对每个分析物显示一个
区域，其中包含文件信息以及每一
种空白样本、标准样本、质控样本
和 20% 未知样本的 XIC 表。

此样本报告模板随附了查询文件
Analyte20percent.Query。

分析物摘要 这份结果表格显示批次所有样本中
特定分析物及相关内标物的样本名
称、计算浓度和离群值。

不适用

校准曲线 这份报告显示分析物的文件信息、
统计表（标准物）和校准曲线，每
种分析物占一页。

• Reportable 复选框被清除的标准
物将不会在数据表中报告。统计
数据不会受到 Reportable 状态影
响。

• 此报告将根据 Used 列状态显示
回归方程和图形，如 Analytics 工
作区的 Calibration Curve 窗格中
所示和计算。

完整定量所有峰
和图形

这份报告显示每个样本的 Results
Table 条目。所有在 Results Table
中可见的列均会在报告中显示。报
告还包括各样本和分析物的 XIC 色
谱图、平均质谱图和重建质谱图。

此报告专门用于质量重建工作流。

完整定量分析物
摘要和校准曲线

这份报告显示 Results Table 条目、
校准曲线和各分析物统计数据。
Results Table 包括样本名称、样本
类型、分析物名称、实际浓度、面
积、高度、预计 MW、MW、MW
增量、计算所得浓度和准确度。

此报告专门用于质量重建工作流。

完整定量样本摘
要

这份报告显示所有样本的 Results
Table 条目。Results Table 包括样
本名称、样本类型、分析物名称、
实际浓度、面积、高度、预计
MW、MW、MW 增量、计算所得浓
度、准确度和准确度接受度。

此报告专门用于质量重建工作流。

度量图表 这份报告针对每个分析物显示一个
区域，其中包含文件信息和分析物
峰面积的度量图表。

Reportable 复选框的状态不会影响
报告内容。即使清除该复选框，也
会包含所有数据点。

MQ 分析物报告
1

这份报告针对每个分析物显示一个
区域，其中包含文件信息、样本结
果表和每个样本的 XIC 表 - 每个分
析物（< 8 个样本）通常会打印 2
页。

不适用
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

MQ 分析物报告
2

这份报告针对每个分析物显示一个
区域，其中包含文件信息和每个未
知样本的 XIC 表 - 每个分析物（< 8
个样本）通常会打印 2 页。

仅报告未知项。

MQ 分析物报告
3

这份报告针对每个分析物显示一个
区域，其中包含文件信息和未知样
本摘要表。

仅报告未知项。

MQ 分析物报告
综合表

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要表。该表显示为 2
列，以便每页能够显示更多样本。

仅报告未知项。

含色谱图的 MQ
分析物报告

这份报告针对每个分析物显示一个
区域，其中包含文件信息、样本结
果表和每个样本的小型色谱图。

仅报告未知项。

MQ 空白模板 不适用 这份报告仅显示标题信息、徽标和
页码。

MQ 肽定量 不适用 与肽定量数据集一起使用。请参阅
MultiQuant 软件的用户指南的第二
个示例，绝对定量示例。

带标记的 MQ
QC 摘要 1

这份报告显示文件信息、每种分析
物的 QC 摘要表（CV 高于 20% 的
数值会突出显示）以及 QC 详细结
果表（准确度在 80-120% 范围之外
的数值会突出显示）。

清除 Reportable 复选框的质控品不
会包含在报告中，也不会用于计
算。

MQ 样本报告 1 这份报告针对每个样本显示一个区
域，其中包含文件信息、样本信
息、IS 信息、分析物结果表和包含
IS 和各分析物的 XIC 表 - 每个样本
（< 8 个样本）通常会打印 2 页。

不适用

MQ 样本报告 2 这份报告针对每个分析物显示一个
区域，其中包含文件信息、TIC、样
本详细信息、分析物 XIC 和表格形
式的结果 - 每个样本（< 8 个样本）
通常会打印 2 页。

仅报告未知项。

MQ 样本报告 3 这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要表。

仅报告未知项。
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

MQ 样本报告综
合表

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要表。该表显示为 2
列，以便每页能够显示更多分析
物。

仅报告未知项。

含色谱图的 MQ
样本报告

这份报告针对每个样本显示一个区
域，其中包含文件信息、样本信
息、分析物结果表和每个分析物的
小型色谱图。

仅报告未知项。

含浓度阈值的
MQ 样本报告

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要。

• 相关查询文件为包含
Concentration Threshold.query
的样本报告。

• 成分必须命名为 "Cmpd X #”X
#"，其中 X 是从 A 到 F 的任意字
符，# 是任意数值。

示例：在报告中，名为 "Cmpd A
1" 的成分将显示在标题
Compound Group A 下；名为
"Cmpd B 1" 的成分将显示在
Compound Group B 下，以此
类推。

• 如果成分属于同一个组，则该组
中仅按字母顺序的第一个成分将
被纳入报告。

例 1：如果 "Cmpd B 25" 和
"Cmpd C 1" 都属于组 "Grp"，则
"Cmpd C 1" 不会出现在报告中。

例 2：如果 "Cmpd A 1"、 "Cmpd
A 2" 和 "Cmpd A 3" 未分配到
组，则 "Cmpd A 2" 和 "Cmpd A
3" 将不会出现在报告中。

例 3：如果 "Cmpd A 1"、"Cmpd
A 2" 和 "Cmpd A 3" 分别分配到
组 1、2 和 3，则所有 3 个成分
都将出现在报告的 Compound
Group A 标题下。
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

含 MRM 比的
MQ 样本报告 2

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息、报告摘要表和所有 XIC 叠加
图。Expected Ion 率可采用任何可
用标准物自动计算。比值被放在
Results Table 的自定义列中。任何
与预计值偏差超过 20% 的值都会被
标记。定量离子分析物名称必须以
一个空格后接数字 1 为结尾。比值
离子分析物名称必须以一个空格后
接 2 和 9 之间的某个数字为结尾。

不适用

含 MRM 比的
MQ 样本报告 EU

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要表。Expected Ion
率可采用任何可用标准物自动计
算。比值被放在 Results Table 的自
定义列中。任何超过预计值的数值
都会被标记（依据 EU 比值公差指
引）定量离子分析物名称必须以一
个空格后接数字 1 为结尾。比值离
子分析物名称必须以一个空格后接 2
和 9 之间的某个数字为结尾。

相关查询文件为
MRM ratios EU.query。

含 MRM 比的
MQ 样本报告
MQ EFAB 03

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要表。Expected Ion
率可采用任何可用标准物自动计
算。比值被放在 Results Table 的自
定义列中。任何与预计值偏差超过
20% 的值都会被标记。定量离子分
析物名称必须以一个空格后接数字 1
为结尾。比值离子分析物名称必须
以一个空格后接 2 和 9 之间的某个
数字为结尾。

不适用
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

含 MRM 比的
MQ 样本报告

这份报告针对每个未知样本显示一
个区域，其中包含文件信息、样本
信息和报告摘要表。Expected Ion
率可采用任何可用标准物自动计
算。比值被放在 Results Table 的自
定义列中。任何与预计值偏差超过
20% 的值都会被标记。定量离子分
析物名称必须以一个空格后接数字 1
为结尾。比值离子分析物名称必须
以一个空格后接 2 和 9 之间的某个
数字为结尾。

相关查询文件为
MRM ratios.query。

含标准物、质控
品和空白品的
MQ 样本报告

这份报告针对每个样本显示一个区
域，其中包含文件信息、标准物摘
要信息、质控品摘要表、空白品结
果表；并针对每个未知样本显示一
个区域，包含文件信息、样本信
息、IS 信息、分析物结果表和包含
IS 和各分析物的 XIC 表 - 每个样本
（< 8 个样本）通常会打印 2 页。

清除 Reportable 复选框的标准物和
质控品不会包含在报告各自的综合
表中，也不会用于统计计算。

MQ Tutorial
Dataset Heavy
Light

不适用 此报告用于与 Tutorial Dataset
Heavy Light 数据集一起使用。请参
阅 MultiQuant 软件的用户指南的第
二个示例，相对定量示例。

每个样本定量-定
性

这份报告针对每个选定样本显示一
个区域，其中包含文件信息、样本
信息和选定分析物的分析物结果
表。Analyte Results Table 按照其
在 Results Table 内的显示内容打
印。所有定性置信度红绿灯均在表
格开头处列出。

不适用

每个样本定量-定
性可见行（使用
可见分析物）

这份报告针对每个选定样本显示一
个区域，其中包含文件信息、样本
信息和选定分析物的分析物结果
表。Analyte Results Table 按照其
在 Results Table 内的显示内容打
印。所有定性置信度红绿灯均在表
格开头处列出。

行的隐藏状态优先于 Reportable 复
选框的状态。如选中 Reportable 复
选框，但行已隐藏，则不会报告该
行。
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

每个样本定量-定
性（含统计数
据）

这份报告显示每个样本的成分以及
WYSIWYG 表。显示 XIC、MS 和
MS/MS。面积的统计综合表显示在
报告末尾。

• 如果成分表包含 UV 成分，则
UV 迹线将在该报告的 XIC 图形
下报告。

注释: 如果 UV 成分的名称采用格
式 [compound_nameuv] 或
[uv]，则不报告任何 UV 迹线，因
为 uv 后缀与 UV MS 定性报告相
关。

• 如果样本被标记为 QC，且有 2
个或以上样本，则将计算均值、
STDEV 和 %CV 并将其包含在报
告末尾的 QC 摘要表中。

• 如果清除 QC 行的 Reportable
复选框，则该行不会用于 QC 摘
要表的任何计算。

每个分析物定量-
定性

这份报告针对每个分析物显示一个
区域，其中包含文件信息、Results
Table、校准曲线以及内标物和每种
分析物的色谱图。该模板适合已定
义分组的 Results Table。

不适用

确定匹配定性 这份报告针对每个选定样本显示一
个区域，其中包含文件信息；样本
信息；选定分析物的分析物结果
表；所有分析物、内标物和 XIC 的
叠加色谱图；已采集/理论 MS 质
谱；每种选定分析物的已采集/谱库
MS/MS 质谱。Analyte Results
Table 按照其在 Results Table 内的
显示内容打印。所有定性置信度红
绿灯均在表格开头处列出。

不适用

定性 CSV 报告 这份报告以 .csv 格式针对每个样本
显示一个区域，其中包含文件信
息、样本信息和分析物结果表。

建议对报告格式使用 CSV 选项。

样本摘要 这份报告针对每个样本显示一个区
域，其中包含分析物摘要表。该报
告模板适合已分组的 Results
Table。

不适用
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表 6-11 默认模板 (续)

模板 模板说明（如 Create Report 对话
框所示）

补充说明

UV MS 定性报告 这份报告通过 WYSIWYG 表针对每
个样本显示该样本的成分及其对应
的 UV 成分。报告会显示 XIC、MS
和 MS/MS 以及 UV 数据。面积的统
计综合表显示在报告末尾。

• 处理 UVMS 数据时应遵循命名惯
例，使用 compound 1（任意字
符串）表示质谱仪 (MS) 组件，
compound 1uv（任意字符串加
uv）表示相应的 UV 组件。

• 仅会显示质量误差、碎片质量误
差、RT 置信度、同位素置信度
和谱库置信度红绿灯。

• 可创建图形表来显示 Results
Table 的各个成分，包括化合物 1
的 XIC、MS1 迹线、MS/MS 迹
线和标题信息，以及化合物 1uv
的 UV 迹线。请参阅图 6-34。

• 分析物图形仅可重复用于 MS 实
验，而不能用于 UV 实验。

• 如果样本被标记为 QC，且有 2
个或以上样本，则将计算均值、
STDEV 和 %CV 并将其包含在报
告末尾的 QC 摘要表中。请参阅
图 6-35。

• 如果清除 QC 行的 Reportable
复选框，则该行不会用于 QC 摘
要表的任何计算。

图 6-34 图形表
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图 6-35 统计表
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事件 7
发生问题时，Central Administrator Console (CAC) 软件会记录屏幕上显示的错误报告和警
告。Event Log 工作区包含系统事件日志，包括错误、警告和消息。

要打开此工作区，请单击 Home 页面上的 Event Log 图标。

表 7-1 Event Log 工作区列

标签 描述

Current （当前）各个子系统的当前事件列表。

Severity （严重性）事件类型：信息、错误或警告。

Time （时间）发生事件的时间。

Subsystem （子系统）发生事件的子系统。

Event （事件）事件的描述。此信息可用于系统检修。

User （用户）用户名称和发生事件的系统。

注释: 对于由决策规则触发的事件，就是提交该批次的用户。

事件日志
其中包括以下日志：

• All（全部）

• Device（设备）

• LC(LC)

• Mass Spectrometer（质谱仪）

• Workspace（工作区）

• Batch（批次）

• Explorer(Explorer)

• Devices（设备）

• General（概况）

• LC Method（LC 方法）

• MS Method（MS 方法）

• MS Tune（MS 调谐）

• Analytics（分析）
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• Queue（队列）

• Users（用户）

• Configuration（配置）

在事件日志包含 20,000 条记录后，SCIEX OS 会自动归档记录并开始创建新的事件日志。更
多信息，请参阅以下章节：事件日志存档。

查看日志
1. 打开 Event Log 工作区。

2. 单击左侧面板中的列表项查看日志。

存档日志
1. 打开 Event Log 工作区。

2. 单击 Archive > Archive Log。

图 7-1 Archive 菜单：Archive Log

图 7-2 Archive Log 对话框

3. 在 Archive event log items older than 的字段中，单击日期图标并选择一个日期。

4. 单击 Archive。

查看存档的日志

1. 打开 Event Log 工作区。
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2. 单击 Archive > Open Log Archive。

图 7-3 Archive 菜单：Open Log Archive

3. 打开所需的文件。

4. 单击 Archive > Close Log Archive。

图 7-4 Archive 菜单：Close Log Archive

打印日志
1. 打开 Event Log 工作区。

2. （可选）打开存档日志。请参阅以下章节：查看存档的日志。

3. 单击 Print。
Print 对话框随即打开。

4. 选择打印机，然后单击 Print。

事件日志存档
事件记录都汇集在事件日志中，可能会形成庞大的文件，从而给查找和管理都带来困难。

当事件日志达到 20,000 条记录时，便会进行存档。一条最终的事件记录会添加到事件日志，
然后，该事件日志将采用显示事件日志的类型、日期和时间的文件名保存。接着，将创建新的
事件日志。新事件日志中的第一条记录将说明事件日志已存档。

事件日志存档储存在 C:\ProgramData\SCIEX\Clearcore2.Acquisition 文件夹中。

文件名的格式为 <logfile>Archive_<YYYYMMDD>_<HHMMSS>.data。例如，
CustomerLogArchive_20220427_172915.data。
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审核 8
本部分主要介绍如何使用审核功能。

查看审核记录结果
1. 打开 Audit Trail 工作区。

2. 要查看工作站的审核记录，单击左侧窗格中的 Workstation。

3. 要查看项目的审核记录，选择左侧窗格中的项目。然后选择以下选项之一：

• General Events：显示应用至整个项目的审核记录，如审核图更改和样本采集。

• Analytics：显示 Results Table 的审核记录。

• All Project Events：显示一般事件和处理事件的审核记录。

使用关键词搜索过滤已审核事件
用户可以使用关键字搜索筛选审核记录中的已审核事件。搜索会突出显示每一次出现的文本。

1. 打开 Audit Trail 工作区。

2. 选择要搜索的审核记录。请参阅以下章节：查看审核记录结果。
随即将显示 Audit Trail。

3. 在 Find in Page 字段中键入要查找的词语。
页面上出现的所有词语将突出显示。

4. 使用 Next ( ) 和 Previous ( ) 按钮在匹配项之间移动。

使用一组指定标准筛选已审核事件
用户可以使用一套指定标准过滤审核记录中的已审核事件。

1. 打开 Audit Trail 工作区。

2. 选择要筛选的审核记录。请参阅以下章节：查看审核记录结果。
随即将显示 Audit Trail。

3. 单击 Filter( )。
Filter Audit Trail 对话框随即打开。

4. 用列表定义所需筛选标准。
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图 8-1 Filter Audit Trail 对话

项目 描述

1 在<No Filter>列表，选择要筛选的字段。以下字段可用于筛选：

• Description

• Sample Name

• Full User Name

• E-Signature

• Reason

2 选择以筛选某个特定的词或短语。

3 选择以筛选部分词或短语。

4 指定要筛选的文本，如下所示：
• 键入全文本字符串。选择 Is（项目 2）。

• 键入部分文本字符串。选择 Contains（项目 3）。

• 选择 Yes 或 No。

5 用于筛选在特定日期和时间发生的事件。

5. 要清除筛选条件，请遵照以下步骤：

a. 单击 Filter( )。

b. 单击 Clear 将所有过滤标准重设为 No Filter。
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c. 单击 OK。

打印审核记录
1. 打开 Audit Trail 工作区。

2. 选择要打印的审核记录。请参阅以下章节：查看审核记录结果。

3. 单击 Print。
Print 对话框随即打开。

4. 选择打印机，然后单击 Print。
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工作原理—软件 A
本部分描述软件中使用的概念。

数据处理
SCIEX OS 软件需要一台运行 Windows 7、64 位或 Windows 10、64 位操作系统的计算机。
计算机及相关系统与系统控制器和相关固件一起控制系统和数据采集。在系统运行期间，所采
集的数据会被发送至 SCIEX OS 软件，此软件可通过完整质谱、单离子或多离子强度随时间
变化曲线或总离子流随时间变化曲线的形式显示这些数据。

扫描技术
该系统是一种用途广泛的、可靠的系统，用于对样本液流执行液相色谱-质谱分析，以便识
别、量化和检测化合物。

该系统采用以下质谱技术对样本进行分析：

• 单一质谱法 (MS) 的两种模式：

• 基于四极的单一质谱分析（仅适用于 Q1 校正）

• 基于飞行时间的单一质谱分析

• 串联质谱法 (MS/MS) 的一种模式：

• 产物离子质谱分析

不同的数据视图

色谱图

色谱图显示在重复性实验中，某些量相对于时间发生的变化。例如，当仪器经过编程设计可将
一组给定的质谱扫描重复数次时。色谱图数据是连续的，即使数据强度为零也不例外。色谱图
不是由仪器直接生成的，而是通过质谱产生的。

在色谱图中，以每秒次数 (cps) 为单位的强度在 Y 轴上显示，而 X 轴代表时间。峰是自动标记
的。

色谱峰的保留时间和强度会随着给定样本的色谱条件变化而变化。

该软件显示以下类型的色谱图：

• TIC：通过将总离子流作为时间的函数而绘得的图形。
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图 A-1 TIC 示例

• XIC：通过从一系列质谱扫描在单个、不连续的质量数或一个质量范围内提取产生的强度数
值而创建的离子色谱图。XIC 表示一个给定的质量数或质量范围随时间变化的行为。
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图 A-2 XIC 示例

质谱图

质谱是指直接从质谱仪获取的数据，通常代表的是以特定质荷比 (m/z) 值检测到的离子数。它
以图形形式显示，X 轴显示 m/z 值，Y 轴显示强度 (cps)。

当数据作为质谱查看时，可获得有关某化合物的质量特异性信息。质谱提供特定色谱峰的对应
离子的 m/z 值。这些离子可用于查找更具体的信息。例如，质谱显示的是组成一个峰的所有质
量，包括每一种质量的强度。

质谱强度可能会改变，但 m/z 值是固定的，因为化合物的质量不会改变。

生成质谱数据有两种方式：

• 如果只采集到一种扫描，则会以质谱方式显示数据。

• 来自色谱图。

重建谱图

通过对 MS 或 MS/MS 质谱应用去卷积算法可生成处理过的质谱。重建谱图由具有相应强度的
零电荷或中性质量组成。谱图通常提供化合物的分子量信息。谱图强度可能会发生变化，但分
子量信息不会变化。

显示典型的重建谱图时，质量 (Da) 显示在 X 轴上，强度显示在 Y 轴上。
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决策规则
当 Queue 工作区内正在处理批次时，软件能针对特定分析结果执行选定的纠正措施。例如，
如果样本不符合处理方法中定义的验收标准（分析结果），则可要求软件重新注射该样本（纠
正措施）。

此功能通过决策规则实现。决策规则包括两个主要部分：

• 标记规则，用于定义分析结果

标记规则在处理方法中定义。

• 纠正措施，当处理结果不符合分析结果标准时采用纠正措施

纠正措施包括以下几种：

• 停止队列

• 中止批次

• 注射不同的样本

• 重新注射标记的样本

创建批次时，用户可以激活该批次的决策规则，然后选择要使用的决策规则。

Dynamic Background Subtraction 算法
Dynamic Background Subtraction 算法可以增强信息相关采集 (IDA) 实验中前体离子的检测效
果。当算法被激活后，IDA 将使用一个已经经过背景减除的质谱来选择所关注的前体离子进行
MS/MS 分析，而非直接从测量质谱中选择前体离子。由于在 LC 分析期间进行处理，该算法
在信号强度增加时启用粒子种类检测。因此，此算法关注 LC 峰上升部分直至或稍微超出 LC
峰顶部的前体离子的检测和分析。

定量分析
定量分析用于确定样本中特定物质的浓度。通过分析未知样品并与包括浓度已知的相同物质的
样本（即标准物样本）进行比较，软件可以计算出未知样品的浓度。这个过程涉及使用标准品
的信号响应或响应比创建校准曲线，然后计算未知样本的浓度。所有样品的计算所得浓度都添
加到 Results Table 中。

定量分析最常使用多反应监测 (MRM) 扫描执行。在 MRM 扫描中，使用前体离子和特征产物
离子定义对分析物具有高度特异性的 MRM 离子对。在液相色谱检测期间，MRM 离子对与分
析物相关保留时间结合起来，可达到定量分析所需的特异性。

定量工作可通过使用经过验证的 MRM LC-MS/MS 采集方法、采集校准标准曲线以及随后对目
标化合物相关峰进行积分来实现。信号响应与浓度之间的校准曲线关系用于确定未知样本中特
定分析物的含量。

标准物添加

标准物添加可用于确定已知基质效应阻碍了传统校准曲线使用的样本中的化合物浓度。
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此功能让用户可以在软件内直接执行标准物添加计算。如果在定量工作流中启用了标准物添加
功能，那么将在积分过程中执行标准物添加计算，结果将显示在 Results Table。

如果启用此功能，那么将禁用以下回归参数：

• Regression Type

• Weighting Type

• Automatic Outlier Removal

启用标准物添加功能

1. 打开 Analytics 工作区。

2. 单击 Process Method > New。

提示! 要编辑已有的处理方法，单击 Process Method > Edit embedded method，然后
遵照下列步骤。

3. 选择 Workflow 页面，然后选择至少一个工作流程以及参考样本。

4. 选择 Components 页面，然后定义成分名称、质量、内标物、分组等。

提示! 如果该组在 Components 表中进行定义，那么用户可选择对组内离子求和，即使相
应离子对的前体离子和实验指数不同时也不例外。求和离子未显示在表中，但却显示在
Integration 页面上，并且也作为 <group name>_Sum 显示在 Results Table 中。该功能有
助于定量分析蛋白质和肽。

提示! 在成分的保留时间未知的情况下，请将质量或化学式的 Retention Time Mode 设置
为 Find n peaks，其中 n 为 1、2、5、10 或全部。软件可识别指定数量的面积最大的特
征峰，指定合适的保留时间，然后执行针对性的峰处理工作流。处理完成后，可以将
Results Table 的内嵌方法保存为一个正常的针对性方法。

5. 选择 Integration 页面，然后为各个成分选择积分参数。

6. 单击 Options > Quantitate by standard addition。

此功能对以下批次字段有具体要求：

• Sample ID:属于同一标准物添加组的所有样本必须具有相同的样本 ID。

• Sample Type:采用标准物添加进行定量分析的所有样本必须具有样本类型
Standard。

• Actual Concentration:该字段必须包含添加到标准物添加组中每一样本的标准物的已
知浓度。例如，对于没有添加标准物的样本，该字段为 0。来自该列的数据绘制为
Calibration Curve 上的 X 轴。

如果启用该功能，那么 Results Table 将包含一个新的 Standard Addition Accuracy 字
段，该字段将样本的 Standard Addition Calculated Concentration 与 Standard
Addition Actual Concentration 相比较。

特定样本的校准曲线动态视图显示在 Calibration Curve。
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质量重建

对于大分子，通常会在 MS 全扫描质谱中观察到电荷状态散布。质量重建功能让用户可以直接
在软件中执行谱图去卷积，然后基于去卷积或零电荷质量峰执行定量。如果质量重建功能已在
定量工作流程中启用，则将在处理期间执行找峰、谱图去卷积、质量峰查找和积分，且结果将
显示在 Results Table 中。

启用质量重建功能

注释: 质量重建仅在定量工作流程中受支持。

注释: 质量重建仅支持 MQ4 和 Summation 积分算法。

注释: 如果启用了质量重建，则 Options > Sum Multiple Ion 被禁用。

1. 打开 Analytics 工作区。

2. 单击 Process Method > New.

提示! 要编辑已有的处理方法，单击 Process Method > Edit embedded method，然后
遵照下列步骤。

3. 选择 Workflow 页面，然后选择 Quantitation 工作流程以及参考样本。

4. 选择 Components 页面。

5. 单击 Options > Mass Reconstruction。

6. 添加成分，以在必填字段中键入信息。

注释: Expected MW 字段可选。

7. 单击 Integration 查看积分页面，并审核 XIC 色谱图、平均质谱图和重建质谱图，然后选
择目标质量。

8. 保存方法。

如果这项功能启用，则 Results Table 会包含以下新列：Expected MW、MW、MW
Delta (Da)、MW Delta (ppm)、IS Expected MW、IS MW、IS MW Delta (Da) 和 IS
MW Delta (ppm)。

定性分析
定性分析是鉴别一种目标或未知化合物。在质谱分析中，确定存在哪种化合物的工作可使用质
量准确度、保留时间、同位素模式、谱库搜索和化学式查找功能来实现。综合使用所有这些工
具可在鉴别未知样本中靶标和非靶标化合物方面提高置信度。

质量准确度

当尝试识别样本中的一种已知目标化合物时，查看该化合物的质量准确度并确定该化合物的某
种可能的匹配是否具有在特定公差范围内的质量准确度是非常有用的。例如，抑霉唑的化学式
为 C14H14Cl2N2O，由它得出的单同位素质量为 296.0483，精确到小数点后四位。质子化加合
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物是带一个正电荷的一种离子，使用质谱仪通常可检测到。抑霉唑的质子化加合物的质荷比
(m/z) 为 297.0556。如果怀疑样本中有抑霉唑，则将所发现的化合物的 m/z 与质子化抑霉唑的
m/z 进行比较，并确定它们的匹配程度。差值越小（以 ppm 或 Da 为单位），发现的化合物就
越可能匹配。

保留时间

大多数质谱仪使用某种类型的色谱法。化合物的保留时间通过注射化合物的一种已知标准物确
定。保留时间可用于帮助鉴别样本中的目标化合物。如果疑似化合物存在于一种未知物样本
中，则保留时间越靠近标准物的保留时间，未知化合物就越容易鉴别。保留时间可能变动，且
必须使用已知标准物进行常规确认。

同位素模式

根据化合物的分子式，在质谱仪中对其得出的全扫描质谱具有不同的同位素模式。

关于抑霉唑的同位素形式，请参阅下图。

图 A-3 同位素模式（抑霉唑）

抑霉唑的同位素模式由元素的不同质量同位素构成。对同位素模式进行理论计算，然后将其与
在未知物样本中针对该化合物实际采集到的同位素模式进行比较。理论与实际同位素模式越匹
配，该化合物就越有可能是已鉴定的化合物。

谱库搜索

将未知样本的已采集 MS/MS 质谱与包含参考质谱的化合物数据库进行比较是最强有力的定性
分析工具之一。谱库搜索算法将未知物质谱与样本进行比较，然后尝试将质谱匹配至已知化合
物和数据库内的质谱。匹配越接近，所报告的评分越高，从而更有可能使化合物得到鉴定。

纯度、拟合值和逆拟合值计算如下：

• 如果（折算的）谱库质谱和（折算的）未知质谱（其强度比在用户指定的限值范围内）在
给定质量下都有一个峰，则谱库质谱内的峰强度会被设定为与未知物质谱相等。

• 纯度计算如下：
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100.0 (ULtotal)2 / (Utotal•Ltotal) 其中：

Utotal = ∑ Um•Um

Ltotal = ∑ Lm•Lm

ULtotal = ∑ Um•Lm

求和值包括所有质量，其中强度 Um 和 Lm 是质量加权值的平方根，它是折算的未知库条
目。纯度一定会落入 0 - 100 的范围内，它是衡量谱库质谱和未知物质谱相似性的一个指
标。

• 拟合值按照与纯度完全相同的方式进行计算，但只有出现在谱库质谱中的质量才会被包括
在总和之中。这对 Ltotal 或 ULtotal 没有影响，因为未从这些总和值中删除任何条件。拟合值
是衡量谱库质谱包含在未知物质谱内的程度的一个指标。高拟合值和低纯度表示未知物质
谱可能不纯，但包含谱库化合物。

• 逆拟合值也按照与纯度完全相同的方式进行计算，但只有出现在未知物质谱中的质量才会
被包括在总和之中。逆拟合值是衡量未知物质谱包含在谱库质谱内的程度的一个指标。

化学式查找

通过使用质量数，化学式查找算法尝试根据质谱仪生成的 MS 和 MS/MS 质谱图，预测化合物
的化学式。化学式查找得分高并不一定意味着样本中的化合物是化学式查找算法所鉴定的化合
物，因为有些化学式通常会有质量匹配误差。必须小心操作，同时必须在使用化学式查找功能
识别化合物之前，先进行其他确认性测试。

注释: 不建议使用标称质量系统进行执行化学式查找。

化学式查找算法对质量准确性使用红绿灯设置。红色的 ppm 误差得 0 分，完美匹配得 100
分。

MS 质谱对最终的化学式查找评分的贡献是 67%，MS/MS 质谱的贡献是 33%。因此，化学式
预测 MS 质量的能力是影响评分的主要因素。然而，MS/MS 碎片的匹配也会影响评分。

同位素模式用于生成所发现化学式的列表，但它不用于生成最终评分。因此，同位素模式错误
的化学式可能不包含在列表中。

可能化学式的列表使用前体离子质量准确度、同位素模式和 MS/MS 碎裂进行确定。建议化学
式根据前体离子质量准确度以及匹配碎片的平均 MS/MS 质量准确度进行评分。

积分
在定量或定性分析中，积分指的是为关注化合物生成色谱峰面积或高度。处理方法包含处理数
据所需的所有信息。

给定样本集的定量或定性信息汇编构成所谓的 Results Table。请参阅 Results Table。

该软件有三个可以使用的积分算法：

• MQ4：选择的是一个默认为分析运行代表样本的低浓度（但不是最低浓度）标准物或质量
控制样本。
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• AutoPeak：选择的是一个默认为分析运行代表样本的高浓度（但不是饱和浓度）标准物或
质量控制样本。

• Summation：不执行正常的峰搜索，但假设峰出现在预计保留时间附近。

对于上述算法漏掉的峰，也可以手动求取其积分。

AutoPeak 积分算法参数

以下参数用于识别和报告所关注的峰。

关于可用参数的完整列表，请参阅帮助系统。

• 局部峰基线：与根据整个色谱图计算基线不同，该软件可评估峰周围基线的局部改变。

• 线性峰基线：与峰下面的基线可能表现为非线性形式的情况不同，该软件可在一组特定峰
的起点和终点之间进行线性拟合。

饱和校准：当算法检测到某个峰已饱和时，如果此时检测器未饱和，则会运用该模型来预测峰
的形状。这样就会使峰的轮廓超过峰的最顶端，直到所能达到的响应高度附近。它可以扩大校
准曲线的线性动态范围。只有在设置总体算法默认值而且不在创建处理方法或检查各个峰的时
段内，该选项才可用，因为仅对某些峰使用该设置是没有用的。

Minimum Signal/Noise
如果最小信噪比被设为 7，如下图中的左图所示，则不会报告峰。如果最小信噪比被设为 2，
如右图所示，则会报告峰。参数并不影响积分。

图 A-4 S/N 阈值

置信度阈值

该参数用于过滤潜在的假阳性峰。默认值为 50%，通常情况下是适宜的。不过，对于噪声较
大的数据或者不同样本间峰宽度差异较大的数据，用户可能希望使用更大的值。

下面的两个图显示了 Confidence Threshold 对峰的识别数量有怎样的影响。如果
Confidence Threshold 设为 50%，带有一点肩部的峰被识别为一个峰。如果 Confidence
Threshold 降低到 16%，则 SignalFinder 算法将找到两个峰。在两个峰的区域画框，查看两
个峰。
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要确定一个峰当中是否可能存在其他峰，以及 Confidence Threshold 是否正确，可按住
Ctrl，然后将所关注的峰区域画入框中。这样可以自动降低 Confidence Threshold，以反映
第二个所关注的峰，这个峰在 Confidence Threshold 被设为 50% 时是不存在的。

图 A-5 50% 置信度

在 16% 的置信度下发现了两个峰。在峰区域画框，找到两个峰.

图 A-6 16% 置信度

图 A-7 置信度阈值参数
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局部与全局峰基线

峰基线可以是局部的，也可以是全局的。如果选中局部选项，定量软件就会以局部方式评估基
线的变动。全局选项将整个色谱图用作基线。

有关显示应在何时使用局部基线的示例，请参阅下图。左图是一个用局部基线经过恰当积分的
色谱图。右图是同一个用全局基线经过不恰当积分获得的色谱图。

图 A-8 使用全局基线

线性与非线性峰基线

峰基线可以设为线性或非线性。非线性选项用来预测每一个峰之下的基线。线性选项可以在特
定峰组的起点和终点之间作出一根拟合线。有关共同洗脱峰线性和非线性基线的示例，请参阅
图 A-9 和图 A-10。第 1 项至第 4 项是卷积峰。第 5 项显示由不同选项得出的基线。

对多个峰建议使用非线性基线。对单个峰而言线性和非线性基线之间的差别并不显著。
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图 A-9 线性基线示例

工作原理—软件

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统
172/301

软件用户指南
RUO-IDV-05-7560-ZH-I



图 A-10 非线性基线示例

MQ4 积分算法参数

以下参数用于识别和报告所关注的峰。关于可用参数的完整列表，请参阅帮助系统。

噪声百分比

该参数用于估计色谱图中的噪声水平。强度最小的数据点的指定百分比被假定为噪声。

典型值的范围为 20% - 60%。如果在有较大峰存在的情况下不能发现小的峰，就应当降低噪声
百分比。下图显示了一个有极大峰存在情况下的小峰的例子。当噪声百分比被设为 90% 时，
该峰未被找到，但当噪声百分比被设为 40% 就能找到。
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图 A-11 关注峰

在下面的图中，左图显示噪声百分比被设为 40%。右图被设为 90%。

图 A-12 噪声水平

Baseline Subtract Window
在经过平滑计算但尚未进行其他处理时，色谱图的基线会作减法计算，以消除数据中的隆起部
分。对于每一个数据点来说，基线是用当前强度最小的点（在减除窗口内）的左右两侧的数据
点计算出来的。

该参数值确切是多少并不重要，只要该值在设置时至少是预计峰宽度的数倍即可。

下图中，左侧的图显示了设为 0.1 分钟的基线减除窗口，右侧的图显示了设为 1 分钟的基线减
除窗口。
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图 A-13 基线减除窗口

峰分离

该参数用于控制潜在的噪声峰是作为一个峰还是两个或多个单独的峰对待。如果两个潜在峰之
间的空隙小于指定值，则作为一个峰对待。否则就作为两个峰对待。

将该参数设为一个较大的值可以防止噪声峰被分离，并被作为两个单独的峰对待。不过，如果
有两个洗脱峰靠得很近（重叠），则需要使用较小的值。

在下图中，左侧的图显示的峰分离被设为两个点。右侧的图显示的峰分离被设为三个点。

图 A-14 峰分离

回归
在 Calibration Curve 和 Metric Plot 中，分析物峰的面积或高度与已知浓度的关系被绘制成图
表。之后用线条连接各点。回归线用于计算未知样本的浓度。
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回归方程

本部分主要介绍用于计算回归曲线的方程。在下列等式中，x 代表标准物样本的分析物浓度，
而 y 则代表相应的峰面积或高度。用于回归计算的变量取决于是否使用了内标物以及所使用的
峰面积或高度是否如下表所示。

表 A-1 回归变量

是否使用了内标
物？

是否使用了面
积？

x y

是 是 Ca / Cis / DF Aa / Ais

是 否 Ca / Cis / DF Ha / His

否 是 Ca/ DF Aa

否 否 Ca/ DF Ha

其中：

• Ca = 实际分析物浓度

• Cis = 内标物浓度

• DF = 稀释系数

• Aa = 分析物峰面积

• Ais = 内标物峰面积

• Ha = 分析物峰高

• His = 内标物峰高度

加权类型

下表显示的是七种加权类型中的加权系数 (w) 是如何计算的。

表 A-2 加权类型

加权类型 权重 (w)

无 始终是 1.0。

1 / x 如果 |x| < 10-5，则 w = 105。否则，w = 1 / |x|。

1 / x2 如果 |x| < 10-5，则 w = 1010。否则，w = 1 / x2。

1 / y 如果 |y| < 10-8，则 w = 108。否则，w = 1 / |y|。

1 / y2 如果 |y| < 10-8，则 w = 1016。否则，w = 1 / y2。

ln (x) 如果 x < 0，则会报错。如果 x < 10–5, 则 w = ln 105，否则 w = |ln (x)|。

ln (y) 如果 y < 0，则会报错。如果 y < 10-8，则 w = ln 108，否则 w = |ln (y)|。
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相关系数

在回归等式中，x、y 和 w 的定义和前面一样。所有求和计算都是针对全部标准物样本，被标
注为未使用的标准物样本除外。

相关性系数的计算如下：

其中：

•

• yc = 使用回归类型的适当等式计算的 Y 值

•

回归类型

Analytics 工作区中提供有以下回归类型：

• 平均值（仅限 Metric Plot 窗格）

• 中位值（仅限 Metric Plot 窗格）

• 线性 (y = mx + b)

• 过零点线性 (y = mx)

• 平均响应因子

• 二次 (y = a2 + bx + c)

• 幂

• Wagner

• Hill

注释: Calibration Curve 窗格内的 Regression Options 对话框中的 Remove outliers
automatically from the calibration curve 选项会将自动离群值删除规则自动应用到选定的相
关成分。请参阅帮助。

Linear (线性回归)
线性校正等式为：

y = mx + b

斜率和截距的计算方式为：
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其中：

过零点线性

过零点线性的校准等式是：

y = mx

斜率的计算方式是：

平均响应因子

平均响应因子校准等式为：

y = mx

这与线性过零点校准用的是相同的等式。不过斜率的计算方式不同：

响应因子的标准差则是：

其中：

注释: X 值为零的点不予求和。

如果在点连线上有一些直线，有一些曲线，则应使用幂回归而非线性或二次回归方式在这些拟
合点之间的某处产生连线。

二次

二次校准等式如下所示：

y = a2x2 + a1x + a0

多项式系数的计算如下：

a2 = (b2/b0 - b5/b3) / (b1/b0 - b4/b3)

a1 = b5/b3 - a2b4/b3
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其中：

幂

幂函数校准等式为：

y = axp

线性校准等式的用法如上所述，它被用于计算斜率 (m) 和截距 (b)，只不过这些等式中的 x 用
lnx 代替，而 y 则用 lny 代替。这一步完成后，a 和 p 的计算方法为：

a = eb

p = m

如果有任何 x 或 y 值为负或零，软件就会报告错误。

Wagner
Wagner 校准等式为：

ln y = a2 (ln x)2 + a1 (ln x) + a0

按照上文所述使用二次校准等式来计算 a0、a1 和 a2，但这些等式中的 x 将被 ln x 替换，y 将
被 ln y 替换。

如果有任何 x 或 y 值为负或零，软件就会报告错误。

Hill
Hill 校准等式为：

y = (a + bxn) / (c + xn)

不可能有分析方程能够解出 a、b、c 和 n。这些系数是用 Levenberg-Marquardt 迭代法确定
的。
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自动离群值删除
这是一项选配功能，让软件可自动从校准曲线删除离群值。这项节省时间的功能，对于线性范
围和灵敏度不同的多种化合物的应用而言比较有用。

当这项功能启用时，软件会迭代地检验所有数据点，以便确定由四个连续点组成的起始范围，
该范围能提供最佳线性回归并满足用户指定的离群值删除规则。算法针对起始点的所有排列计
算多重回归。它会考虑满足用户指定的规则的所有有效回归，并让这些所有有效的回归通过扩
展序列。对于所有有效的起始范围而言，每次扩展是否成功取决于所使用点的总数、所使用水
平的范围以及扩展之前和之后回归内具有最糟糕绝对准确度的那一点。扩展至最大范围且满足
规则的回归是“胜出”回归。

注释: 如果无法提供四个数据点，那么软件将采用三个。如果可提供的数据点少于三个，那么
将不会应用算法。

自动离群值删除的规则在处理方法中定义，包括以下内容：

• 最小相关系数 (r)

注释: 此选项采用相关系数，而非确定系数 (r2)。

• 定量下限 (LLOQ) 时标准物重复的最大允许准确度误差

• 高于 LLOQ 时标准物的最大允许准确度误差

• LLOQ 时多个标准物重复的最大变异系数 (CV) 百分比

注释: 如果 %CV 大于特定值，那么算法将按准确度误差降序删除重复，直到剩余重复的
%CV 小于该值。

• 高于 LLOQ 的所有水平时多个标准物重复的最大 CV 百分比。

注释: 如果 %CV 大于特定值，那么算法将按准确度误差降序删除重复，直到剩余重复的
%CV 小于该值。

• 指定的离群值总数是否不包括低于 LLOQ 和高于定量上限 (ULOQ) 的离群值

• 可为某一浓度水平删除的离群值最大数

• 可从校准曲线中删除的离群值总数

注释: 此算法适用于所有标准，包括那些手动排除的标准。

注释: 如果用于生成回归的重复次数对于每个标准物水平有所不同，自动离群值删除无法完美
运行，只能作为起始点使用。手动检查每个校准曲线。

提示! 请确保处理方法 Acceptance Criteria 中的标准物准确度公差阈值与 Rules for
Automatically Removing Outliers for Calibration Standards 对话框中的公差阈值相匹配。
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Results Table
Results Table 收集了与一组样本相关的定量和定性信息。表中包括内插标准物校准曲线后确
定的浓度和准确度计算值。谱库搜索结果、化学式查找结果以及其他定性分析结果也在
Results Table 中提供。可显示面积、高度和其他数量特征。为便于查看，可对 Results Table
中列的数量和类型进行编辑。

校准曲线
校准曲线（也被称为标准浓度曲线）是一种通过将未知样本与一组已知浓度的标准物样本进行
比较，来确定未知样本中物质浓度的方法。校准曲线是一种仪器（的分析信号）如何响应分析
物（待测量的物质）浓度变化的图表。用户可以准备一系列标准物，其浓度范围接近未知样本
中分析物的预计浓度。

校准标准品用于建立校准曲线。有些校准样本的错误读数或缺失的读数可能会指出分析运行中
存在的问题。遵循文献和监管机构指南中找到的可接受方法来创建校准曲线。制作校准曲线时
的良好做法示例包括：

• 在要测量分析物的空白基质中制备校准标准物。

• 为每个要测量的分析物生成校准曲线。

• 确保涵盖预期分析物浓度范围，包括典型和非典型标本。

• 使用六到八个标准物来生成曲线。

这不是详细一览表，在确定制定实验室校准曲线的最佳做法时还应使用其他指南。

注释: 一些分析运行中使用单点校准标准物。通过基质空白样本和单个标准物浓度可进行单点
校准。仪器反应和分析物浓度之间的关系可通过由这两个点确定的直线确定。将采集方法和处
理方法用于其预期用途前，这两个方法都应进行验证。

信噪比
当执行定量质谱数据处理时，一定要确定某个峰是否显著，而显著通常是指超过了背景噪声。

相对噪声和信噪比计算

通常峰高度要与无峰区域测量的背景噪声进行比较，这些地方的噪声通常以该范围数据点标准
差的 1 倍或 3 倍进行估算。这种方法不甚理想的原因有：

• 它是主观的，因为噪声区域是手动选择的。

• 没有峰的背景区域可能不存在，或者该区域可能过窄，无法准确估计噪声。

• 峰位置处的噪声可能与选定噪声区域的噪声有很大不同。

• “1 倍或 3 倍”的系数也是主观的，而且不同权威人士给出的推荐也不同。

• 如果数据已经预先经过处理，明显的噪声可能会受到改变。比如，被平滑或被限制范围。

通过运用相对噪声 (Rn) 的概念，可以很容易找到一种简单的方法来计算任何数据点处的预计
噪声，以便与测量得到的信号进行比较。这是一种实实在在且客观的量度，可以用来计算信噪
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比 (S/N) 以及评估和比较仪器及测定方法的性能。相对噪声的概念有很多用途，其中之一就是
计算 S/N。

基本算法如下：

1. 设计一种噪声模型，使用户能够在数据点的基础信号水平给定的情况下，计算数据记录中
任何点位置的预计噪声。

噪声模型可以从理论角度来确定，也可以通过对某个系统的实际测量来进行建模。对于脉
冲计数检测器来说，信号的标准差，也就是预计噪声，是与信号的平方根成正比的，因而
会随着信号变化。在其他系统中，有一个始终存在的“白色噪声”成分，它可能与某个和强
度有关的成分结合在一起。

2. 要根据测量信号来估计基础信号。

此任务可以通过多种方式来实现，但最简单的方法是生成一个经过平滑的数据。请参阅
图：图 A-15。

图 A-15 原始和平滑数据的叠加

3. 用所有点（峰和背景）测量数据范围内的实际噪声。

通过从每个数据点测得的信号中减去基础信号估计值，并从该点的原始信号中减去平滑信
号，便可以得到结果。此结果就是所谓的 delta 噪声。delta 噪声的范围基本上是恒定的，
除了最大峰所在的位置，因为噪声要取决于信号，因而信号强的地方噪声也大。请参阅
图：图 A-16。

图 A-16 每个数据点的 delta 噪声值图表

4. 在每一个数据点计算测量噪声与预计噪声的比率。
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也就是说，在每一个数据点，我们都要用步骤 3 中测得的噪声值除以噪声模型的预测值，
在本例中为强度的平方根。如果噪声模型较好，软件会生成一系列的值，其绝大部分都在
极限范围内。请参阅下图。此图还显示了图表

注释: 此步骤减小了 delta 噪声中的较大差异，从而产生了差异范围较小的数值集合。

图 A-17 噪声模型

5. 计算比值的标准差。即 Rn，是实际 delta 噪声和模型预测噪声之间最接近关系的预测值。
在前面的图中，这样得到的值为 9.5。

下面的图显示了如何用相对噪声计算 S/N 的一个例子。

图 A-18 原始数据、基础信号估计值和基线估计值的叠加

如前文所述：

在本示例中：
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如果用峰的最高点作为信号，则 S/N 为 34 (4900/145)，如果用平滑信号的高度，则 S/N 为
22 (3150/145)。

报告 S/N 时，MQ4 积分方法采用的是本文所述的程序，而且以峰的最高点为信号。由于
AutoPeak 积分算法是用模型来拟合峰的，它所使用的是拟合轮廓的高度。这样得到的 S/N 较
小。不过，这个值要更为准确，因为它受可能的噪声尖峰的影响较小。AutoPeak 积分算法还
有一种更为复杂的基线估算方法，基于这两个原因，两种算法所报告的 S/N 值并不相同，尽管
它们通常较为类似。

总而言之，相比以背景区域的标准差来估算噪声的常用方法，用相对噪声计算 S/N 的方法有以
下优点：

• 主观性小，因为无需手动选择背景区域。

• 预测的 S/N 较为准确，即使色谱图上不存在无峰区域。

• 对于 AutoPeak 和求和积分算法，估算的基线及噪声靠近所关注的峰。对于 MQ4 积分算
法，基线是用户指定噪声百分比处的数据点的强度。例如，如果用户指定噪声百分比为
40%，有 100 个数据点，则 MQ4 积分算法按照从最小到最大强度对数据点进行排序，使用
强度为第四十的数据点的强度。

这样会使得所报告的 S/N 值有很大差异，因为常用方法所选择的背景区可能比靠近峰的背
景区噪声小。如前文所述，用相对噪声法计算得出的 S/N 比常用方法所得出的值更小。不
过，它们要更加准确，而且更有用。请参阅图 A-18。

若要使 Signal / Noise 列在 Results Table 中可见，请参阅#unique_160。

使用 AutoPeak 积分算法时的信噪比注释

由于 AutoPeak 积分算法对信噪比的计算更精确（因此对 CV 预测也更精确），如果采用了 1-
sigma 信噪比方法，就要根据实验室的经验数据适当降低标准操作规程 (SOP) 可接受的最小
信噪比值。

峰-峰信噪比

如采用这种信噪比算法，则软件通过考虑指定背景开始时间和背景结束时间之间的所有色谱数
据点的标准差计算信噪比。该软件计算活动色谱图的信噪比，从选定峰减去平均背景信号，然
后用所得差值除以峰-峰噪声水平。再根据各区域的最大强度区分噪声和峰区域。完成后，活
动色谱图被标记上信噪比。

使用标准差的信噪比

使用这种信噪比算法时，软件计算色谱峰信噪比并进行标记。此算法需要在色谱图上选择两个
区域：

• 噪声区域

• 所关注的峰

然后，软件可根据各选择中的最大强度确定包含峰的区域以及包含噪声的区域。从峰信号强度
减去平均背景信号强度，然后用所得差值除以用户指定的系数再乘以该噪声区域的标准差。
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定义噪声区域

如果使用标准差或峰-峰算法，则使用此程序定义噪声区域。

注释: 在 Results Table 中只能使用一种信噪比算法。要对数据应用不同的信噪比算法，更改项
目默认设置，然后创建新 Results Table。

1. 在项目默认设置中，选择 Standard Deviation 或 Peak-to-Peak 信噪比算法。

提示! 要打开项目默认设置，请单击 Projects > Project default settings。

2. 创建处理方法。

3. 在 Integration 页面上，单击 Options > Show Noise Regions。

4. （如有必要）使用鼠标调整噪声区域。

注释: 必须为每个离子对设置噪声区域。

5. 处理数据。

6. 在 Peak Review 窗格中，单击 Options > Show Noise Regions。

7. （如有必要）使用鼠标调整噪声区域。

计算列
计算列是用于产生将添加到 Results Table 的新自定义列的公式。创建公式并处理（或再处
理）数据后，公式的结果显示在新的自定义列中。

导航计算列界面

计算列在处理方法中创建。它们可以作为 frml 文件导入和导出，以供随后使用或共享。

下图显示了公式编辑器的界面。
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图 A-19 计算列 UI

项目 描述

1 处理方法的工作流中的 Calculated Columns 步骤。单击此处打开
Calculated Columns 页面。然后单击 Add Formula（未显示）。

2 Formula name 字段。键入公式的名称。

注释: 公式名称不能包含计算器上的函数名称、方括号或圆括号。

3 Formula 字段。

4 包含常用函数和运算符的计算器。下列附加运算符可在公式字段中键入：
• >（大于）

• >=（大于等于）

• <（小于）

• <=（小于等于）

• !=（不等于）

有关这些运算符和函数的更多信息，请参阅帮助系统。

5 可用的回归参数和 Results Table 列。

注释: 此列表在 qsession 表格中不可用。

6 Treat resulting text values as 菜单可供用户配置如何处理文本条目。此
选项在可能同时包含数字和文本输出的 Results Table 列中非常重要。

例如，计算所得浓度列可能包含数值以及非数值，例如 N/A、简并和无
穷。

注释: 当用户开始键入使用一组样本的公式时，样本选择项变为可用状态。
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非默认信息的简单提取

计算列功能可供用户显示默认情况下在 Results Table 中不可用的信息。

例如，要将 R2 显示为 Results Table 中的列，用户可以创建一个等于 R2 的公式。

图 A-20 使用计算列创建自定义列

简单算术

可以创建简单公式以执行基本数学运算。

示例：R2

[r]*[r]

在本示例中，利用乘法算子 (*) 将 R 乘以 R 来重现 R2 值。

示例：每秒采集的点数

[Points Across Baseline]/(([End Time]-[Start Time])*60)

在本示例中，基线涵盖的点除以从积分色谱峰起点到终点的秒数。此公式使用除法 (/)、乘法
(*) 和减法 (–) 运算符。
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更复杂的函数

存在许多其他函数和控制结构。其中一些常见的包括 MEAN()、MAX() 和 MIN()，显示在计算
器中的公式栏下。

关于句法详细信息、运算符和函数的完整列表，请参阅帮助系统。

示例：用于标准物的 MEAN([Area])

使用对所有值运行的函数时，用户可以选择要纳入计算中的样本。

图 A-21 仅获取标准物样本的峰面积平均值

示例：组合函数

简单算术和更复杂的函数可以组合使用。例如，为了计算每秒采集的平均点数，可以使用以下
公式：

MEAN([Points Across Baseline]/(([End Time]-[Start Time])*60))

IF 语句

IF 函数执行逻辑测试并为 true 结果返回一个值，为 false 结果返回另一个值。嵌套 IF 函数可
用于测试多个条件。IF 函数可与其他逻辑函数（例如，and 和 or）组合，以扩展逻辑测试。

注释: “&&”和“||”分别可用于 and 和 or。and 和 or 运算符必须被空格包围，但 && 和 || 运算符
不需要。

基本 IF 语句的句法如下：

if(<condition>;<value if true>;<value if false>)
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• <condition> 是可评估为 true 或 false 的值或逻辑表达式。

• <value if true> 是待返回的值，当 <condition> 评估为 true 时显示在相应的 Results Table
列中。

• <value if false> 是待返回的值，当 <condition> 评估为 false 时显示在相应的 Results Table
列中。

注释: IF 函数符号可以从计算器选择、键入或从其他源复制。它可用于 if 或 IF 句法。

IF 函数允许将其他数值函数，例如 MEAN、STDEV 等，用于公式中以及 <condition>、
<value if true>或 <value if false> 表达式中。

示例： <condition>

一些 <condition> 示例包括：

[Peak Area]>5000

[Component Name]='Analyte 1'

[Retention Time]> 1 and [Retention Time]<2

示例： <value if true> 和 <value if false>

<value if true> 和 <value if false> 可以是数值或文本。

if([Retention Time]> 1 and [Retention Time]<2; '1-2 min RT 
window'; 
'not applicable')

示例：内标面积的平均值

在本示例中，在所需的样本中计算内标 (IS) 面积的平均值，并与值 1e6 进行比较。如果
MEAN ([IS Area]) 大于 1e6，平均 IS 面积值显示在相应的 Results Table 列中，该条件表示
如果 <condition> 为 true。如果 MEAN ([IS Area]) 小于 1e6，即如果 <condition> 为 false，
则 Results Table 列包含 Review IS performance， <value if false>。

IF(MEAN([IS Area])>=1e6;'MEAN([IS Area])';'Review IS performance')

注释: 只有 IF 函数能够包含多个计算。

Treat Resulting Text Values As
Treat resulting text values as 选项决定在包含文本或数字和文本组合的自定义 Results
Table 列中如何解读文本。例如，Sample Type 列仅包含文本，Precursor Mass 列仅包含数
值，Calculated Concentration 列可同时包含数值和文本。

根据公式中使用的函数，Treat resulting text values as 选项可对计算所依据的列中的文本值
进行特定解读。可用选项包括：
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• Zero

• Ignore (blank)

• Error (N/A)

• Original text

注释: 有关这些选项的更多信息，请参阅帮助系统。

如果计算基于 COUNT、MAX、STDEV、SUM、MIN、MEDIAN、GET、GETGROUP、
SLOPE、INTERCEPT、MAD 或 GETSTAT 函数，则推荐的选项为 Zero、Ignore (blank) 或
Error (N/A)。当公式中包含预计会有数值的列时，也推荐在 IF 语句中使用这些选项。

Original text 是此类 IF 语句的推荐选项： <condition>、 <value if true>和 <value if false> 表
达式可能同时包含数值和文本，尤其是在使用其他函数时。

注释: 如果 IF 语句包含多个 <condition>，未能评估任何一个 <condition> 都会在自定义
Results Table 列中产生 <value if false> 输出。

示例

在本示例中，公式中使用的列可能同时包含文本和数值。因此，建议使用 Original text 选
项。

IF([Sample Type]='Unknown'&&(GET([Calculated Concentration];
'Analyte 1')+GET([Calculated Concentration];'Analyte 2'))<=15;
'Low Range';IF([Sample Type]='Unknown'&&(GET([Calculated 
Concentration]
;'Analyte 1')+GET([Calculated Concentration];'Analyte 2'))
<=65;'Normal Range';'Over normal range'))

此 IF 公式同时包含 Sample Type 和 Calculated Concentration 列。Sample Type 列中的值
应处理为 Original text。对于 Calculated Concentration 列，可能需要将 <0 和 Degenerate
之类的非数值处理为 Zero。

由于非数值必须以不同的方式处理，因此建议用户将该公式拆分成多个更小的公式，以更精细
地控制非数值。
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校准通过触点闭合配置的系统 B
如果在系统上配置了触点闭合，则可用于在批次和手动模式下校准系统：

• 批次模式：可通过 CDS 或液相色谱方法校准系统。请参阅批次模式下校准系统。

• 手动模式：可通过 CDS 或液相色谱方法校准系统。单击 StartMS MethodStart with LC 工
作区的 或 开始方法。当状态更改为 Load 时，则 LC 设备上便开始进样。

注释: MS Tune 工作区不支持触点闭合功能。MS 调谐不会等待触点闭合信号。

批次模式下校准系统
使用 CDS 或液相色谱方法校准系统。

使用 CDS 校准系统

如果系统采用触点闭合与外部设备通信，则请遵循以下指南采用 CDS 校准系统：

• 配置 Auto-Calibration 属性，包括校准之间的样本数量。

• 同步液相色谱系统与质谱仪上的方法，以便有时间在样本之间进行校准。以下部分介绍了
执行上述操作的两种不同选项。

• 提交批次之后，等待初始校准完成，然后，当系统转为 Loading 状态时，在外部设备上开
始进样。

Option 1
要同步液相色谱系统与质谱仪，请确保液相色谱方法至少比质谱仪方法长两分钟。

以下示例显示了 SCIEX OS 中的批次和队列，以及外部设备上针对每三份样本后执行校准的
批次的相应计划。
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图 B-1 CDS 校准：示例批次

图 B-2 CDS 校准：示例队列

表 B-1 外部设备上的样本序列

时间 (mm:ss) 进样

00:00 样本 1

12:00 样本 2

24:00 样本 3

36:00 样本 4
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表 B-1 外部设备上的样本序列 (续)

时间 (mm:ss) 进样

48:00 样本 5

60:00 样本 6

Option 2
该选项适用于短时液相色谱方法。

请按照该等指南，同步 LC 系统与质谱仪：

• 对于除批次中第一个以外的所有校准，请配置外部设备，以便在计划进行校准时进样一份
空白样本。例如，如果在校准之间需要三份样本，那么请确保每个第四次进样为空白样
本。

• 请确保外部设备上的空白样本运行时间为 2 分钟或更长。（CDS 校准耗时 2 分钟。）请确
保方法持续时间少于或等于进样之间的时间。

以下示例显示了 SCIEX OS 中的批次和队列，以及外部设备上针对每三份样本后执行校准的
批次的相应计划。

图 B-3 CDS 校准：示例批次
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图 B-4 CDS 校准：示例队列

表 B-2 外部设备上的样本序列

时间 (mm:ss) 进样

00:00 样本 1

02:00 样本 2

04:00 样本 3

06:00 空白

08:00 样本 4

10:00 样本 5

12:00 样本 6

使用液相色谱系统校准系统

如果系统采用触点闭合与外部设备通信，则请遵循该等指南采用外部设备校准系统：

• 在质谱仪的属性里，配置一个阀模拟外部设备。

• 为这个阀创建一个液相色谱方法。

• 请确保方法持续时间少于或等于外部设备上进样之间的时间。

• 配置批次的 Auto-Calibration 属性：选择离子参考表并设置校准频率。对于 Calibrant
delivery，请为阀选择液相色谱方法，对于 MS method，请选择要使用的质谱方法。
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图 B-5 液相色谱校准：Automatic Calibration Editor

注释: 确保为参考表中的每种肽输入一个保留时间。

• 提交批次并开始队列。请确保队列中的条目符合外部设备上计划中的条目。

• 在外部设备上开始进样。

以下示例显示了 SCIEX OS 中的批次和队列，以及外部设备上针对每三份样本后执行校准的
批次的相应计划。质谱方法的持续时间为 1 分钟。校准方法的持续时间也为 1 分钟。

图 B-6 液相色谱校准：批次

校准通过触点闭合配置的系统
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图 B-7 液相色谱校准：队列

表 B-3 外部设备上的样本序列

时间 (mm:ss) 进样

00:00 校准物

01:00 样本 1

02:00 样本 2

03:00 样本 3

04:00 校准物

05:00 样本 1

06:00 样本 2

07:00 样本 3

手动模式下的校准
本部分介绍了当在 MS Method 工作区手动运行方法时如何使用触点闭合来校准系统。

通过 CDS 校准系统

1. 在 MS 方法工作区，打开要运行的方法。

2. 单击 Advanced > Calibrate。

3. 在 Ion Reference Table 字段，选择 X500 Positive Calibration Solution 或 X500
Negative Calibration Solution，具体视方法的极性而定。
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4. 选择 Apply Calibration。

5. 单击 OK。

6. 单击 Start。

使用液相色谱方法校准系统

如果系统采用触点闭合与外部设备通信，则请遵循该等指南采用外部设备校准系统：

• 在质谱仪的属性里，配置一个阀模拟外部设备。

• 创建一个包含一个阀的液相色谱方法，并让持续时间少于或等于质谱方法的持续时间。

1. 在 MS 方法工作区，打开要运行的质谱方法。

2. 单击 Start with LC 并选择液相色谱方法。

3. 当系统状态更改为 Loading 时，开始在液相色谱设备上进样。

校准通过触点闭合配置的系统
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精确质量和化学式 C
利血平

表 C-1 利血平精确质量 (C33H40N2O9)

描述 质量

分子离子 C33H41N2O9 609.28066

碎片 C23H30NO8 448.19659

碎片 C23H29N2O4 397.21218

碎片 C22H25N2O3 365.18597

碎片 C13H18NO3 236.12812

碎片 C10H11O4 195.06519

碎片 C11H12NO 174.09134

肽 ALILTLVS

表 C-2 肽 ALILTLVS 精确质量

名称 序列 质量 电荷状态

前体离子 ALILTLVS 829.5393 1+

b8 ALILTLVS 811.5288 1+

b7 ALILTLV 724.4967 1+

b7-18 ALILTLV 706.4862 1+

b6-18 ALILTLV 607.4178 1+

y5 LTLVS 532.3341 1+

b5 ALILT 512.3443 1+

b5-18 ALILT 494.3337 1+

b4 ALIL 411.2966 1+

b3 ALI 298.2125 1+

内部碎片 y|b IL 或 LI 227.1754 1+

内部碎片 y|b LT 或 TL 215.139 1+

b2 AL 185.1285 1+

a2 AL 157.1335 1+
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表 C-2 肽 ALILTLVS 精确质量 (续)

名称 序列 质量 电荷状态

亚胺离子 I 或 L 86.09643 1+
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Explorer 教程 D
介绍
本文件针对软件的部分工具和可用功能提供了教程概述。 但是，本文件不对每个可用操作提
供详细描述，只是对软件可处理的一些常用工作流做出了解释。

机构

尽管有些功能和操作是专用于特定应用和工作流的，但是大部分还是通用的，而且常常用于研
究定性数据。本节中对软件概念进行简要介绍，并对部分最常用的基础操作做了描述。随后的
章节描述了特定工作流程的方法并会用到随软件提供的样本数据文件。

样本文件位于 SCIEX OS resources 项下的 sciex.com/software-support/software-
downloads。将整个项目复制到计算机上的 D:\SCIEX OS DATA 文件夹中。下述样本文件用

于本教程所用的示例中：

• Bromocrip_IDA-DBS alone_T=1.wiff

• Bromocrip_IDA-DBS in plasma_T=0.wiff

• Bromocrip_IDA-DBS in plasma_T=1.wiff

• DataSET61.wiff

• DataSET62.wiff

• DataSET63.wiff

• DataSET64.wiff

• DataSET65.wiff

• DataSET66.wiff

• RP_digests.wiff

• RP_Intact.wiff

• Bromocriptine.mol

溴隐亭文件来自于对鼠肝微粒体温育的负极性 IDA 分析。Bromocrip_IDA-DBS alone_T=1.wiff
是在一小时点处获得的，而其他两个是在零小时和一小时时间点处上升为等离子体。
Bromocriptine.mol 文件中包含溴隐亭的分子结构。DataSET61 至 DataSET66 文件是关于氯
雷他定及其杂质的。不同数据集代表不同的浓度水平。RP_Intact.wiff 文件来自于对完整肌红
蛋白的分析。RP_digests.wiff 文件来自对消化后的肌红蛋白的分析。

选项

软件可提供很多用于微调命令表现方式的选项。 如图 D-1 所示，有些可提供一个复选框，允
许对话框只在 Shift 键被按下时才显示。 这可以消除不要求更改参数时与对话框交互的需要。
这些命令所在菜单中含有一个向上的箭头。
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图 D-1 选项

窗格

当软件使用窗口来显示和接收信息时，基本用户界面组件就是窗格。 一个窗口中可能含有一
个或多个窗格，但是一次只能有一个窗格处于活动状态。 窗格接收来自菜单和工具栏的命
令。 菜单和工具栏提供操作窗格或窗格内所含数据的方式。

窗格内可能含有各种图，如：质谱图和色谱图、热图，或各种表格以及更专业化的视图。 典
型的处理操作既可以创建用于显示信息的窗格，也可以处理窗格内显示的数据。 每个窗格都
含有通用的单窗格和双窗格工具。 大部分窗格都有特定于窗格类型的附加工具。 通过附加工
具可获取更多通用命令。

常见窗口示例如图 D-2 所示。 这个窗口中含有两个窗格，其中活动窗格，即：色谱图，可通
过彩色边框和工具栏来识别。
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图 D-2 窗口内的窗格示例

常见窗格操作总结见通用窗格工具栏和双窗格工具栏。 特定窗格操作总结见图。

通用窗格工具栏

单击图标以使用通用单个窗格操作。

表 D-1 通用窗格工具栏图标

图标 名称（工具提示）

删除窗格

展开活动窗格填充窗口

隐藏窗格

隐藏所有其他窗格

显示当前隐藏的所有窗格

删除所有其他窗格（按住 Ctrl 键，可只删除该窗格之后的窗格）
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注释: 主菜单栏下面的主工具栏中还有可用的类似图标。 单击主工具栏中的任一图标与单击活
动窗格中的图标对活动窗格具有相同的作用。 如果活动窗格已重调大小，且有些图标已不
见，那么该工具栏非常有用。

删除窗格

如果有多个窗格打开，则应通过这个图标删除相应窗格。如果只有一个窗格打开，则该图标不
可用。

展开活动窗格填充窗口

通过这个图标扩大窗格并填充整个窗口，或将窗格恢复至其原始大小。 如果该窗口包含多个
窗格，那么这个图标会暂时聚焦于其中之一。

对于每一个窗格会有一个独立的选项卡出现在窗口顶部。 通过单击恰当的选项卡来在窗格之
间切换。

注释: 如果窗格的标题较长，那么可能不是所有的选项卡都可见。 使用选项卡右面的箭头按钮
来滚动这些选项卡。 再次单击图标可返回原视图，显示所有窗格。

图 D-3 展开窗格示例

隐藏窗格

通过这个图标可隐藏相应窗格，这样窗口内的其他窗格可填充可用空间。 如果用户想查看一
个窗格子集，但不想永久删除其他窗格，该图标非常有用。

隐藏所有其他窗格

通过这个图标隐藏除相应窗格以外的其他全部窗格。 具体效果与单击“展开活动窗格填充窗
口”图标的效果类似，这是因为这两种情况下都只保留了相应的窗格并填充了可用空间。当接
下来再创建另一窗格时，不同之处就很明显了。 在展开窗格案例中，新窗格成为活动窗格并
填充可用空间。 在隐藏窗格案例中，两个窗格（原活动窗格和新窗格）都可见。

Explorer 教程

软件用户指南
RUO-IDV-05-7560-ZH-I

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统

203/301



显示当前隐藏的所有窗格

通过这个图标显示已隐藏的所有窗格。

删除所有其他窗格

如果未按下 Ctrl 键，那么这个图标将删除窗口内除相应窗格以外的所有窗格。清除和再处理样
本时，该选项很有用。当前隐藏的窗格也会被删除。

如果按下 Ctrl 键，那么只有相应窗格后面的窗格才会被删除。当有很多窗格打开，但是只要求
特定数量的初始窗格时，该选项很有用。这种情况下，隐藏窗格不会被删除。

双窗格工具栏

拖动图标，使用双窗格操作（是否可用取决于窗格类型）。 源窗格是指含有选定图标的窗
格，目标窗格是第二个窗格。

表 D-2 双窗格工具栏图标

图标 名称（工具提示）

拖放以重新安排窗格。

拖动至另一图，以将活动数据添加至另一图的活动数据中。（按住 Ctrl 键，将数
据添加至另一图内的所有数据集中。）

拖动至另一图，以将活动数据从目标图的活动数据中减除。（按住 Ctrl 键，从目
标图的所有数据集中减除。按住 Shift 键，以保持负值。）

拖动至另一图，以在目标图内叠加活动数据。 （按住 Ctrl 键，叠加所有数据集，
而不仅仅是活动数据。）

拖放以重新安排窗格

这个图标位于各个窗格的右上角，可用于改变窗格的相对位置。 单击一个窗格中的图标，然
后将其拖动至第二个窗格的顶部、底部、左侧或右侧部分。 根据鼠标释放的位置不同，第一
个窗格相对于第二个窗格的位置改变。当拖动光标时，第二个窗格的一侧红色高亮，以指示第
一个窗格将要放置的位置。图 D-4 显示将该图标从顶部窗格拖动至底部窗格右部后的结果。

图 D-4 将该图标从顶部窗格拖动至底部窗格右部后的结果。
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注释: 将窗格从一个窗口拖动至另一个窗口。

拖动至另一图，以将活动数据添加至另一图的活动数据中

通过这个图标可将两个数据集逐点加在一起。 （来自最初单击过的窗格的）源数据添加至目
标数据（图标在这个窗格中释放）中。 修改数据的标题更新，以表明已修改。

注释: 只有类型相同的两个数据集，才可添加在一起。例如，质谱图不能添加至色谱图中。

注释: 如果目标图含有一个以上的叠加轨迹，那么默认源数据只添加至活动目标数据中。 如果
按下 Ctrl 键，则源数据将添加至目标数据内的所有数据集中。

拖动另一个图，将活动数据从目标的活动数据中减除

通过这个图标从目标数据中减除源数据。 该图标对于背景减除质谱最为有用。

注释: 如果目标图含有一个以上的叠加轨迹，那么默认源数据只从活动目标数据中减除。 如果
按下 Ctrl 键，则会减除目标中所有数据集的源数据。

提示! 通常，不保留源数据内的强度大于目标数据内强度的数据点。 也就是说，不保留 Y 轴上
的负值。 如果按下 Shift 键，则保留负强度点。

拖至另一图，以叠加目标图内的活动数据

通过这个图标叠加目标图上的源图内的活动数据。 操作完成后，目标图包含一个新系列和一
份目标数据。

注释: 如果源图含有多个叠加轨迹，那么默认情况下，只有一份活动数据会移动至目标图中。
如果按下 Ctrl 键，那么源图内的所有数据集都会被叠加到目标图中。

图

图就是能实现数据可视化和交互作用的窗格。 有些操作通用于所有图，但是其他的却取决于
所示数据的类型。
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图 D-5 图

通用命令总结如下：

• 在图的 X 或 Y 轴区域内拖动光标可进行缩放和滚动。 双击可将轴重设至原始范围内，在轴
内单击，而按下 Shift 键可将图恢复至其原视图（缩放和滚动时撤销）。

• 通过拖动可定位阀值指示器。 阀值一般可确定哪个峰有标记，有时也用于确定哪些峰已经
过处理。

• 在数据区域内拖动可进行选择。 所做选择用于规定将要使用或处理的数据部分。 拖动时按
下 Shift 键可选择多个区域。 按下 Ctrl 键，确保在 X 和 Y 轴都做出选择。

图专用工具栏

表 D-3 图专用工具栏图标

图标 名称（工具提示）

将缩放图恢复至主页视图

将选择放大至全视图

显示‘缩放’图（以便跟踪当前缩放）。 请参阅图 D-6。

Explorer 教程

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统
206/301

软件用户指南
RUO-IDV-05-7560-ZH-I



表 D-3 图专用工具栏图标 (续)

图标 名称（工具提示）

为选定的峰添加箭头标记

使用百分比刻度 Y 轴

标记所有叠加轨迹

填充峰

将图的 X 轴与窗口内的其他轴（具有相同的测量单位）连接（按住 Ctrl 键可应用
至当前所有图）

切换数据以使用上一个实验

切换数据以使用下一个实验

切换数据以使用选定的实验

显示可供选择的质谱

设置背景减除范围

注释: 关于该工具栏中的最后六个图标的描述（从“删除窗格”图标）开始，见通用窗格工具
栏。

从缩放图恢复至主页视图

如果详图已缩放，则应通过这个图标恢复至主页视图，也就是说，x 轴和 y 轴都显示其默认范
围且所有可用数据都可见的视图。 在 x 轴内双击可将图恢复至主页视图。 在 y 轴内双击只能
将该轴恢复至其全范围。

将选择放大至全视图

通过这个图标可缩放线图，这样选定区域将充满整个可用空间。 选定这个图标前，在线图内
拖动并做选择。 用户也可以在线图的 x 轴（或 y 轴）内直接拖动来缩放。

显示‘缩放’图（以便跟踪当前缩放）

通过这个图标可在主图下方显示一个小的复制图，如图 D-6 所示。 这个概览图始终显示全部
可用范围并能通过粉色选定部分指出主图的缩放区域。 随着主图的缩放，该选定区域会相应
更新。

当将峰选定部分拖动至一个新位置时，主图可按需要滚动。 拖动选定部分的左或右边缘附
近，以调整其宽度。此时，主图可按需要缩放。

对于高分辨率质谱而言，这一功能很有用，这是因为经常需要很大程度地缩放以查看要求的详
情。 概览图允许用户一直跟踪相对于整个质量范围而言的缩放后区域所在位置。

Explorer 教程

软件用户指南
RUO-IDV-05-7560-ZH-I

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统

207/301



图 D-6 显示概览图

为选定的峰添加箭头标记

通过这个图标可为图中当前选定的区域内的最大峰添加箭头标记。 图 D-7 显示当选定如图所
示的（大约） 829 个峰时单击这个图标后的结果。

图 D-7 添加单个箭头标记

箭头作为数据内的参考点使用。 默认情况下，不临近箭头的峰用其与最近箭头的距离标记。
邻近箭头且 X 值最大的峰则用其实际 X 值标记。 临近箭头但不同于最后一个的峰应相对于箭
头以较高的 X 值标记。 在图 D-7 中，约 829 Da 点对应的峰用其实际 m/z 值标记，而同位素
峰则用其相对于这个峰的距离进行标记。 箭头左侧的峰（未显示出）的标记值可能为负。

箭头最常用于质谱，便于查找预期质量差异，如：同位素、MS/MS 质谱中的中性丢失等等。
图 D-8 显示的是一个肽的 MS/MS 谱图，其中箭头添加位置对应氨基酸残基的中性丢失。 例
如，标记为 99.02 的峰可能是 1050.73 Da 峰的缬氨酸丢失，而下一个标记为 114.03 的峰可
能是天门冬氨酸的附加损失，等等。 标记为 -113.08 的峰可能是相对于标记为 129.02 的峰的
亮氨酸或异亮氨酸丢失（实际 m/z 比接近 709 Da）。
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图 D-8 添加多个箭头标记

如果未使用这种相对峰标记，那么可以清除 中显示的 Use Arrows for Relative Peak
Labeling 菜单项图 D-9。此时，箭头用于标记特别感兴趣的峰。

图 D-9 添加箭头标记菜单

用户可以将箭头拖动至一个新位置。如果将箭头拖动至线图区域内，那么这会取消拖动操作。
如果用户将箭头拖至图外，那么箭头会被删除。也可选择 中所示菜单内的 Remove All
Arrows 来删除箭头图 D-9。

使用百分比刻度 Y 轴

这个图标可确定 Y 轴的刻度。 选定后，可对叠加轨迹进行测量，这样各轨迹的最大值都为
100%。 如果叠加轨迹的绝对量值非常不同，那么使用百分比刻度 Y 轴就便利很多。

标记所有叠加轨迹

默认情况下，当多个轨迹叠加在一起时，只有活动轨迹才会被标记。 单击这个图标可标记所
有轨迹。 再次单击图标，可删除所有标记，然后恢复至原视图。

填充峰

单击这个图标，用深浅填充物交替填充峰，以获取活动数据。 该功能有助于查看峰的准确起
点和终点。再次单击这个图标，取消填充并恢复至原视图。

将图的 X 轴与窗口内的其他轴（具有相同的测量单位）连接

两个或多个图的轴可连在一起，这样当一个图中的一个轴被缩放时，其他轴会自动调整，以显
示相同范围。该功能有助于比较这些图中的数据。另一种方法就是叠加相同图内的数据集。但
是，这种做法不总是我们想要的。

单击各图中的 Links graph's x-axis to others (with same units) in the window 图标以连
接。如果在单击图标的时候按下 Ctrl 键，那么与活动图在同一窗口内具有相同 X 轴测量单位
的当前图形都会被连接。例如，如有三个谱图可见，则在其中一个图上单击 Ctrl+ Links
graph's x-axis to others (with same units) in the window 图标，这三个谱图即连接起来。

Explorer 教程

软件用户指南
RUO-IDV-05-7560-ZH-I

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统

209/301



注释: 在这个示例中，如果接下来生成一个新质谱，那么它不会与其余图相连接。要连接新谱
图，单击相关 Links graph's x-axis to others (with same units) in the window 图标。

默认情况下，只连接图中的 X 轴。这种情况下，当手动缩放一个图时，其余图会自动缩放 Y
轴，这样视图内的峰将填满可用空间。

要断开已连接的谱图，单击相应图中的 Links graph's x-axis to others (with same units) in
the window 图标。单击时按下 Ctrl 键可断开同一窗口内具有相同 X 轴的所有图。

切换数据以使用下一个实验

如果图中的活动数据与特定实验而不是前一个实验相关，那么通过这个图标可用相同类型的数
据替换这些数据，而不是下一个实验的数据。

例如，如果实验 2 的 TIC 处于活动状态，那么单击这个图标可切换至实验 3 的 TIC。 如果实
验 2 内给定时间的质谱处于活动状态，那么单击这个图标可切换至相同时间时的实验 3 的质
谱。

切换数据以使用前一个实验

如果图中的活动数据与特定实验而不是第一个实验相关，那么通过这个图标可用相同类型的数
据替换这些数据，而不是前一个实验的数据。

例如，如果实验 3 的 TIC 处于活动状态，那么单击这个图标可切换至实验 2 的 TIC。 如果实
验 3 内给定时间的质谱处于活动状态，那么单击这个图标可切换至相同时间时的实验 2 的质
谱。

切换数据以使用选定的实验

使用该图标可选择一个特定实验，不需通过逐个滚动的方式寻找所需实验。单击该图标，可打
开一个列出所有可用实验的对话框。活动样本高亮。 单击并选择列表中的一个实验，然后单
击 OK。 请参阅图 D-10。
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图 D-10 Select Experiment 对话框

显示可供选择的质谱

通过这个图标可生成图中当前选择的时间范围内的平均质谱。 双击这一选择可获得相同的结
果。

设置背景减除范围

通过这个图标对从色谱图中生成的质谱实施自动背景减除。

质谱专用工具栏

表 D-4 质谱专用工具栏图标

图标 名称（工具提示）

显示供选择的 XIC

注释: 关于该工具栏中的最后十一个图标的描述（从“将缩放图恢复至主页视图”图标）开始，
见图专用工具栏。

注释: 关于该工具栏中的最后六个图标的描述（从“删除窗格”图标）开始，见通用窗格工具
栏。

显示供选择的 XIC

通过这个图标可生成图中当前选择的质量范围内得出的提取离子色谱图 (XIC)。
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叠加

图中可能含有共享相同轴的不同轨迹，即所谓的叠加，这样便于对其进行对比。 拖动恰当的
双窗格图标（“拖动至另一图以叠加目标图内的活动数据”图标）可生成叠加，也可通过一些窗
格创建命令可自动生成。 请参阅色谱图和质谱。

在图 D-11 中，图中含有四个选定“标记所有叠加轨迹”图标的质谱。 图中的标题区显示两个图
谱的标题和指示轨迹颜色的带色圆圈。 活动轨迹以粗体显示。 这个轨迹是任何处理操作的目
标，如：阀值数据、平滑数据等等，通常是唯一带有标记的。 单击标题左侧的图标可更改图
标，而且只显示活动轨迹的标题。 当叠加很多时，该功能很有用。再次单击图标便可反向操
作。 如果有很多轨迹且光标在这些标题上移动，那么光标会变为双箭头，而且拖动时可作为
滚动条使用，这样可访问所有标题。

图 D-11 含有四个已选定“标记所有叠加轨迹”图标的质谱图

有多种方式可切换活动轨迹：

• 单击标题旁边的彩色圆圈

• 单击标题本身

• 单击轨迹内的数据点（不是轨迹本身）

在有叠加的图内单击右键后可显示快捷菜单，菜单内含有可用于可视化编辑所示轨迹的命令。
可按照预期使用 Remove Active Trace 和 Remove All Traces Except Active 选项。
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打开文件

如图 D-12 中所示，软件可打开不同类型的数据文件，拥有打开单个或多个样本的命令。

图 D-12 文件菜单

打开单个样本文件

通过 Open Sample 选项打开 Select Sample 对话框。 请参阅图 D-13。

通过这个对话框可选择单个文件。 生成的视图取决于所选指令，其中 single .scan 文件可显示
质谱或总离子色谱图 (TIC)，而多个 scan .wiff 文件可显示 TIC（如果为一个以上，则为所有实
验的总和）。

图 D-13 Select Sample 对话框
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单击 .wiff 文件左边的图标以显示文件内的所有样本，然后选择要求的文件名称。 如果文件内
只有一个样本，则选择文件名称并单击 OK。

打开多个样本文件

通过 Open Multiple Samples 和 Open Heat Map TICs from Wiff 选项可打开 Select
Samples 对话框。 请参阅图 D-14。

左侧面板相当于允许浏览文件夹和指定文件的 Open 对话框，而右侧面板指示单击 OK 后将打
开的文件。 样本可按如下操作从左向右转移：

• 扩展 .wiff 格式的文件，选择样本，然后单击右指箭头。

• 扩展 wiff 格式的文件，选择样本，然后将其拖放至右侧面板中。

• 扩展 wiff 格式的文件，然后双击样本。

如果文件中含有多个样本，则通过选择 .wiff 格式的文件并单击右指箭头或选择 .wiff 格式的文
件并拖放至右侧面板而将其全部转移。

样本可按如下操作从右向左转移：

• 扩展 wiff 格式的文件，选择样本，然后单击左指箭头。

• 扩展 wiff 格式的文件，选择样本，然后将其拖放至左侧面板中。

• 双击样本。

图 D-14 Select Samples 对话框
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色谱图和质谱

搜索和查看数据时，总离子色谱图 (TIC)、质谱和提取离子色谱图 (XIC) 是最常使用的数据视
图。软件可提供这些数据视图之间的链接，以便用户快速生成质谱和 XIC，进而确定质谱内的
峰是否来自一个或多个色谱峰。

总离子色谱图 (TIC)
当打开一个扫描或多个扫描 wiff 文件时，默认显示这个视图。 所示 TIC 对应通过以下方式生
成的色谱图：累积各质谱内的所有离子，然后根据保留时间绘制强度累积线图。

如果通过循环实验采集到样本，那么显示的 TIC 对应两个实验的强度累积，而且 x 轴内会画出
一个特殊箭头指标以对此做出指示。 请参阅 图 D-15。 如果双击该指标，则会出现一个显示
各实验的叠加 TIC 的新窗格。

图 D-15 TIC

如果样本中含有 IDA 数据，则可选择任一个 IDA Explorer，这是一种显示选定前体的质量和保
留时间或传统 TIC 的图形方法。 如果选定传统 TIC 选项，则会显示用于 IDA 测量和 IDA 相关
总和的单独 TIC。

单击 Show > Total Ion Chromatogram (TIC) 并打开允许选择实验的对话框后，可随时显示
TIC。 选择时段 1 可显示所有实验的 TIC，而其他条目对应各个 TIC。 使用 Shift+ 或 Ctrl+
单击，以选择多个选项。

质谱

如果一个文件中只含有单个质谱，那么当打开该文件时会显示该质谱。

对于包含多次扫描的数据，在色谱图中选择并在色谱图内双击或单击“显示可供选择的质谱”图
标，便可从色谱图中得出质谱。拖动色谱图内的选择矩形，更新质谱，进而显示新区域。

Explorer 教程

软件用户指南
RUO-IDV-05-7560-ZH-I

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统

215/301



完成第一次选择后，通过按下 Shift 键可选择多个区域。 双击这些选择中的任意一个或单击
“显示可供选择的质谱”图标可生成一个新的质谱窗格，之前的质谱被覆盖。

对于 IDA 而言，迅速叠加所有独立质谱或仅显示第一个打开的质谱。 在后一种情况下，使用
左右箭头键可显示另一个质谱。

注释: 对话框中只有一个 Only show again if the shift key is down 复选框。

通过两种方式可生成经过背景减除的质谱：

• 分别生成峰质谱和背景区域质谱，然后将减除双窗格图标从背景质谱拖动至峰质谱。

• 通过在色谱图中做出一个或两个选择并点击“设置背景减除范围”图标来定义背景区域。 当
背景区域定义好后，生成的任何质谱都会自动进行背景减除。 背景区域在色谱图内显示为
淡红色选择矩形，它和任何质谱选择都可移动以改变显示的数据。 当背景区域定义好后，
单击图标旁边的箭头，然后选择“清除减除范围”便可将其删除。

注释: 箭头标记在质谱中很有用，这是因为峰标记可能与用箭头标记的最近的峰相关，这样可
快速确定丢失物或加合物的质量。 如果有多个叠加且选定了“标记所有叠加轨迹”图标，那么各
叠加则会相对于箭头做出标记。

提取离子色谱图 (XIC)
XIC 可通过下列两种方式生成：

• 单击 Show > Extracted Ion Chromatogram (XIC)。

这个操作可打开一个对话框，在其中可以根据模式开始或停止质量，也可以键入中心或宽
度值。 在对话框内单击右键可打开快捷菜单，通过快捷菜单可进行修改。 通过快捷菜单还
可以使用其他有用命令，如：设置默认宽度和导入或导出质量列表。 用户还可以永久保存
质量值，除非被删除，否则这样它们可一直自动使用。

• 在质谱内做出一个或多个选择，然后双击其中之一或单击“显示可供选择的 XIC”图标。

这些操作可生成与每个选择对应的 XIC。 默认情况下，程序可确定每个选择范围内的最大
峰并自动设置与半高低和高质量值对应的峰的 XIC。 如果按下 Ctrl 键，则使用整个选择宽
度。

两种情况下，所显示的图都是每个选定部分都只有一个叠加的图。 这些选定部分会转为连
接。 拖动连接可更新 XIC。

注释: 通常，XIC 是在整个色谱图范围内计算和显示的，这个过程可能较慢，尤其是在有多个
选定部分且数据来自高分辨率仪器并含有很多扫描的情况下。 一个有用的功能就是将 XIC 范
围限制在用于生成范围的质谱保留时间附近的一个较小窗口内。 单击 Edit > Options > XIC
选项卡后出现一个对话框，可在其中的 XIC 选项卡中进行过此类设置。

等值线图与热图

LC/MS 等值线图（Show > LC/MS Contour Pane）可在单个窗格内显示 LC/MS 样本的所有
数据。 图 D-16 中的示例显示的是一个 TIC 和相应的等值线图，图中所示为 m/z 比率对保留
时间的数据图，其中颜色编码代表强度。 这个案例中还显示了颜色控制，但是在视图中单击
右键并清除 Show Appearance Controls 选项可隐藏颜色控制。 由于等值线图和色谱图拥有
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同一个 X 轴，所以它们可以连在一起，这样缩放和滚动会对两个视图产生类似的影响，便于进
行对比。

图 D-16 TIC 和相应的等值线图

颜色控制使用 256 色调色板显示按 min% 和 max% 规定的范围内的强度。 Min% 以下的强度
用 < min 绘图，而 max% 以上的强度用 > max 绘图。 如果使用代表 < min 的颜色且数据都
不同（如图所示），那么低于 min% 的数据都会消失。 这是一种可简化 Figure 1-11 中所示线
图的视觉阀值形式，图中已将 min % 值提高至 0.5%。 关于颜色控制的更多信息，请参阅系
统用户指南。
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图 D-17 等值线图，最低百分比值提高至 0.5%

通过降低 max % 可强调低强度峰，这样调色板可涵盖一个较小强度范围，但是大于该值的所
有峰都以相同颜色表示。 通过选定 Log Scale 复选框也可对此进行强调。 激活 Log Scale 要
求 min % 的值不能为零（如：1 或 0.1），然后将颜色映射到百分比强度对数。

软件中的多样本可视化工具可显示 TIC、XIC 和作为一系列单一热图的多样本质谱，这有助于
样本对比。 图 D-18 是六个分析物的一系列 TOF 色谱图。 请参阅对多个样本有效。
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图 D-18 热图色谱

使用色谱图和质谱
本节描述的是一些最常用的处理选项。 所用文件为含有大量环回实验的 IDA 文件，但是在本
示例中，使用的是第一测量实验，用于模拟一个简单的 LC/MS 分析。 下一节将探讨 IDA 功
能。

打开数据文件

1. 单击主工具栏中的“打开样本”图标。
Select Sample 对话框即会打开。
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图 D-19 Select Sample 对话框

2. 如果 Sample Data 文件夹未选定，则单击 Browse 并前往 Sample Data 文件夹。 关于
已安装的数据文件位置的信息，请参阅 机构。

3. 要显示文件内的所有样本，可单击 Bromocrip_IDA-DBS alone_T=1.wiff 文件左侧的图
标。
Bromocrip_IDA-DBS alone_T=1.wiff 文件中只有一个样本。

4. 选择样本名称，然后单击 OK。
因为这是一个 IDA 文件，所以软件提示您具体说明如何打开选定的样本。

图 D-20 打开 IDA 样本

5. 如果尚未选择，则单击 As a standard TIC，然后单击 OK 生成图 D-21 中所示的 TIC。
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图 D-21 TIC

这个窗格中叠加有一个全谱扫描 TIC（蓝色）和一个叠加独立（产物离子）扫描。 在这种
情况下，我们希望处理测量数据，以单独显示测量 TIC。

显示一个实验的 TIC
1. 双击 X 轴中心的“双击以叠加所有实验的 TIC”图标，以生成全部实验的叠加 TIC。

新色谱图就是活动窗格。 另外，由于测量是第一项实验，新色谱图就是标题区中加粗标题
的活动轨迹。
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图 D-22 叠加 TIC

2. 在活动色谱图窗格中右击，然后单击 Remove All Traces Except Active，以便只保留测
量 TIC。

图 D-23 右键菜单

3. 在同一窗格内，单击“删除其他所有窗格”图标，以只留下测量 TIC。
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图 D-24 测量 TIC

显示已知分子式的 XIC
虽然在 4 - 7 分钟范围内明显存在一些小峰，但由于背景信号在该数据中相当强，因此许多峰
可能会被其掩盖。由于这个样本符合溴隐亭的微粒体温育，可使用预期分子离子的 m/z 比作为
到达峰位置的初步指引。 溴隐亭的分子式为 C32H40N5O5Br， 由于这是负极性模式数据，我
们希望看到一个 (M – H)– 离子。

1. 单击 Show > Mass Calculators。

2. 单击 Mass Calculators 窗格中的 Mass Property 选项卡。

3. 在 Formula 字段中键入分子式。

4. 在 Charge state 字段中键入 -1。

5. 选择 ‘H+’ charge agent (else electron)。

6. 单击 Calculate。

注释: 也可以从分子式中手动删除一个氢，而不选定 ‘H+’ charge agent (else electron) 复
选框。

刷新对话框显示一系列质量值：单同位素、平均值等等。
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图 D-25 质量计算器窗格

注释: 在这些质量值下，同位素容易分辨。因此，单同位素的 m/z 值是最恰当的值。

7. 选择 Monoisotopic m/z 值，然后按下 Ctrl+C 键将值复制到剪贴板。

8. 单击“删除窗格”图标以删除 Mass Calculators 窗格，或单击“隐藏窗格”图标以隐藏窗
格。

9. 单击 Show > Extracted Ion Chromatogram (XIC) 以打开 Specify XIC Ranges 对话
框。
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图 D-26 Specify XIC Ranges 对话框

10. 在 Specify XIC Ranges 对话框中单击右键打开快捷菜单。

11. 在快捷菜单中，执行以下操作：

a. 确保未选定 Start/Stop Mode 选项，这样 XIC 值可作为中心值和宽度输入。

b. 单击 Set Default Width，键入 0.05，然后单击 OK。

c. 单击 Persist Ranges for Future Use，以便下次使用对话框时这些值还保存在内。
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图 D-27 快捷菜单

12. 返回至 Specify XIC Ranges 对话框。
对话框现已设置为每个相关 XIC 只能输入一个质量值并使用一个默认宽度。

13. 选择 Center 下方的第一个单元格，然后按下 Ctrl+V 键并粘贴从步骤 7 获得的质量值。

14. 单击 OK。

注释: 由于已设置默认宽度，所以不需要另外输入宽度值。

现在的窗格中含有溴隐亭的预期分子离子的 TIC 和 XIC，显示有多个峰。

图 D-28 溴隐亭的预期分子离子的 TIC 和 XIC
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生成并与质谱交互

1. 隐藏 TIC 窗格，在 XIC 内的最大峰附近做出选择，然后单击“显示可供选择的质谱”图标
以生成该区域的平均质谱。

图 D-29 XIC 内最大峰的质谱

注释: 在图 D-29 中，Options 对话框的 Peak Labeling & Finding 选项卡上的 Label 字
段（通过 Edit > Options 获取）被设置为 Mass (Charge)。

2. 从约 630 -- 700 Da 处拖动 X 轴，将质谱缩放到这个区域。

注释: 这可能需要通过两个步骤来完成。

在非常接近预期值 652.2140 的 652.2199 点处有一个也显示溴同位素形式的峰，但是从
668.2158 开始有一个第二溴同位素群集。精确 m/z 比值因 XIC 内选定的准确保留时间窗
口不同而不同。

注释: 此处使用的标记类型在括号内显示 m/z 比和电荷状态预估（基于峰间距）。 单同位
素峰也用一个星号标记。 标记算法并没有考虑到除 13C 以外的同位素，因此该算法将
81Br 同位素标记为单电荷同位素，但是却错误地将其标记为单同位素。

3. 单击 Edit > Options，前往 Peak Labeling & Finding 选项卡，然后将设置改为 Label
字段中的 Mass / Charge，这样可将标记类型改为默认类型。

4. 单击 OK。
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图 D-30 不同标记类型的质谱

5. 在扩展的质谱中，在 652.2199 所对应峰周围选择，然后单击“为选定的峰添加箭头标记”
图标。

图 D-31 质谱，在选定峰上显示

质量标记现在与选定的峰相关，这样可显示质量峰之间的差异。 现在，668.2158 处峰标
记的读数为 15.9959（相当于氧的质量），表明这个峰为烃基溴隐亭的代谢产物。

提示! 将箭头拖动至另一峰便可移动箭头，而从与箭头图标相邻的列表中选择 Remove
All Arrows 可删除箭头。

6. 在 15.9959 所对应峰周围选择，然后单击“显示供选择的 XIC”图标。

7. 在 XIC Selection Ranges 对话框中，单击 OK。
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图 D-32 XIC 选择范围对话框

图 D-33 XIC

这是一种交互式地生成 XIC 的有用方法。 默认情况下，XIC 所用宽度是半高处的质量峰
的宽度，选择连接显示于质谱内。

8. 拖动选择连接以更新显示的 XIC，重复这一步骤添加更多。

9. 在这个新色谱图内单击 “拖动至另一图以叠加目标图内的活动数据”图标，然后将色谱图拖
动至原 XIC 窗格，这样它们可叠加在一起。
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图 D-34 叠加的 XIC

10. 隐藏或删除第二个色谱图窗格和质谱，然后缩放叠加的色谱图以显示 4 - 5 分钟左右的区
域。
4.4 分钟附近有两个分别来自 XIC 的峰，它们以非常接近但不是完全相同的保留时间进行
洗脱。在 668.216 色谱图中也有大量峰，可大概说明其中含有其他烃基代谢产物。

11. 双击色谱图窗格内的 4.4 分钟处，以生成单个扫描的质谱。
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图 D-35 单个扫描的质谱

XIC 中的虚线指所示扫描（用图 D-35 中的箭头标记）。 如果拖动这条线，则质谱更新，
进而可查看 4.40 分钟附近的区域。使用向前和向后箭头一次移动一个扫描。 通过将线条
移动至 668.215 离子的信号为零的区域内（但即使在这里背景也非常高）可能获得 m/z
比为 652.214 的峰的干净质谱，但是后者的干净质谱无法通过这种方式获得。

12. 删除质谱窗格。

13. 在色谱图窗格内，缩小选择范围（包含 652 峰的左侧，但是不包括 668 峰），然后单击
“设置背景减除范围”图标。

选定部分变为粉红色。

设定好减除范围后，接下来生成的质谱将自动进行背景减除。 单击“设置减除范围”图标右
侧的小箭头访问列表，然后在列表中选择“清除减除范围”便可清除该范围。

14. 在色谱图中选定另一部分，其中应包含 668 峰的最高点，但是应尽可能少地包含 652
峰，然后单击“显示可供选择的质谱”图标。
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图 D-36 668 峰的背景减除质谱

得到的结果是 668 峰的背景减除质谱且几乎不含 652 峰。 即使背景不可见，色谱图内的
两个选定部分仍然与各自的质谱连接在一起，而且可移动至色谱图内的其他部分。 移动质
谱选定部分将自动更新显示出的质谱，但是如果背景区域发生变化，那么这个操作就只适
用于接下来生成的质谱。

15. 单击“隐藏所有其他窗格”图标，在单个质谱 TIC 内单击，然后单击“删除所有其他窗格”
图标，以便只显示 TIC。

16. 如果 TIC 窗格已删除，则单击 Show > Total Ion Chromatogram (TIC)，选择 Period 1,
Experiment 1，然后单击 OK。

使用等值线图

查看数据集（色谱图或谱图）各部分的另一种方法就是使用等值线图来获取某一实验的完整概
况。 等值线图可提供很多信息，但是通常必须通过调整查看参数来获取最佳结果。 在这个例
子中，前体化合物经过溴化处理，而等值线图可提供一种通过溴同位素形式来定位峰的方法。

1. 只有单个实验 TIC 处于活动状态时，单击 Show > LC/MS Contour Pane，然后在生成的
等值线图中的工具栏中单击“展开活动窗格填充窗口”图标，这样就只有这个窗格可看到。

2. 如果外观控制（左下角的颜色复选框）不可见，则在窗格内单击右键，然后单击 Show
Appearance Control。 请参阅等值线图与热图和参考指南。
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图 D-37 等值线图

提示! 对于默认参数而言，这个视图不是很有用，这是因为这个视图中低水平峰和会掩盖
真实峰的噪声占主导。 通过以下方式生成一个更好视图：

• 更改要显示的最低强度。 这会改变低于这个水平且应以与无数据的点颜色相同的颜色
绘制的所有数据点，也就是说，它们变得不可见。

• 改变颜色映射，这样可用颜色会覆盖用于强化小峰可见性的较窄的强度范围。

3. 将 min %值改为 0.01。 这会导致强度低于 0.01% 基峰的所有数据点消失。
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图 D-38 等值线图

数据中显示了更多结构信息。 空隙容积和列清除区很清晰，有很多在所有保留时间都出现
且显示为水平线的背景峰。

4. 选中 Log scale 复选框。
选定的颜色被映射到强度对数（以基峰强度百分比表示），有强化较低强度峰的作用，例
如：4 - 4.5 分钟左右的峰群（质量范围 600 - 700）。

5. 选择这个区域，然后单击“将选择放大至全视图”图标。

提示! 也可以按照常规方式分别缩放 X 轴和 Y 轴。
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图 D-39 等值线图

现在的视图显示，在这个区域内有很多溴化峰，通过四条对应于 79Br 和 81Br 同位素及其
13C 同位素的平行线可对其进行区分。

6. 在颜色控制设置下进行实验，观察对视图的影响。

7. 完成后，关闭窗口。
这样也会关闭数据文件。

摘要

本节中对下列任务进行了讨论：

• 浏览并打开一个数据文件，以显示 TIC。

• 更改视图，以便只用一个实验。

• 通过质量计算器来确定元素组成中的离子质量，并使用该质量生成 XIC。

• 交互生成质谱和色谱图，使用质谱上的箭头标记来显示峰之间的质量差异。

• 生成背景减除质谱。

• 使用等值线图生成一个数据集概览。

不论所显示的数据类型是什么，这些操作都是所有交互数据处理的基础。
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使用 IDA Explorer
在 IDA 实验中，当一个或多个测量质谱中的数据符合特定标准时，可自动收集 MS/MS 质谱
（和可能的 MS3）数据。 通常会设置参数，在特定时间段内排除前体离子质量（不允许其作
为触发器），以避免从同一 LC 峰收集多个质谱。 偶尔，也可能会收集到冗余质谱。 另外，
由于一旦峰满足标准就会触发 IDA，所以一般会早在 LC 峰时就生成质谱，但是质量可能不是
最佳。

软件中含有显示、过滤和处理 IDA 数据的工具。 本节中对部分工具进行了探索。

开始前请关闭所有已打开的窗口。

显示并合并质谱图

1. 单击主工具栏中的“打开样本”图标。
Select Sample 对话框即会打开。

2. 如果 Sample Data 文件夹未选定，则单击 Browse 并前往 Sample Data 文件夹。

3. 选择 Bromocrip_IDA-DBS alone_T=1.wiff 文件，然后单击 OK。

4. 在 Open IDA Sample 对话框中，单击 With the IDA Explorer，然后单击 OK。
程序会检查数据文件中的所有质谱，然后生成下列图。

图 D-40 IDA 查看器

左边窗格中含有一个 Graph 选项卡和一个 Table 选项卡。 Graph 选项卡可显示一个虚拟
等值线图，其中每个数据点代表保留时间和被选定为前体离子的 m/z 比。 Table 选项卡显
示虚拟等值线图上数据点的表格视图。 右侧面板显示选定数据点的质谱。 最初显示的是
第一个 MS/MS 质谱。
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等值线图使用颜色强度来反映峰强度。 颜色越深，则峰强度越大。 在可以设置标记的地
方设置标记，以确保它们不会与数据点重叠或相互间重叠。 放大等值线图，以便更详细地
检查该区域和显示更多标记。

5. 在左面板中，缩放 4 - 5 分钟以及 640 - 700 Da 的区域，此处的峰与此前发现的溴隐亭相
关。

左侧图（图 D-41）只显示左侧面板。 如果当前的视图不同，则单击 Show Options 图标
并清除 Options 对话框的 General 选项卡上的 Merge spectra with similar precursor
masses 复选框。

该区域中收集了大量 MS/MS 质谱，尽管色谱峰非常窄，但是有些可能来自相同峰。 此
外，还针对同位素群集中的每个峰收集了 MS/MS 质谱。

6. 继续放大图，将峰群集集中在 m/z 比为 668 Da 到 672 Da 之间的区域。 请参阅图 D-41
中的右侧面板。

图 D-41 IDA 查看器

7. 选择 669.2197 峰中的第一个峰（在上文右侧面板中显示为一个星号），然后单击“显示供
选择的 XIC”图标以显示全谱扫描中该前体离子质量的 XIC。

一开始就选择峰，这样就会显示出相应的 MS/MS 质谱。
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图 D-42 全谱扫描中前体离子质量的 XIC

如果等值线图中有一个未标记的数据点，则应将光标移至该点以显示 m/z 比和保留时间标
记，这样就可以关联产物离子扫描的次数和全谱色谱图。

对于 669.2 峰，前三次扫描与 4.21 分钟（这也是 668.2 扫描生成的地方）的第一个 XIC
峰相关，紧接着的两次扫描与 4.27 分钟的峰相关，而最后一次扫描来自 4.42 分钟的峰
(669.2177/4.46) 。在 4.52 分钟时的 669.2 峰未进行任何扫描，但是从 670.2 峰获得了一
个扫描。

注释: 扫描次数稍有不同，这是因为即使是在相同全谱扫描中检测到的，它们也是按顺序
获得的。 较小的同位素峰可能会晚于较大的峰而被检测到。

8. 在前五个 669.2 扫描附近画一个选择矩形，右击，然后选择 Select Points in Graph
Selection。

这样，质谱窗格会叠加在所有 MS/MS 质谱上。
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系统已获得比需要更多的扫描。 减少要处理的质谱数量并合并那些太接近而不会是不同化
合物的质谱，这样我们就可以获得更高质量的结果。 合并操作使用质量和保留时间，以确
定这些扫描。

9. 单击 Show Options 图标，选择 Merge spectra with similar precursor masses 复选
框，然后将 Mass tolerance 设置为 10 ppm，将 RT gap tolerance 设置为 0.03 分钟
（该分析中的峰约为 2 秒 宽）。

10. 单击 OK。

注释: 对话框的这个部分还允许用户设定如何提取 XIC。 质量宽度应与仪器的分辨率或峰
宽相匹配，由于可加速处理，所以这有助于限制所用的时间范围。

以这种方式合并数据后得到三个 669.2 峰（4.21 分钟、4.28 分钟和 4.46 分钟）。IDA 查
看器窗格底部的状态栏显示数据合并进程，然后显示合并完成后相关质谱的总数。

11. 单击 670.2149/4.26 对应的数据点，然后按下 Ctrl 键并单击 668.2162/4.27 对应的数据
点。

12. 在 MS/MS 质谱窗格中，单击“展开活动窗格填充窗口”图标，“使用百分比刻度 Y 轴”图标
和“标记所有叠加轨迹”图标，然后缩放 x 轴以显示 340 到 680 之间的区域。

图 D-43 质谱：m/z 340 到 680 之间的缩放区域

由于这两个前体对应 Br 同位素，所以除保留 Br 原子的离子外质谱应完全相同，显示为按
每两个 Da 分开的一对峰。 本示例中，344.0441、625.1765 和 637.1712 处的碎片
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（668.2 轨迹）保留了 Br 原子，而 340.1925、367.1796 和 588.2877 处的碎片没有保
留。

在 588.2877 峰处放一个箭头，然后观察现在标记有 Br 同位素质量加 1 的 668 和 670
峰，表明 588.2877 峰对应于丢失的 Hbr。

13. 删除质谱中的箭头，单击“展开活动窗格填充窗口”图标，然后缩小等值线图以查看所有数
据点。

过滤 IDA 数据

IDA Explorer 含有很多过滤器，可用于缩减要可视化或要处理的数据量。 本节中对这些过滤器
进行了描述。

1. 在等值线图中，单击“展开活动窗格填充窗口”图标，然后单击工具栏下方的 Filtering
Controls 旁边的图标。

图 D-44 过滤 IDA 数据

该窗口有多个滑块和复选框，每一个对应一个可用于调节所示数据量的不同过滤标准。此
处可通过缩放视图来选择保留时间（Time））和 m/z 比 (m/z)。

其他过滤器如下所示：

• TIC：设置 MS/MS 谱图中的峰强度累积极限值。 通常用于删除小的噪声扫描。

• Quality：指大于 1 个同等物的强度累积分数，一般不太可能由噪声造成，是对光谱质
量的预估。

• Matched Int. (%)：使用 Fragment Matching 时，可对通过已知碎片和中性丢失进行
解释的强度累积分数作出评估。

• Similarity：当已设置参考谱图时可用。 该功能可用于测量与参考谱图中的普通碎片和
中性丢失相对应的强度累积分数。请参阅使用参考谱图。
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• Mass Defect ：可设置某一质量小数部分的单个范围。 该功能对于寻找代谢产物非常
有用，因为常见代谢转化（O、O2 等等）不会明显改变前体分子的亏损，所以使用接
近其亏损的范围可能会找到可能的代谢产物。

• Defect in Range：除单个质量亏损范围外，软件还允许用户定义多个适用于不同质量
范围的亏损值。 如果已规定这类范围，那么通过这个复选框用户可确定是否应用过滤
器。 范围可在 Options 对话框的 Mass Defect 选项卡上设置。

• Isotope pattern：该复选框允许用户将一个或多个同位素形式过滤器应用于 MS 测量
数据。 也就是说，只有当选定的前体离子具有所需形式时，才会显示数据点。这些形
式可在 Options 对话框的 Isotope Pattern 选项卡中界定。

每个简单数据过滤器都有两个滑块，可用于界定范围。 双击任一滑块，然后直接键入一个
值。

2. 滑块设置好后进行实验，应尤其注意的是，即使是 TIC（如：1e3）或 Quality (1) 值的最
低设置也会有惊人的效果。 将较低 TIC 过滤器设置为 2e3，其他全部设置为 0。

溴隐亭的质量亏损约为 0.22，因此简单代谢产物不可能有大于该值的值或更低的值。

3. 将 Mass Defect 过滤器设定为 0.18 和 0.23，同时注意观察其余峰是否在 4.5 分钟和 650
Da 的邻近范围内，并且该区域（4.40 分钟）内只有一个源自 m/z 比等于 652.2211 时的
数据点。

4. 点击 Filtering Controls 旁边的图标可隐藏过滤器控制。

提示! 要更改可见的过滤器，可在过滤器区域内点击右键，选择 Filters，然后选择恰当的
过滤器。

使用参考谱图

1. 在等值线图内，点击 652.2211/4.40 处的数据点（溴隐亭本身），然后点击“设置参考谱
图（用于相似性打分）”图标。

注释: 可能需要先缩放图。

2. 单击“设置参考谱图（用于相似性打分）”图标旁边的箭头，然后确保选定 Overlay
Reference Spectrum。

3. 点击 654.2185/4.39 处的数据点。

参考谱图设定好且 Overlay Reference Spectrum 选定后，显示的任何质谱都有叠加的参
考谱图，这样便于对比。 处理代谢产物时这个操作很有用，这是因为该操作可以提供一个
快速确定哪个峰发生变化的方式。

我们已经绘制出作为参考的低质量溴同位素的前体离子的 MS/MS 谱图，而且已经叠加了
较高质量同位素的质谱，这样我们就拥有一个类似于先前生成的 668.2 峰的视图。也就是
说，含溴离子可通过相距两 Da 处出现的峰来识别。

4. 单击“展开活动窗格填充窗口”图标，然后在等值线图中单击 Table （位于 Filtering
Controls 正下方）。

注释: 如需要，将质谱窗格移动至表下方（使用“拖动并重排窗格”图标），这样所有列就都
可见了。
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表中显示与图形管理器相同的信息，但是提供更多详情。 它也对过滤控制作出回应，这样
两个视图就含有相同的质谱。 表与质谱视图连接后，选择行时质谱会更新，而单击列标题
可对行进行分类。

当设定好参考谱图后，多出以下两列：Delta m/z 显示与行相对应的参考物谱图和质谱的
前体离子质量差异。 Similarity 显示两个质谱的相似度。

5. 单击 Delta m/z 对表格进行分类，然后观察到它包含几个峰，相差约 15.995（氧质量），
而 31.990 (O2) 点处的峰可能是烃基溴隐亭的代谢产物。

6. 单击表中的某一行显示相关质谱。

注释: 这些质谱中有与扫描高度相似的值，其中前体质量高两个 Da，这些值来自于含有离
子的 81Br。

摘要

本节中对下列任务进行了讨论：

• 通过图表 IDA Explorer 视图检查 IDA 文件。

• 确定需要时，合并相关质谱。

• 使用 TIC 和质量亏损过滤器过滤显示出的质谱数。

• 叠加质谱，以便对其进行对比。

• 设定一个参考质谱，然后使用表格找到类似的代谢产物。

这些操作对于 IDA 数据处理很重要。

下一节的内容是通过使用溴隐亭的 MS/MS 质谱来描述如何使用结构工具。

使用结构工具
软件中含有帮助将离子质量连接至结构（保存为 .mol 格式的文件）并探索生物转化可能位置
的工具。

将结构与 MS/MS 质谱关联

1. 查找溴隐亭的 MS/MS 谱图位置，652.2211/4.40。请参阅使用 IDA Explorer。

2. 单击等值线图内“隐藏所有其他窗格”图标，以便只有质谱可见。

3. 单击 File > Open Mol File。

4. 在 Select Mol File 对话框中，选择 Bromocriptine.mol 文件，然后单击 Open。 关于已
安装的数据文件位置的信息，请参阅 机构。
新窗格在质谱下方打开并显示结构和工具。
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图 D-45 溴隐亭结构

5. 单击结构窗格内的 Show options 对话框，确保选择 Zoom spectrum (if any) on
selection）和 Mark selected fragment mass with arrows 复选框，然后单击 OK。 其
他参数可保持不变。
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图 D-46 结构选项对话框

质谱和结构会自动连接，这是因为创建结构窗格时质谱处于活动状态。 将“显示可供选择
的质谱”图标拖动至适当的质谱便可手动连接结构与质谱。

在结构窗格内拖动时会在光标后产生一条线（套索），以便用户选择将以粗体绘制的全部
或部分结构。因为有一个已连接的质谱，所以可缩放和滚动，以显示选定子结构质量的周
围区域。

6. 在整个分子周围画一条套索，视图发生改变，显示 m/z 比等于 652.2177 时的峰，这与
(M – H)–离子相对应。

因为已选定 Mark selected fragment mass with arrows 复选框，所以在峰上下方画一
个红色箭头，以表明这是与相应选定区域相对应的预期离子质量（即：(M – H)-，因为这
个数据为负极性模式）。

注释: 结构窗格的标题指示元素组成和与选定部分对应的中性化合物的质量（也就是说，
C32H40N5O5Br，质量为 653.2213 Da）。

如果选定 Mark selected fragment mass with arrows，那么当结构窗格内未选定任何选
项时会在 652.2177 峰处绘出绿色箭头。 这是因为绿色箭头标记的是当前选定部分的补
充，如果没有选定部分，则补充为整个分子。

7. 选择除溴原子以外的整个分子。 请参阅图 D-47。
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图 D-47 溴隐亭结构

注释: 只有溴原子用的是普通字体，结构窗格内的标题显示组成和质量，分别为
C32H40N5O5 和 574.3029 Da。在质谱中，红色箭头指示所做选择的预期质量，也就是
说，(M – H)–分子离子的质量小于溴的质量，在距离各侧 1 Da 远处也有箭头。碎裂期间
获得或丢失额外氢原子是很常见的，软件在各个断键的 +1 和 –1 处画了一对蓝色箭头，
表明存在这种可能性。 在这个例子中只有一个键断裂，所以只有两个附加箭头。

质谱中的实际峰与这些箭头中的一个相对应，表明额外氢原子（也就是 HBr）丢失，因此
离子质量对应于 (M – H – HBr)–。

操作碎片

软件中含有可生成核素质量的碎片离子预测因子，这些核素是通过打破化学键并加入或去除氢
原子而形成的。
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注释: 此项预测只是纯粹的运算，并没有应用化学逻辑，所以可能会对生成的碎片估计过高，
但是对于碎片分析而言这仍是一个有用的工具。

1. 当结构窗格处于活动状态时，单击 Show > Fragments Pane。
根据 Fragment Options 对话框中的设置，可能会显示一个进度条。 请参阅图 D-48。

2. 单击 Show options 对话框图标，设置图 D-48 中显示的参数，然后单击 OK。

图 D-48 Fragment Options 对话框

设置选项，以便产生一小组简单碎片，然后根据需要增加断键的数量和类型，以对观察到
的离子做出解释。 允许很多键断裂会减缓程序并生成大量不太可能的碎片。

关于 Fragment Options 对话框中的大部分参数，见参考指南，但是还应注意以下内容：

• 如果已选定 Automatically recalculate on-the-fly 复选框，那么对质谱（切换至另一
个不同质谱，调节参数）或选择做出的任何更改都会导致对碎片进行重新计算。 通常
这是期望的行为，但是如果选项设置为生成很多碎片时可能会影响分析速度。 如果不
使用这个选项，则应单击“碎片”图标。

• Constrain using peak list 表示软件只显示与质谱内的峰匹配且允差恰当的碎片。
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• Require evidence for previous step when breaking bond 只在一个以上的键断裂时
有效。 程序首先断裂一个键，然后考虑断裂所生成的碎片中的键。 如果已选定这个选
项，则在这些键进一步断裂前必须有与其相对应的离子。

根据这些参数，视图应类似于 图 D-49，但是可能会稍微不同，这是因为只考虑了阀值设
置以上的峰（也标记了）。

图 D-49 溴隐亭结构

注释: 质谱内的峰做了标色，以指示与碎片选项卡内的峰相匹配的已指定（蓝色）和未指
定（红色）的峰。

碎片窗格含有两个选项卡：

• Fragments ：在这个例子中，列表较短，这是因为在这些条件下生成的碎片不多，只
有其中一部分按需要与质谱内的峰相匹配，因为选定的是 Constrain using peak list
复选框。

• Peaks：显示一个峰列表，内容包括质谱内阀值以上的峰、其强度以及它们是否已指定
给碎片。对于已指定的峰，表中还显示质量错误。
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图 D-50 碎片窗格

3. 在 Fragments 选项卡中，选择 m/z 比为 324.1929 的一行。峰用红色箭头标记，以表明
这是预期质量，结构窗格内的相应子结构以粗体标出。
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图 D-51 Fragmentation 对话框

注释: 结构窗格标题内的组成和质量现在反映的是离子质量，而不是中子质量。

4. 检查指定给其他碎片的结构。

它们都与将分子的两个循环部分分开的酰胺键相关，而且看起来似乎是可能的。

注释: 已指定的元素组成与使用参考谱图中生成的叠加质谱一致，通过对比含有分子离子
的 79Br 和 81Br，推断碎片中含有 Br。

5. 缩放质谱，以使整个质量范围都可见。
其中两个主峰（m/z 为 324.1970 和 m/z 为 344.0430，对应于分子两侧）已指定，而且以
蓝色线绘出。但是，仍有许多峰未指定。

6. 打开 Options 对话框，然后将 Maximum number of bonds to break 改为 2。

注释: 根据阀值设置，该选项可能会导致一些小峰被指定，而不是丰度更高的峰（例如：
m/z 比为 114.0584、209.1337 或 227.1431）。如果质谱相对于红色箭头做出标记，则应
在结构窗格内单击并清除所做选择，以显示绝对质量值。
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7. 选择 Break ring bonds 复选框，然后单击 OK。
现在很多额外离子都已匹配，包括 m/z 为 209.1337 和 227.1431 时的离子。在
Fragments 窗格内选择新质量并加亮子结构，表明它们与分子的循环肽部分的环破裂相
关。在确定这个区域内的代谢转化点时，这些离子可能会有用。

向质谱添加子结构

选择结构部分，然后用它们为质谱做注释，以供未来参考。根据质谱窗格的大小，使用结构窗
格内的 Options 对话框调整 Target Bond Length，以供复制。

1. 在 Fragment Options 对话框中，清除 Break ring bonds 复选框以简化碎片数量。

2. 在碎片窗格中，选择与更丰富离子之一对应的行，以强调相应子结构。

3. 单击结构窗格内部。

4. 单击 Edit > Copy。

5. 在活动质谱窗格中右击，然后单击 Paste Image。
这样可将子结构图像粘贴进质谱窗格内。

6. 拖动图像，将其移至目标位置。 单击右键并选择 Delete Image 可完全删除图像。
图像与质谱相连接，也就是说，质量强度位置，这样用户滚动和缩放时它们可移动。

7. 对于其他碎片离子，可重复步骤 2 至步骤 6 并生成与图 D-52 类似的最终图像。

图 D-52 带有新增子结构的质谱

8. 单击 File > Print > Print Preview Window，确认子结构定位。
因为匹配后的离子用蓝色线画出，所以很容易与相应结构关联。

9. 复制图像，然后将其粘贴进一个绘图程序以增加线或其他特征。

Explorer 教程

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统
250/301

软件用户指南
RUO-IDV-05-7560-ZH-I



使用相关 MS/MS 质谱

在有些应用中，很有用的一点就是能够对比改性化合物（如：代谢物）的质谱和前体化合物的
质谱和结构。

1. 使用 IDA Explorer 再次显示等值线图。 选择 668.2176/4.21 点对应的峰，然后隐藏等值
线图。

因为结构和碎片窗格已连接至质谱，所以为了反映新质谱窗格已更新，但是结构仍然表示
的是前体化合物，质谱是从带有额外氧原子的化合物（质量为 16 Da 以上）获得的。 很
多情况下，仍然有一些匹配，表明分子部分未改变，但是在本案例中，重要离子都没有匹
配，也没有用红色标出。

结构窗格含有一些简单的绘图工具，可对结构进行修改，以查看是否能找到任何匹配。

2. 结构窗格左侧含有一个带有元素符号的网格。 单击 O，然后将其朝主结构方向拖动。
当原子接近结构时，它以光标后的单键形式与结构结合。

3. 拖动 O 符号，这样键会被拖至结构（麦角灵）的下部，然后释放鼠标（例如：将新原子
放置在苯环上）。图 D-53 显示过程。

图 D-53 结构窗格

质谱再次更新后显示两个匹配项：668.2089 点的分子离子和对应于 588.2828 点上所丢失
HBr 的离子。这表明整体元素组成现在是正确的，但是事实却是主要碎片不匹配，这说明
原子未添加至分子的正确部位。

4. 单击刚刚添加的 OH 组，然后将其拖动至位于结构上部的吡咯烷环上。 确保只有被移动
过的原子以粗体绘出。 否则，表明整个高亮结构都移动了。

如图 D-54 所示，这会使 340.1927、366.1722 和 367.1797 点的离子形成匹配，相应结
构是与前体化合物的质谱相匹配的离子烃基化形式。
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图 D-54 溴隐亭质谱

前体质谱中出现了很多不匹配的低质量峰，或者是烃化等价物，它们是在当算法被允许打
破环键时匹配的，但是在 637.1725 处有一个高质量离子，可能是简单碎裂步骤中产生
的，而且尚未匹配。

5. 在 Fragments 选项卡中，选择 668.2089 对应的行，这样这一行会注上标记，而其他离
子会相对于它注上标记。
这表明 637.1725 点处的峰对应于前体分子（可能是 CH3NH2 或 CH3O）在 31.0364 点的
损失。由于前体分子质谱中未观察到该离子，所以这个离子极有可能是来自该结构环肽部
分内某一甲基的烃基化反应。

6. 在结构窗格内单击两次可取消选定结构，然后将新的 OH 基拖动至结构右侧的某一个甲
基。

7. 打开 Fragment Options 对话框，将 Mass tolerance 设置为 30 ppm，然后单击 OK。
637 离子现在已匹配，选择碎片窗格中的这一行表明离子可能对应含甲氧基部分的损失。

8. 打开 Fragment Options 对话框，选择 Break ring bonds 复选框，然后单击 OK。
虽然当三个键（其中两个需用于前体分子，另一个为额外氧原子丢失）允许破裂时只有
209 处的离子可匹配，但是大部分碎片都可匹配。
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注释: 碎片窗格现在对有些质量包含多个行，如： 637.1905。每个行对应一个不同的可能
碎片（如果三个键都允许破裂，那么会生成更多碎片）。碎片窗格中的峰选项卡只显示基
于综合考虑（质量准确性、断键数、碎片是否是自由基等等）而被认为最佳的匹配。在这
种情况下，最佳匹配对应可能已为前体化合物生成但并未观察到的碎片，因此碎片选项卡
中的附加选项在提示不明显的潜在路径方面很有用。

摘要

本节中对下列任务进行了讨论：

• 以 .mol 格式的文件输入一个结构，然后将其与质谱连接。

• 选择部分结构，然后确定是否有相应的质量峰。

• 生成碎片窗格，然后设置参数以观察简单碎片。

• 使用 Fragments 和 Peaks 选项卡来显示匹配组成、子结构和质量峰。

• 修改 Fragment Options 以允许有更多复杂的碎裂途径。

• 在质谱窗格中加入子结构。

• 修改结构，探查相关分子的碎裂效应，如：代谢物。

通常，较好的做法是先从允许简单碎裂过程开始，根据需要选择额外碎裂选项（额外键、环
键），以便解释观察到的离子。 这与以下事实一致：离子碎片一般先形成更简单的碎片，然
后以一系列步骤碎裂，而不是通过协调步骤打破多个键。 当然，简单碎片可能不稳定，而且
会立即继续碎裂，所以可能观察不到。 另外，允许大量碎裂步骤要求更多的处理时间，也需
要花更长的时间来完成。

对比相关分子时，很有用的一点就是，叠加参考质谱（前体分子）和修改后的格式可能会很有
用，然后连接视图和结构或碎片窗格，活动质谱交换时窗格更新。 但是，如果重叠在一起
时，应用于已匹配和未匹配离子的配色可能难以区分，所以建议您在熟悉程序和视图前使用单
个质谱。

对多个样本有效
虽然通常对单个样本有效，但有时候同时对比或肉眼观察多个样本时可能会获得更多信息。
本节先对软件中可用于两个样本的一些可用工具进行描述，然后对可用于多个样本的工具进行
了描述。

操作两个样本

常用工作流是对比在不同条件下获得的两个样本，以确定有哪些变化。 例如，治疗药物管理
后的两个不同的时间点。 对比数据（T = 0 小时和 T = 1 小时）来自于将鼠肝微粒体注入血浆
后的溴隐亭温育。

开始前请关闭所有已打开的窗口。

1. 单击 File > Open Multiple Samples，然后浏览含有样本数据的文件夹。

2. 选择 Bromocrip_IDA-DBS in plasma_T=0.wiff 和 Bromocrip_IDA-DBS in
plasma_T=1.wiff 文件，然后将文件拖动至窗口右侧。

3. 单击 OK。
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图 D-55 选定多个样本

与打开分别显示测量和单独扫描的 TIC 的单个 IDA 文件相反，有多个 IDA 文件时，所有
样本的全部数据都会显示在单个 TIC 里。 在这种情况下，有两个 TIC，如图 D-56 所示。
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图 D-56 TIC

4. 单击 Show > Total Ion Chromatogram (TIC)，打开 Select Experiment 对话框。

5. 选择 Period 1, Experiment 1－TOF MS (100 - 2000)，然后单击 OK。

图 D-57 处理所有叠加对话框

处理叠加轨迹时会显示 Process All Overlays 对话框，用户可选择是否处理所有轨迹或
只处理活动轨迹。 处理所有轨迹非常有用，这是因为接下来的操作会影响所有轨迹（样
本）。

6. 选择 All Overlaid。

7. 选择 Only show the dialog again if the shift key is down 复选框，使这个选择成为默
认操作。
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8. 单击 OK。
可生成一个含有测量 TIC 叠加的窗格。色谱法的重复性非常好且代谢产物峰也较密集，因
此有些可通过缩放和对比色谱图找到（检查 6 分钟左右的区域），但是通常需要进行额外
的工作。有很多方法可生成更易对比的视图。 在这个例子中，使用了基峰色谱图。

注释: 如果单击了 File > Open Heat Map TICs from Wiff，则可直接生成条形视图，而无
需先显示叠加的色谱图。

9. 隐藏原 TIC 窗格，然后单击 Show > Base Peak Chromatogram (BPC)。

10. 在 BPC Options 对话框中，按需要修改设置以匹配 图 D-58 中的值，然后单击 OK。

图 D-58 BPC Options 对话框

基峰色谱图是各扫描中最大峰的强度随保留时间变化的曲线图。 为了提供更多信息，当基
峰质量的变化量超过本对话框中规定的质量允差时，各轨迹可在其正常颜色与灰色之间切
换。

或者，您可以对所考虑的质量范围作出限制（例如，这样可以避免噪声背景峰导致的人工
痕迹）并设置保留时间范围以加速处理。 因为我们知道溴隐亭的质量约为 652，简单代谢
产物的 m/z 比不会低于 500。

11. 在 Process All Overlays 对话框，确保选定 All Overlaid 选项，然后单击 OK。
与原来的 TIC 相比，在新窗格中显示 BPC 更简单且更容易对比。
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图 D-59 BPC

与 T = 0 样本（蓝色）相比，在 1 小时样本中似乎有两个峰（粉红色）在减小。 它们对应
溴隐亭（6.09 分钟） 和一种同分异构物。 还有三个峰（蓝色箭头）只出现在了 T = 1 样
本中，但没有出现在 T = 0 样本中。 它们可能是潜在代谢产物。

注释: BPC 可能会非常有用，但是它只能反映最强离子的变化（在选定的质量范围内）。
不会变为基峰的质量峰可能不会显示出来，所以如果想要查看样本之间的差异需要使用其
他工具。

12. 隐藏 TIC 窗格。

13. 在 BPC 内的 6.09 分钟处双击

14. 在 Process All Overlays 对话框中选择 All Overlaid，然后单击 OK。
这样可生成两个叠加质谱。

15. 在质谱窗格中，单击然后缩放，以显示 m/z 比约为 652 时的同位素群集。 请参阅 图
D-60。

质谱窗格中含有来自两个样本的叠加质谱，因此容易对比。在这个例子中，很明显 T = 1
hr 样本（粉红色）中的强度小于 T = 0 样本。

在查看像这样的高分辨率数据时，概览图非常有价值，这是因为它可以提供一种方式，在
保持全部质谱可见的同时查看详情。
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图 D-60 m/z 比约为 652 时的同位素群集

16. 在色谱图窗格中，在显示质谱时间的线（先前已双击）上移动光标。

17. 当光标变为双箭头时，将其拖动至约为 5.8 分钟对应的峰。

质谱继续显示扩展的质量范围（现在只有噪声和小峰）。 如要在主窗口中显示粉红色大
峰，可拖动概览图内黑色箭头指示的的粉红色矩形。 释放鼠标后视图恢复正常。

在 图 D-62 中，勾选了“标记所有叠加轨迹”图标。
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图 D-61 BPC 和质谱
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图 D-62 BPC 和质谱，应用了标记所有叠加轨迹选项

T = 0 样本中没有这些峰。

18. 继续操作前请关闭所有窗口。

操作两个以上的样本

当叠加两个以上的样本时，窗口可能会变得混乱，这会使得更难将差异与正确样本关联起来。
软件中含有其他工具，可帮助显示来自多个样本的数据。

示例中使用的数据集来自六个不同数据集的杂质剖面分析。

1. 单击 File > Open Multiple Samples。

2. 选择 DataSet61.wiff 至 DataSet66.wiff 文件，然后将其移动至 Selected 面板。
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图 D-63 选定的多个样本

3. 单击 OK。

4. 单击 Show > Total Ion Chromatogram(TIC)。

5. 从 Select Experiment 对话框中选择 Period 1, Experiment 1。
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图 D-64 Select Experiment 对话框

6. 单击 OK。

7. 在 Process All Overlays 对话框，选择 All Overlaid，然后单击 OK。 表中显示了文件
中各样本的 TIC 色谱图叠加。
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图 D-65 DataSet61.wiff 至 DataSet66.wiff 中实验 1 的叠加 TIC

活动轨迹的标题以粗体字显示。 单击这个标题左侧的图标可将标题折叠到一行，以便为信
息提供更多空间。

8. 单击 Show > Overlaid Traces as Heat Map，然后在生成的窗格中设置颜色控制，即：
设置 min% 为 0.5，max% 为 100。

提示! 如果颜色控制不可见，则单击右键，然后选择 Show Appearance Control。

9. 单击色谱图窗格里面，然后单击“隐藏所有其他窗格”图标。
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图 D-66 热图色谱

每个样本都由一个根据强度进行颜色编码并可显示其 TIC 的单水平条带表示。 根据上述
配色方案，黄色表示未采集到数据的点或强度小于样本最大强度 0.5% 的点，蓝色表示
0.5%，红色表示最大强度信号。

该窗口显示 6 - 7 个峰（4.5 - 6.5 分钟），除了 6.5 分钟处的峰之外，其他峰的响应情况
存在差异。

峰的顺序与样本的采集顺序相同，但可能不是最理想的。 在此例中，这个顺序是适合的。

10. 在窗格中单击右键，然后单击 Show Samples Table。 最初，样本表在热图右侧。 窗格
右上角的“拖动并重排窗格”图标 可用于将窗格拖放至热图底部，以将表移动至原窗格下
方。
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图 D-67 热图色谱的样本列表

表中含有与各样本相关的不同文本字段列。 Display Name 列可编辑，但其他列只读。
所有列都可用于分类表和样本视图。

11. 在 5.5 分钟左右的 Imp STD 10 中进行选择，然后在其内部双击。
一个新的热图质谱窗格即会生成，完整的质量范围显示在 X 轴上。

Explorer 教程

软件用户指南
RUO-IDV-05-7560-ZH-I

SCIEX OS 软件 适用于 X500 QTOF 和 ZenoTOF 7600
系统

265/301



图 D-68 热图质谱

根据质谱图可确定，有几个质量（介于 m/z 400 和 m/z 460 之间）是造成所选时间区域内
强度更高的原因。

12. 选择 Imp STD 10 样本的 Mass/Charge Da 值为 401 左右时的质量，然后右击选择 Show
Spectra for Selected Samples。
这样即可生成选定样本的质谱。 可显示某一时间点的质谱。 请参阅图 D-69。

13. 双击热图质谱中 Mass/Charge Da 为 401 时的质量，以生成一个热图 XIC。
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图 D-69 质谱

摘要

本节中对下列任务进行了讨论：

• 使用软件内可用的多个样本工具。

• 用叠加色谱图和交互质谱对比两个样本。

• 用热图视图对比多个样本。
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使用 Bio Tool Kit 功能
本节对软件中的 Bio Tool Kit 菜单项下的一些可用选项进行了描述。

注释: 必须激活 Bio Tool Kit MicroApp Feature 才能使用这个功能。 激活完成前，可用的选项
只有 Peptide Fragments、Add Manual Reconstruct Highlights 和 Remove Manual
Reconstruct Highlights。 请参阅发行说明文件中的 Activate the Bio Tool Kit MicroApp
Feature。

手动排序

通过该选项可对消化后的蛋白样本的 MS/MS 质谱数据进行手动排序。

1. 单击主工具栏中的“打开样本”图标。
Select Sample 对话框即会打开。

2. 如果 Sample Data 文件夹未选定，则单击 Browse 并前往 Sample Data 文件夹。

3. 选择 RP_digests.wiff 文件，然后单击 OK。

Open IDA Sample 对话框即会打开。

图 D-70 Open IDA Sample 对话框

4. 确保选定 With the IDA Explorer 选项，然后单击 OK。
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图 D-71 来自 RP_digests.wiff 的质谱

5. 单击 Table 标签。

6. 在 Time 12.73 处选择 m/z 471.2398。

7. Spectrum 窗格打开后，单击 Graph > Duplicate Graph。
针对所选定前体 (471.2) 的新 Spectrum 窗格即会打开。 IDA Explorer 窗格及其相关
Spectrum 窗格可删除。
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图 D-72 保留时间为 12.73 和前体为 471.2398 时的质谱

8. 选择标记为 738.3833 的峰。

9. 单击 Bio Tool Kit > 手动排序。
Sequence Options 对话框即会打开。
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图 D-73 Sequence Options 对话框

注释: 当选择 Ignore isotopes 和检查电荷状态复选框后，在软件提议接下来的氨基酸时就
不会考虑同位素和电荷状态不正确的峰。

10. 单击 OK。
Create Sequence 对话框即会打开。
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图 D-74 Create Sequence 对话框

注释: 通过这一对话框，用户可在对文件进行手动排序后更改针对 y- 和 b- 系列图标所做
的假定并查看哪一个假定与数据最符合。

11. 确保选定 Create Sequence (for Peptide Fragments Pane) 复选框。

12. 在 Precursor charge 字段中键入 2。

13. 在 Fragment charge 字段中键入手动排序时应追踪的选定峰的电荷值。

14. 单击 OK。
软件更新后可显示更新后的 Spectrum 窗格和能指出质谱数据上可能获得或丢失的第一组
氨基酸的红色垂直线。
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图 D-75 手动排序的质谱－最初的可能情况

15. 双击应进一步排序的红色垂直线的标题。
软件更新，指示质朴数据上的下一组氨基酸。

16. 重复步骤 15，直到所有可能的氨基酸均已提出为止。
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图 D-76 手动排序的质谱

注释: 中 在图 D-76 中，按照以下顺序单击标题：F > G > I/L > E > Y。

提示! 如果软件提出一个以上的可能情况建议，而且您想选择一条不同于最初建议的分支
时，可从图返回至主视图并重复该程序，选择相应的替代氨基酸标签。

手动排序，与肽碎片相连

1. 单击 Bio Tool Kit > Peptide Fragments。
Peptide Fragments 窗格即会打开，并与手动排序的质谱相连接。
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图 D-77 Peptide Fragments 窗格，与手动排序的质谱相连接

注释: 匹配实验数据的氨基酸在 Table 选项卡的列中以红色粗体字显示。 匹配实验数据但
是有不同的目标碎片电荷的氨基酸在 Table 选项卡的列中以红色斜体字显示。

2. 单击 List 选项卡。

3. 单击 Show > Mass Calculators。

4. 单击 AA Property 选项卡。
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图 D-78 质量计算器－AA Property 选项卡

注释: 默认情况下，质量计算器会自动连接至手动排序后的质谱。 质谱中的氨基酸序列显
示在 AA sequence 字段中。

5. 当质谱窗格处于活动状态时，单击 Bio Tool Kit > Set Sequence Creation
Parameters。
Create Sequence 对话框即会打开。
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图 D-79 Create Sequence 对话框

6. 如下完成 Create Sequence 对话框：

• 确保选定 Create Sequence (for Peptide Fragments Pane) 复选框。

• 选定 Assume b-series 选项。

• 在 Precursor m/z 字段中输入 471.2398。

• 在 Precursor charge 字段中键入 2。

• 在 Fragment charge 字段中键入 1。

7. 单击 OK。
Peptide Fragments 窗格和 Mass Calculators 窗格更新已升级的序列数据。

8. 单击 Peptide Fragments 窗格中的 Table 选项卡。
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图 D-80 更新后的 Peptide Fragments 窗格，与手动排序后的质谱相连接

9. 当质谱窗格处于活动状态时，单击 Bio Tool Kit > Clear Manual Sequencing。
清除所有手动排序标记。

添加和删除手动重构高亮

通过 Add Manual Reconstruct Highlights 选项，将指示给定质量的理论 m/z 位置的标记添
加至质谱中。在确认当质谱含有多电荷成分时质谱内的特殊峰是否对应相同成分的情况下，该
功能非常有用。通过 Remove Manual Reconstruct Highlights 选项去除标记。

提示! 拖动标记的垂直线至一个新的 m/z 值，进而将标记移动至一个新位置。

提示! 单击标记的垂直线或相应的电荷状态标记，以使标记处于活动状态。活动标记显示 m/z
位置。

1. 单击主工具栏中的“打开样本”图标。
Select Sample 对话框即会打开。

2. 如果 Sample Data 文件夹未选定，则单击 Browse 并前往 Sample Data 文件夹。

3. 选择 RP_Intact.wiff 文件，然后单击 OK。
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图 D-81 来自 RP_Intact.wiff 文件的 TIC

4. 使用肌红蛋白峰峰顶部区域（5.91 至 6.00 分钟）创建一个平均质谱。
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图 D-82 平均质谱

5. 当质谱窗格处于活动状态时，单击 Bio Tool Kit > Add Manual Reconstruct
Highlights。
Add Manual Reconstruct Highlights to Graph 对话框即会打开。
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图 D-83 添加手动重构高亮至图

6. 在 Value 字段中键入 16950。

7. 选择 H+ 作为电荷调节剂，然后单击 OK。
图更新后含有高亮。

图 D-84 带有新增高亮的质谱

8. 单击 Bio Tool Kit > Remove Manual Reconstruct Highlights 去除标记。
图更新后高亮去除。

消化蛋白质

通过这个选项获取来自于用户针对特定蛋白质而自定义获得的酶法分析产物的理论肽序列的信
息。

工具栏

使用工具栏内的图标，按需要调整视图。
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表 D-5 工具栏图标

图标 名称（工具提示）

按序列查找和替换

将选定部分转换为大写字体

查找序列

注释: 关于该工具栏中的最后六个图标的描述（从“删除窗格”图标）开始，见通用窗格工具
栏。

按序列查找和替换

通过该选项查找 Sequence（序列）字段中的现有文本并用新文本替换。

1. 单击“按序列查找和替换”图标。
Find and Replace Text 对话框即会打开。

图 D-85 Find and Replace Text 对话框

2. 在 Find 字段中键入要替换的信息。

3. 在 Replace 字段中键入适当的信息。

4. 单击 OK。
用用户规定的替换文本替换软件中的现有文本。

将选定部分转换为大写字体

通过该选项将用小写字体键入 Sequence 字段中的文本转换为大写字体。

1. 选择适当的文本。

2. 单击“将选定部分转换为大写字体”图标。
软件可用大写的文本内容替换小写的相同文本内容。

查找序列

通过这个选项可查找 Sequence 字段中的文本。

1. 单击“查找序列”图标。
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Find Text 对话框即会打开。

图 D-86 查找文本对话框

2. 在 Find 字段中键入适当的信息。

3. 单击 OK。
软件可突出显示匹配文本。

理论蛋白质消化

1. 单击 Bio Tool Kit > Digest Protein。
Protein 窗格即会打开。

图 D-87 蛋白质窗格－蛋白质和肽选项卡

2. 在所提供的字段内输入一个蛋白质或肽序列。

注释: 本教程使用的是 GLSDGEWQQV LNVWGKVEAD IAGHGQEVLI RLFTGHPETL
EKFDKFKHLK TEAEMKASED LKKHGTVVLT ALGGILKKKG HHEAELKPLA
QSHATKHKIP IKYLEFISDA IIHVLHSKHP GDFGADAQGA MTKALELFRN
DIAAKYKELG FQG（肌红蛋白序列）。

3. 选择 Enzyme。
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注释: 本教程中选择的是胰蛋白酶。

4. 选择 Max. missed cleavages。

注释: 本教程中选择的是 0。

5. 单击 Digest。
软件将关于酶解肽及其序列的理论信息填入表中。

图 D-88 蛋白质窗格，填有理论信息

6. 单击 Variable Modifications 选项卡。
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图 D-89 蛋白质窗格－变量修改选项卡

7. 选择 Max. number of simultaneous modifications。

注释: 本教程中选择的是 3。

8. 勾选 Use 列中的复选框，以进行恰当修改。

提示! 如果图标显示在复选框左侧，那么整个氨基酸列表都可选定或可选定那些适用项。

注释: 本教程中选定的是 [1Ac] 的复选框。
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图 D-90 选定修改示例

9. 单击 Protein & Peptides 选项卡。

10. 单击 Digest。
表中的结果经过修改后可反映用户所做的选择。
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图 D-91 蛋白质窗格，填有修改后的信息

LCMS 肽重构

通过 LCMS 肽重构来确认质谱峰并对已确认的质谱峰进行去卷积。 LCMS 肽重构工具含有两
个操作步骤。 首先，使用强化型峰发现算法找到峰。 其次，该工具可找到形成同位素系列和
电荷系列的峰组并报告所发现所有组分的中性质量。

1. 单击主工具栏中的“打开样本”图标。
Select Sample 对话框即会打开。

2. 如果 Sample Data 文件夹未选定，则单击 Browse 并前往 Sample Data 文件夹。

3. 选择 RP_digests.wiff 文件，然后单击 OK。

Open IDA Sample 对话框即会打开。
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图 D-92 Open IDA Sample 对话框

4. 确保选定 As a standard TIC 选项，然后单击 OK。

确保第一个轨迹 IDA Survey from RP_digests.wiff (sample 1) - Sample001 以粗体显
示。 必要时可选择这个轨迹。

图 D-93 IDA Survey from RP_digests.wiff

5. 单击 Bio Tool Kit > LCMS Peptide Reconstruct (with peak finding)。
LCMS Peptide Reconstruct Options 对话框即会打开。
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图 D-94 LCMS 肽重构选项对话框

6. 在提供的字段内键入下列值：

• 在 Minimum retention time 字段内输入 9.00 分钟

• 选择 Maximum retention time 复选框，然后在字段中键入 16.00

• 在 Approximate LC peak width 字段中键入 6.0 秒

注释: 峰宽近似值用于确定背景减除期间的偏移。

• 在 Minimum intensity in counts 字段中键入 5 个数

• 在 Chemical noise intensity multiplier 字段中键入 1.5

• 在 Mass tolerance 字段中键入 0.100 Da

• 在 Maximum charge 字段中键入 5

注释: ‘电荷去卷积’一节中的质量允差可确保重构峰与理论上消化的蛋白质相匹配，并确保
术语相同蛋白质的不同 m/z 值组合在一起。

7. 单击 OK。
软件可显示按保留时间区分的肽列表。 列表中的每个肽都有下列信息：Index、Ret.
Time、Mass、Mass / Charge、Int. Sum 以及 Num. Peaks。
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图 D-95 重构峰列表

8. 展开 Filtering 以显示可用的过滤选项。

可用的过滤选项包括：Intensity threshold 、Min. Num. Peaks 和 Show matched
peaks only。
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图 D-96 过滤选项

9. 选择一个或多个过滤器，按需要调节视图。

注释: 在本教程中，Intensity threshold 设置为 2.39e4，Min. Num. Peaks 设置为 4。

图 D-97 过滤后的重构峰列表

工具栏

使用工具栏内的图标，按需要调整视图。

表 D-6 工具栏图标

图标 名称（工具提示）

显示质谱和 XIC
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表 D-6 工具栏图标 (续)

图标 名称（工具提示）

显示 IDA MS/MS 质谱

注释: 关于该工具栏中的最后六个图标的描述（从“删除窗格”图标）开始，见通用窗格工具
栏。

显示质谱和 XIC

当选定“显示质谱和 XIC”图标时，下列质谱和 XIC 窗格即会打开：

图 D-98 显示质谱和 XIC 结果

对于生成的 MS 谱图，导致肽质量的各峰下方会显示一个箭头。 每个导致肽质量的 m/z 峰的
XIC 在窗格右侧显示为叠加物。

显示 IDA MS/MS 质谱

当选定“显示 IDA MS/MS 质谱”图标后，下列质谱窗格即会打开：

用消化蛋白质重构 LCMS 肽
1. 单击 Bio Tool Kit > Digest Protein。

Protein 窗格即会打开。
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2. 将 Protein 窗格内的“拖动至蛋白质窗格以设置其峰列表”图标拖动至 Reconstructed
Peak List 窗格内。

Protein 窗格更新后显示蛋白质窗格内与重构峰列表相匹配的肽序列。 Protein 窗格中以
红色粗体显示的的碎片是与 Reconstructed Peak List 窗格形成精确匹配的碎片。 以红
色普通字体显示的碎片表示可能已与 Reconstructed Peak List 窗格内的碎片形成匹配的
碎片，但前提是 Reconstructed Peak List 窗格的 Match 列中的括号内已指定了碎片的
电荷状态。 以黑体字显示的碎片指与 Reconstructed Peak List 窗格内的任何碎片都不
匹配的碎片。
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图 D-99 关于与重构峰列表相连接的蛋白质窗格的理论信息

重构蛋白质

通过这个选项获取一个完整蛋白质的平均质量（分子量）。

1. 单击主工具栏中的“打开样本”图标。
Select Sample 对话框即会打开。
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2. 如果 Sample Data 文件夹未选定，则单击 Browse 并前往 Sample Data 文件夹。

3. 选择 RP_Intact.wiff 文件，然后单击 OK。

图 D-100 来自 RP_Intact.wiff 文件的 TIC

4. 使用 5.93 分钟时的峰区域创建一个平均质谱 请参阅图 D-101。
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图 D-101 平均质谱

5. 当质谱窗格处于活动状态时，单击 Bio Tool Kit > Reconstruct Protein。
Reconstruct Options 对话框即会打开。
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图 D-102 重构选项

6. 为以下选项输入恰当的值：

• 开始质量：15000 Da

• 停止质量：18000 Da

• 步骤质量：1.0 Da

7. 选择恰当的 Input spectrum isotope resolution：中度 (10000)。

注释: 对于通过四极杆系统获取的数据，显示的是峰宽参数，而不是输入质谱同位素分辨
率参数。

8. 选择恰当的 电荷调节剂：H+。

9. 单击 OK。
软件在单独的窗格中生成一个重构蛋白质的质谱，标题为：Reconstruction, Input
spectrum isotope resolution [user selection]。
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图 D-103 重构窗格

注释: 对于通过四极杆系统获取的数据，窗格内的标题为：Reconstruction，Peak width
[value]。

10. 选择重构的蛋白质峰。
垂直手动重构高亮被添加至选定用于生成重构蛋白质的质谱中。
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图 D-104 质谱，带有手动重构高亮

摘要

本节中对下列任务进行了讨论：

• 对消化后的蛋白样本的 MS/MS 质谱数据进行手动排序。

• 连接手动排序的质谱和肽碎片。

• 将指示给定质量的理论 m/z 比的标记（手动重构高亮）添加至质谱中。

• 从质谱中移除标记。

• 获取来自于用户针对特定蛋白质而自定义获得的酶法分析产物的理论肽序列的信息。

• 通过 LCMS 肽重构来确认质谱峰并对已确认的质谱峰进行去卷积。
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• 连接关于蛋白质窗格的理论信息和重构的峰列表。

• 获取完整蛋白质的平均质量（分子量）。
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联系我们

客户培训
• 北美地区：NA.CustomerTraining@sciex.com

• 欧洲：Europe.CustomerTraining@sciex.com

• 在欧盟与北美之外请访问 sciex.com/education

在线学习中心
• SCIEX Now Learning Hub

SCIEX 支持
SCIEX 及其代表在全球范围内设有经过系统培训的服务和技术专家。他们可以解答系统问题
或可能出现的任何技术问题。详情请访问 SCIEX 网站 sciex.com 或通过下述方式之一联系我
们：

• sciex.com/contact-us

• sciex.com/request-support

网络安全
有关 SCIEX 产品的最新网络安全指南，请访问 sciex.com/productsecurity。

文档
本版本的文档取代本文档的所有先前版本。

要查看本文档的电子版本，需要 Adobe Acrobat Reader。要下载最新版本，请转到 https://
get.adobe.com/reader。

要查找软件产品文档，请参阅软件随附的版本发布说明或软件安装指南。

要查找硬件产品文档，请参阅系统或组件的文档 DVD。

最新版本的文档可从 SCIEX 网站上获得，网址：sciex.com/customer-documents。

注释: 如需免费获取本文档的印刷版本，请联系 sciex.com/contact-us。
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